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Introduction
Overview
Welcome to Ontrack® PowerControls™, the mailbox recovery software that saves time, money,
and resources when recovering Microsoft® Exchange Server data.

Ontrack PowerControls works with your existing Microsoft Exchange Server backup architecture
and procedures to recover individual mailboxes, folders, messages, attachments, calendar items,
notes, and tasks directly to your production Microsoft Exchange Server or any Personal Folders (PST)
file. This eliminates time-consuming and expensive single mailbox (brick-level) backups. This
powerful software also lets you search and create a copy of all archived email that matches a
given keyword or criteria.

Five Major Reasons for Using Ontrack
PowerControls
There are five primary ways you can benefit from using Ontrack PowerControls:

1. Minimize the time to restore an individual mailbox.
Ontrack PowerControls can slash restore time, making it possible to restore mail items from a
previous full backup directly into your production Microsoft Exchange Server, or directly into a new
or existing PST file. This eliminates the need for a recovery server and the extra steps required to
separately import mail back into Microsoft Exchange Server or Microsoft® Office Outlook®.

2. Eliminate backups of an individual mailbox.
Ontrack PowerControls eliminates the need to back up individual mailboxes because they can be
restored directly from a Microsoft Exchange Server Database (EDB) file.

3. Minimize the time to locate all email matching specific criteria.
Ontrack PowerControls includes an Advanced Find feature that can search across all mailboxes in
an archive EDB file, rather than searching one mailbox at a time or bringing an old backup back
online for analysis. And you can search by a variety of criteria, including keywords, subject, date
and specific users.

4. Minimize storage space and the cost required to store and archive your backups.
Because you do not need to back up mailboxes individually doing a brick-level backup, you
eliminate the backup space, cost, and time associated with performing brick-level backups.

5. Minimize the time to back up all mailboxes.
Ontrack PowerControls eliminates the need to back up mailboxes individually. Normally,
companies do a full Microsoft Exchange Server backup, and then run a second process to back
up "Very Important Mailboxes" (VIMs) individually as well. Ontrack PowerControls eliminates this
second process.
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About the Free Trial
After installation, Ontrack PowerControls operates as a Free Trial by default until a license file is
applied. The Free Trial of Ontrack PowerControls is limited in functionality and time-limited to 30
days of use.

With the Free Trial, you can:

n Open sources
n Open targets
n Perform searches
n Perform integrity checks
n Generate reports

If you would like to have full functionality, or learn more about the purchasing options and product
information for Ontrack PowerControls, visit our website at www.ontrack.com.

Readme File
The Ontrack PowerControls Readme file contains additional information about the Ontrack
PowerControls, including:

n Supported environments
n Licensing
n Limitations
n Technical support

The Ontrack PowerControls Readme file is included in the electronic package.

About the Microsoft Exchange Server Database
The Microsoft Exchange Server database consists of the following files:

n .edb file (rich text database file) contains data placed in the store through Messaging
Application Programming Interface (MAPI), as well as all the database tables that define
mailboxes, messages, folders, and attachments.

n .stm file (streaming database file) contains common Internet formatted content, such as
Multipurpose Internet Mail Extensions (MIME) content, that protocols other than the MAPI
protocol place in the store.

Note: The .stm file is new toMicrosoft Exchange Server 2000. Microsoft Exchange Server 5.5
does not contain .stm files.
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n .log files (transaction logs)are history files recording server activity used in restoring and
backing up Microsoft Exchange Server data. Transaction logs for Microsoft Exchange Server
5.5, 2000, and 2003 are 5 MB in size. Transaction logs for Microsoft Exchange Server 2007 and
later are 1 MB in size.

Each storage group uses its own set of transaction log files. For example, if a storage group
contains five stores, all transactions for all five stores are recorded in a single series of
transaction log files. You can determine where to locate the transaction log files for each
storage group.

n .chk (check) filesare checkpoint files used for recovering (playing) data from transaction
logs into EDB files. The checkpoint is the place marker in the EDB.CHK file that indicates
which transactions have been performed. Whenever data is written to an EDB file from the
transaction log, the EDB.CHK file is updated with information specifying that the transaction
was successfully committed to the respective EDB file. Separate EXX.CHK files are
maintained for each storage group using ESE (Extensible Storage Engine).

n .pat (patch) filesare used to record information on page splits in Microsoft Exchange Server
5.5 through Microsoft Exchange Server 2000 (SP1). In Microsoft Exchange Server 2000 (SP2)
and later, the functionality provided by .pat files is incorporated into Microsoft Exchange
Server log files.

Organizing the Microsoft Exchange Server Database Files for
Ontrack PowerControls
For best results when using an online incremental or differential backup

n Put the .edb, .stm, and .pat files in one directory.
n Put the associated log files (for example, .log, .chk) in one directory.

Note: The two directories can be different.

Ontrack PowerControls does not require .stm or .log files, but you should include them to ensure
that all email data is recovered. You may get corruption errors if these files are not present.

If you are using an offline backup

You need to use the .edb and .stm files for offline backups. To ensure that all email data is
recovered, you should also include all .log files, and, if they exist, .pat and .chk files. Ontrack
PowerControls performs its own verification process and includes the .log and .pat files to
determine if it needs them to recover the data.

Getting Help
Ontrack provides you with the following ways to get help with Ontrack PowerControls:
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n Online Help
n Technical Support

Online Help
Online Help includes all of the information in the user guide. You can quickly access this
information using the following online Help tabs:

n Contents: Displays a hierarchical view, similar to the Contents of the user guide.
n Index: Provides a list of key words to locate specific topics.
n Search: Offers a full-search of the Help file.

To start online Help
Do one of the following:

n On theHelpmenu, clickContents.
n Click on the toolbar.
n Press the F1 key.

Context Sensitive Help
You can click the Help button that appears on many of the dialog boxes when using Ontrack
PowerControls to open the online Help topic related to the current task.

Tooltip
When you position the pointer over a tool or control and pause, a message box appears with a
definition of your selected item.

Technical Support
If you have questions or problems not answered in the user guide or the online Help (F1), call our
Technical Support group. When reporting an issue, please include any information that might help
us diagnose the problem. The following details are often the most helpful:

n The version of Ontrack PowerControls you are using (on theHelpmenu, clickAbout).
n The versions of the Windows® operating systems and Microsoft Office Outlook that you are

running.
n The version of Microsoft Exchange Server that contained the source EDB file.
n The circumstances and sequence of steps that led to the problem.
n The text of the error messages (if any appeared), and the contents of theDetailswindow.
n A list of other Windows-based programs that you were running when the error occurred.

See "Contact Information" at the beginning of this user guide.
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See Also:

n Contact and Legal Information
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Chapter 1: Looking at the Interface
Overview
This chapter describes the parts of the main window of Ontrack PowerControls and shows you how
to preview messages, view details of an EDB, PST, or CAS file, and change the view.

Main Window
The main window is where you do most of your work. This window displays the source EDB or PST file
(s) or Content Analysis Store (CAS), as well as the target PST file(s), Microsoft Exchange Server, or
CAS. The target acts as a container for the restored files. The various work areas and controls are
described in the following sections.

Figure 1-1: Themainwindowwith four panes

Key items on theOntrack PowerControls mainwindow:

1. Menu Bar
2. Toolbar
3. Source Location
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4. Source Pane
5. SourceMessage List
6. Target Location
7. Target Pane
8. TargetMessage List
9. Status Bar

Note: In the illustration above, the Source pane displays an EDB file, but it could just as easily
display a PST file, CAS, or evenmultiple EDB and PST files. The Target pane displays a PST that acts
as a container for restored files. Keep inmind that the Target pane could just as easily display a
Microsoft Exchange Server.

Source Pane
The Source pane displays the data you intend to recover, such as the EDB file(s) or a content
analysis store (CAS). If you have not yet extracted Microsoft Exchange Server data from a backup
tape or disk, see theOntrack PowerControls ExtractWizard User Guide.

Figure 1-2: Example of Source pane (description of icons in table below)

Icon Description
Sources Root Node contains one or more source data stores that are pre-pended
with a "SourceX" where X is a number starting with 1 and is incremented for each
additional source opened. You can select the sources root node as your search
source.
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Icon Description

Source EDB File (for example, ) contains the Microsoft Exchange
Server Information Store data. Click the plus sign (+) next to an EDB file to expand its
contents.

Mailbox (for example, , Archive, and Public Folder) contain the
Microsoft Office Outlook folders. Click the plus sign (+) next to a mailbox to expand its
contents.

Microsoft Office Outlook Folders (for example, Inbox, Contacts, Tasks)
contain Microsoft Office Outlook message items. Select a folder to view its contents
in the Source Message list.

Source CAS File (for example, ) contains the content analysis store data

created to analyze content based on certain criteria.

CAS Profile Folder (for example, ) contains the results of a content
analysis.

Inaccessible Mailboxwhich displays if a mailbox is inaccessible. An inaccessible
mailbox presents no visible content.
Source mailbox access is controlled by Ontrack PowerControlsAgent for
Administrative Services. If Ontrack PowerControls Agent for Administrative Services in
enabled and Ontrack Administrative Services Mailbox Permissions Control
functionality is active, source mailbox accessibility is controlled through this
functionality. Otherwise, source mailbox access is always permitted. Target mailbox
access is controlled by the target Microsoft Exchange Server.

Status indicator noting that Ontrack PowerControls is licensed for the Agent for
Administrative Services and that it is connected to Ontrack Administrative Server. This
icon is located in the Status Bar of the Ontrack PowerControls main window.

Status indicator noting that Ontrack PowerControls is either not licensed for the
Agent for Administrative Services or it is licensed but not connected to the Ontrack
Administrative Server. This icon is located in the Status Bar of the Ontrack
PowerControls main window.

Source Message List
The Source Message list displays the message items in the Microsoft Office Outlook folder that you
selected in the Source pane. This folder is one of the Microsoft Office Outlook folders (for example,
Inbox, Contacts, Tasks).
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Figure 1-3: The SourceMessage list (displayingmessages in an Inbox)

The Source Message list displays metadata about the message items in six columns. The metadata
includes file type; attachments, if any; message sender; subject; date; and status. The Sent Items
folder also displays the "To" column. For more information on the message list, see "Sorting
Messages in the Message Lists".

The source content analysis store message list includes file type; Database #, Database, and Path.
The source content analysis store profile folder message list includes file type; Attachment, if any;
From; Subject; Create Date; Sent Date; Database #; Folder, and Status. For more information on
content analysis stores, see "Content Analysis Store".

Target Pane
The Target pane can display one or more target PST files and/or one or more target mailbox,
public folders and mailboxes from a Microsoft Exchange Server, and content analysis stores (CAS)
with profile folders. The target acts as a container for your restored files. If a target is a newly
created PST file, it defaults to Microsoft Office Outlook folders. If a target is an existing PST file or
Microsoft Exchange Server, it shows whatever folders are in the target. It is into these folders that
you paste and restore your message items. For information on restoring message items, see
"Restoring Microsoft Exchange Server Data".
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Target panes for PST
files

Target pane for a CAS file Target pane for a Microsoft
Exchange Server

Figure 1-4: Target panes with PST, CAS, andMicrosoft Exchange Server files

Target Message List (Restored Messages)
The Target Message list displays the message items in the Microsoft Office Outlook folder that you
selected in the Target pane. If the target is a newly created PST file or CAS, the Outlook folders and
message list will be empty. If the target is an existing PST file, CAS file, or Microsoft Exchange Server,
or if you have restored message items to a newly created PST file, you can select a folder in the
Target pane to display messages in the Target Message list.

Figure 1-5: TargetMessage list displaying restoredmessages
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The Target Message list displays metadata about the message items in five columns (instead of six
columns in the Source Message list). The metadata includes file type; attachments, if any;
message sender; Subject; and Create Date. The Sent Items folder also displays the "To" column. For
more information on the message list, see "Sorting Messages in the Message Lists".

The target content analysis store message list includes file type; Database #, Database, and Path.
The target content analysis store profile folder message list includes file type; attachment, if any;
From; Subject; Create Date; Database #; Folder; and Status. For more information on content
analysis stores, see "Content Analysis Store".

Menu Bar

Figure 1-6: Themenu bar in themainwindow

The menu bar contains all of the commands for Ontrack PowerControls. The menu commands,
submenu commands, and resulting windows are discussed fully in the chapters that focus on
those specific commands. See the Index to quickly locate the pages on which a menu command
is discussed.

Help Menu - Administrative Services
The Administrative Services option is available in the Help menu when the Ontrack Administrative
Server for Administrative Services is active. It displays information regarding the Ontrack
Administrative Server that Ontrack PowerControls is connected to and the services that are being
used.

Note: During normal operation, the auditing service (if activated) does not alter the behavior of
Ontrack PowerControls.

Toolbar

Figure 1-7: The Button Toolbar in themainwindow

The buttons on the toolbar perform the following functions:

Toolbar
Button

Function

Open Source opens the Source Selection page of the Data Wizard, where you can
navigate to and select a source Microsoft Exchange Server Database (EDB), PST, or
CAS file. The EDB, PST, or CAS file contains the message items you want to restore.
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Toolbar
Button

Function

Open Target PST opens the Open Target PST dialog box, where you can navigate to
and select a target Personal Folders (PST) file. The target PST file is a container for
restored message items.

Open Target Microsoft Exchange Server opens the Target Selection page of the Data
Wizard, where you select the type and path of the target location for the data you
want to restore.

Create/Open Content Analysis Storedisplays the Create Content Analysis File
window, where you can open an existing content analysis store or to create a new
one in the Target pane.

Copy copies into the Clipboard the selected message(s) in the Source Message list; or
the selected folder, mailbox, or EDB file in the Source pane.

Paste inserts the items from the Clipboard into the selected folder in the Target pane. If
you want to retain the directory structure of the restored messages, you must use the
Paste Special command instead of the Paste command or Paste button.

Exportdisplays the Export window, where you can export messages to a local or
network drive destination. You can choose to save exported messages as plain text
files (.txt), Microsoft Office Outlook files (.msg), or Outlook Data files (.pst).

Searchdisplays the Find window, where you can specify the desired search criteria for
finding messages in the Source pane.

Preview Panedisplays the Preview pane on the Ontrack PowerControls main window,
where you can read a message without opening it.

View Helpdisplays Ontrack PowerControls Online Help, which includes all of the
information in this user guide. You can quickly access the Online Help information
using its Contents, Index, Search, and Favorite tabs.

Message Table View is only available when a message in the Source Message list is
highlighted. It opens a Message Table View of that message and any message
related to it.

Attachment Table View is only available when a message with an attachment in the
Source Message list is highlighted. It opens an Attachment Table View of that
message and attachment and all related messages and attachments.

Conversation View is only available when a message in the Source Message list is
highlighted. It shows the thread of that message with indentations to indicate the
responses to each e-mail.
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Shortcut Menu
You can access many of the same commands available on the menu bar and toolbar by right-
clicking the mouse to view a shortcut menu. The contents of the shortcut menu depend on
whether you right-click in the Source or Target pane. This manual explains how to use commands
on the menu bar and toolbar, and does not always specify when you can use the shortcut menu.
Once you become familiar with Ontrack PowerControls, the commands available to you on the
shortcut menu should become apparent.

Previewing and Opening Messages
In the Preview pane, you can read the contents of a message item and open attachments. You
can preview a message located in either the Source Message list or the Target Message list. The
information displayed in the Message Header is different for messages, calendars, contacts, tasks,
and distribution lists.

To open the preview pane
Do one of the following:

n On theViewmenu, click Preview Pane.
n On the toolbar, click the Preview Pane icon in the toolbar.

To hide the preview pane

n Repeat one of the previous steps.

Tip: Hiding the Preview pane will allow you to scroll through messages faster.

To display a message in the preview pane

1. In the Source or Target Message list, select a message.

2. Open the Preview pane by clicking on the Preview Pane icon in the toolbar.

Figure 1-8: Previewpane for amessage
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To open a message in its own window

n In the Source or Target Message list, double-click a message.

Changing the View
You can change the view in the Ontrack PowerControls window by hiding the toolbar or status
bar, by using split bars; by sorting message lists; and by refreshing the screen.

Viewing or Hiding the Toolbar and Status Bar
The toolbar and status bar appear by default in the main Ontrack PowerControls window, but you
can easily hide them.

To hide the toolbar or status bar

n On theViewmenu, click Toolbar or Status Bar. The check mark no longer appears next to
the name of the toolbar or status bar.

To view the toolbar or status bar

n On theViewmenu, click Toolbar or Status Bar. The check mark appears next to the name of
the toolbar or status bar.

Resizing Panes Separated by a Split Bar
You can use a split bar (the horizontal or vertical double line that separates two panes) to increase
the area within one pane while simultaneously decreasing the area within the adjacent pane. The
Source pane, Source Message list, Target pane, Target Message list, and Preview pane all border
a split bar.

To resize panes separated by a split bar

1. Position the pointer over a split bar between the two panes on either the vertical or
horizontal split bar.
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Figure 1-9: Before dragging the split bar between the TargetMessage list and the Preview
pane

2. When the pointer becomes a double-headed arrow, drag it to resize the pane.

Sorting Messages in the Message Lists
You can sort messages in the Source and Target Message lists based on attachments, message
sender, subject, date, and status. In addition, the Source Message list lets you sort messages based
on status, and the Sent Items folder lets you sort items based on the "To" heading. Sorting messages
on the From column, for example, can help to identify messages from a specific sender.

To sort a message list

1. Click a column heading to sort the messages based on that heading. For most headings, an
arrow appears indicating the sort direction. An up arrow indicates that the messages
appear in ascending (A-Z) order. A down arrow indicates that the messages appear in
descending (Z-A) order.

2. To reverse the order of the messages based on that column heading, click the column
heading again. Notice the arrow reverses directions.
An example of sorting messages:

l If you click the attachment column heading, messages are sorted in ascending
order based on this heading, even though no arrow appears. This means that messages
with attachments appear at the top of the message list, while messages with no
attachments appear at the bottom of the document list. If you click the attachment

column heading again, the order is reversed.

Note: The view settings (sort order and columnwidth) for a folder ormailbox are saved until
you close the data store.
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Refreshing the Screen
You may want to refresh the screen occasionally when you are connected to a target Microsoft
Exchange Server. That is because the information on the server may change while you are
connected.

To refresh the screen
Do one of the following:

n On theViewmenu, click Refresh.
n Press the F5 key.

Opening Attachments
If you have the appropriate program installed on your computer, Ontrack PowerControls loads
the application to view the selected attachment (for example, to view an .xls file attachment,
Ontrack PowerControls will launch Microsoft® Excel®).

If no associated program is available for the attachment's file type, Ontrack PowerControls
presents a message window saying the attachment cannot be viewed.

Note:Ontrack PowerControls cannot viewattached embeddedgraphics in HTMLmessages.

To open an attachment in an open message

1. In the message list, double-click a message that has the Attachment icon next to its
name.

2. Click theAttachment icon on the right side of the message header. A pop-up window
lists the attachments for the selected message.

3. Click the name of the attachment you want to view.

To open an attachment in the preview pane

1. In the message list, select a message that has the Attachment icon next to its name.

2. Open the Preview pane. In the Ontrack PowerControls main window, click the Preview

Pane icon . In the Findwindow, select the Preview check box.

3. Click theAttachment icon on the right side of the message header in the Preview pane.
A pop-up window lists the attachments for the selected message.

4. Click the name of the attachment you want to view.
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Saving Attachments
A "save attachments" option is available on the File menu and paperclip menu of an open
message, as well as on the paperclip menu of the Preview pane. The Save Attachments window
lists the attachments for the selected message and lets you select the attachments you want to
save.

To save attachments in an open message

1. In the Source or Target Message list, double-click a message that has the Attachment icon
next to its name.

2. In the open message, do one of the following:
l On the Filemenu, click Save Attachments.

l Click theAttachment icon on the right side of the message header, and then click
Save Attachments.

3. In the Save Attachmentswindow, select one or more attachments, and clickOK.
4. In the Browse For Folderwindow, select a location for the attachment(s), and clickOK.

To save attachments in the preview pane

1. In the Source or Target Message list, select a message that has the Attachment icon
next to its name.

2. In the Preview pane, click theAttachment icon on the right side of the message header,
and then click Save Attachments.

3. In the Save Attachmentswindow, select one or more attachments, and clickOK.
4. In the Browse For Folderwindow, select a location for the attachment(s), and clickOK.

Viewing the Properties of an EDB File, PST File,
CAS File, CAS Profile Folder, Folder, or Mailbox
Ontrack PowerControls makes it easy to view the properties of a source PST file, EDB file, CAS file,
CAS profile folder, mailbox, or folder.

Note:Only accessiblemailboxes can produce property reports. For CAS files, inaccessible
mailboxes within that data store are not included in the totals.

Note:When the Show Recoverable Itemspreference is enabled, the Recoverable Items folder,
subfolders, andmessageswill appear in the folder andmessage counts in the EDB properties. If the
preference is cleared, the Recoverable Items folders andmessages are not included in the folder
andmessage counts.
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To view the properties

1. In the Source pane, right-click an EDB file, PST file, CAS file, CAS profile folder, mailbox, or
folder.

2. On the shortcut menu, click Properties. One of the following Properties dialog boxes
appears:

Figure 1-10: EDB File Properties dialog box

Note: The Save button is only available for Microsoft Exchange Server 2010 and earlier
databases. Click Save to save theMicrosoft Exchange Server name to your hard drive.

18



Figure 1-11: PST File Properties dialog box

Figure 1-12: Content Analysis Store (CAS) File dialog box

Figure 1-13: Content Analysis Store (CAS) Profile Folder dialog box
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Figure 1-14: Properties of aMailbox dialog box

An alternate way to view the properties of an EDB or PST file

Once you have viewed the properties of the source EDB or PST file as described above, you can
then display the properties in the Preview pane.

1. Open the Preview pane by clicking the Preview Pane icon on the toolbar or by clicking
theViewmenu and pointing to Preview Pane.

2. Click the source EDB or PST file in the Source pane and click Properties.

Figure 1-15: Properties of an EDB File

Performing an Integrity Check
You can perform an integrity check on messages, folders, mailboxes, PST files, CAS files, CAS profile
folders, EDB files, and live Microsoft Exchange Server target search results. During the integrity
check, Ontrack PowerControls verifies that it can read all folder and message properties from the
selected source.

To perform an integrity check

1. In the Source pane, select an EDB file, PST file, CAS file, CAS profile folder, mailbox, folder, or
message(s).
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2. Do one of the following:
l On the Toolsmenu, click Integrity Check. The Integrity Checkwindow appears.
l Right-click the item and click Integrity Check in the shortcut menu.

3. Click Print to print a copy of the integrity check.
4. Click Save to save a copy of the integrity check to file.

Creating a Mailbox List
You can create a text file with a list of all mailboxes available in an EDB source file.

Note: This is similar to the -list command line parameter.

To create a mailbox list

1. In the Source pane, select an EDB file.
2. Do one of the following:

l Right-click the EDB files and selectCreate Mailbox List in the shortcut menu.
l Press Ctrl+Alt+L.

3. On the Save mailbox list dialog box, select the path and enter a File name, then click Save.

Viewing Deleted Messages
Ontrack PowerControls can view and restore deleted messages that are held in the EDB file. These
messages appear with the value "Deleted" in the Status column of the Source Message list. If
deleted messages have been purged from the EDB file due to the deleted retention schedule,
Ontrack PowerControls cannot view or restore these messages.

Content analysis store deleted messages in both the Source and Target panes also appear with
the value "Deleted" in the Status column of the message list.

Viewing Deleted Items in Microsoft Exchange Server
Databases
Deleted items do not have the same functionality as items from earlier databases. Instead of
being stored in the folder they were deleted from, they are stored in a separate "Recoverable
Items" folder.

Note: The Recover Items folder only appears when usingMicrosoft Exchange Server 2010
databases and later.

By default, this separate folder does not appear in the source tree under the mailbox. A
preference setting allows you to view this folder in the source tree, making the deleted items
accessible to you. For more information, see Setting Preferences in the "Security Tab".
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Recoverable Items Folder
When the Recoverable Items folder is visible, the subfolders are accessible as well, including:

n Audits: Holds audit log entries for the mailbox, if audit logging is enabled on the Microsoft
Exchange Server.

n Calendar Logging: Holds calendar changes that occur within a mailbox.
n Deletions:Holds messages that have been removed from the Inbox using the Delete key,

menu item, or shortcut key.
n DiscoveryHolds: Holds all items that meet the hold query parameters and are purged.
n Purges:Holds messages that have been removed from a mailbox via the "Recover Deleted

Items" tool in Microsoft Office Outlook when a legal hold is set for a mailbox.
n Versions: Holds sent and received messages that were edited by a user in a mailbox for

which a legal hold was set.

You can perform source operations on the messages in these folders, including copying and
exporting. The messages in Recoverable Items and its subfolders are also included in searching,
creating reports, integrity checks, and property counts.

Note: Viewing the Recoverable Items folder applies to sources only. It is not visible in target
mailboxes.

Setting Preferences
The Preferences dialog box allows you to streamline Ontrack PowerControls operations. Most of
the preference settings in the four tabs are selected by default. There are two exceptions: the
"Display new PST when PST limit is reached" setting in the Target Options tab, and the "Enable
Tamper-Proof Target" setting in the Security tab. If you change the settings, they are stored and
reloaded on the next run of Ontrack PowerControls.

General Tab
The General tab governs the tasks that Ontrack PowerControls performs and the location of the
license file.
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Figure 1-16: TheGeneral tab in the Preferences dialog box

To change the General preference settings

1. On the Editmenu, click Preferences, then clickGeneral.
2. Select or clear the following check boxes as desired:

n Run Data Wizard on startup: The Data Wizard will launch every time you open Ontrack
PowerControls.

n Check for duplicate messages during copy and export:When restoring Microsoft
Exchange Server data, Ontrack PowerControls does not copy duplicates of a message to
the destination folder if a message already exists in the destination folder. Selecting this
preference setting results in slower copy performance.

n Check for duplicate messages during search:Ontrack PowerControls will not return
duplicates of a message during a search. For example, if the same message exists in two or
more data stores, only the first message found is listed in the search results. Selecting this
preference setting results in slower search performance.

n Append to existing PST files during export: If selected, Ontrack PowerControls updates
previously exported PST files with new messages from the export process. If cleared, a new
PST file is created when exporting data.

Target Options Tab
The Target Options tab governs the target-related tasks that Ontrack PowerControls performs.
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Figure 1-17: The Target Options tab in the Preferences dialog box

To change the Target Options preference settings

1. On the Editmenu, click Preferences, then click Target Options.
2. In the PST Options group, select or clear the following check boxes as desired:

n Create new PST folders when PST message/folder limits are reached:Ontrack
PowerControls automatically creates new folders (for example, Inbox) when the
16,383 messages/folder limit is reached. After Ontrack PowerControls creates a new
folder, it continues to restore Microsoft Exchange Server data where it left off. For
more information, see "Limits for PST and Folder Targets".

n Display new PST when PST limit is reached: When the limit for a PST is reached in the
Target pane, Ontrack PowerControls automatically displays the overflow PST.

n Create Unicode PSTs: If selected, Ontrack PowerControls always creates Unicode
PSTs. If cleared, Ontrack PowerControls creates non-Unicode PSTs.

Note: The default maximum size for Unicode PST files is typically set by the locally
installed version ofMicrosoft OfficeOutlook. For information on adjusting this
limitation, see https://support.microsoft.com/en-us/kb/832925.

n Limit maximum PST file size: If selected, Ontrack PowerControls automatically creates
a new PST file when theMB size is reached during export. For more information, see
"Setting a Global Limit for PST Files"
Note: TheMB field should not exceed 48640.

3. In the Microsoft Exchange Server group, select or clear the following check boxes as
desired:
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n Encrypt data connection with Microsoft Exchange Server: If selected, Ontrack
PowerControls will use an encrypted connection to send data to the Microsoft
Exchange Server. Clear this if you are using an unencrypted connection.

n Use Autodiscover to detect Microsoft Exchange Server connection settings: If
selected, Ontrack PowerControls attempts to use Autodiscover to detect profile
settings for connecting to the target Microsoft Exchange Server.

n Use Outlook Anywhere to connect to Microsoft Exchange Server: If selected, Ontrack
PowerControls uses Outlook Anywhere settings to connect to the target Microsoft
Exchange Server. For more information, see "Outlook Anywhere and Autodiscover".

n Always prompt for credentials when connecting to a single mailbox: If selected,
Ontrack PowerControls requests a username and password each time it connects to
a mailbox on a Microsoft Exchange Server. This option requires a user to provide
credentials when connecting to a single mailbox, even when the logged in user is
connecting to their own mailbox, or when managed passwords are set up for the
Microsoft Exchange Server.

4. In the Mailbox Creation group, select or clear the following check boxes as desired:
n Allow mailbox creation during copy: If selected and a mailbox copy is initiated by

you, mailboxes can be created during a mailbox copy. If it is cleared, mailbox
creation cannot take place during copy. This setting has no effect on manual
mailbox creation.

Security Tab
The Security tab controls the level of information available to the user when using the application
and governs the tasks that person can perform.

The options in the Security tab are modifiable by default only by users that belong to the
Administrator Group. The options are stored in the registry: HKEY_LOCAL_
MACHINE\software\ontrack\powercontrols.

The Ontrack PowerControls Installation program sets this registry key to have read/write access to
users in the Administrators group and read-only access to any user in the Users group.

The settings on the Security tab can also be set and managed by an Administrator using the
Settings service on the Ontrack Administrative Server (OAS). In that situation, you need to contact
your OAS administrator to change the settings on the Security tab.
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Figure 1-18: The Security tab in the Preferences dialog box

To change the security preference settings

1. On the Editmenu, click Preferences, then click Security.
2. Select or clear the following check boxes as desired:

n Allow preview of messages: If this option is not selected, you will not have the ability to open
or preview messages in the source or target.

n Enable Tamper-Proof Target: If this option is selected, Ontrack PowerControls does not allow
you to delete messages or folders in the target or have the ability to rename folders in the
target. You only have the ability to add (copy) to the target.

n Allow Bcc field to be included when restoring or searching messages: If this option is
selected, Ontrack PowerControls includes Bcc information when restoring or searching
messages. This means that a recipient is able to see Bcc recipients that he or she was not
intended to see. It also means that searching with the "Sent to" option returns messages for
Bcc recipients.

n Enable Message Views: If this option is selected, it makes the Message Views available.
n List inaccessible mailboxes: When Ontrack PowerControls connects to a Microsoft

Exchange Server, it can display both accessible and inaccessible mailboxes. If this option is
selected, the inaccessible mailboxes listed in the directory appear and are display-only.

n Note:Clearing this optionwhile you havemailboxes open refreshes themailbox list and no
longer displays the inaccessiblemailboxes.

n Show Recoverable Items: Selecting this option allows the "Recoverable Items" folder to be
displayed under your mailbox, enabling you to have access to any deleted items. It also
provides access to the "Purges" and "Versions" folders, which are also sub-folders of
"Recoverable Items."
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Note: This setting only applies toMicrosoft Exchange Server 2010 and later.

Important: Selecting the Show Recoverable Items preference causes your Microsoft
Exchange Server 2010 and later EDB sources to close. A warning message appears
giving you the option to cancel or continue changing the setting.

n Enable Multi-Tenant Support: If this option is selected, multi-tenant support is enabled. This
allows you to filter a source or target from a list of Microsoft Exchange Server 2010 through
SP3 hosted organizations or Microsoft Exchange Server 2010 SP2 and later Address Book
Policies (ABPs). It also selects and opens all mailboxes or displays mailboxes not contained in
any hosted organization (hosted environment only).
l Enforce ABP or Hosted Organization for current user: If this option is selected, you cannot

select from a list of hosted organizations or Address Book Policies (ABPs) from source or
target dialog boxes. Rather, you are limited to opening only the mailboxes included in
the Global Address List (GAL) of your assigned ABP or mailboxes contained in the hosted
organization to which you belong.

Note: This option is only availablewhen EnableMulti-tenant Support is selected.

l Show deleted or unrecognized mailboxes:When this option is selected, Ontrack
PowerControls opens mailboxes not found in the current environment. These
unrecognized mailboxes may have been previously present in the environment and
were deleted or are mailboxes from a different environment. Unrecognized mailboxes
are opened and displayed in the source tree, in conjunction with the selected ABP or
organization mailboxes. This option only applies to the opening of source EDBs.

Note: This option is only availablewhen EnableMulti-tenant Support is selected.

Warnings Tab
The Warnings tab controls whether or not warning messages appear when various tasks are
performed.
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Figure 1-19: TheWarnings tab in the Preferences dialog box

To change the warnings preference settings

1. On the Editmenu, click Preferences, then clickWarnings.
2. Select or clear the following check boxes as desired:

n Show warning when logs specified but not found: Ontrack PowerControls warns you when
opening an EDB file if no .log files were found at the specified directory.

n Show warning when no log file path specified: Ontrack PowerControls warns you when
opening an EDB file if a .log file path has not been specified.

n Show warning when copying to Microsoft Exchange Server root: Ontrack PowerControls
warns you when you are about to copy a large amount of data to the Microsoft Exchange
Server root.

n Show warning when opening a Microsoft Exchange Server and a Microsoft Exchange
Server is already open: This warning appears when you attempt to connect to either a
single mailbox or all mailboxes on a Microsoft Exchange Server when a target Microsoft
Exchange Server connection is already open in Ontrack PowerControls.
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Chapter 2: Using Ontrack PowerControls
Overview
You can open a source Microsoft Exchange Server Database (EDB) file or PST file and specify a
target PST file or target Microsoft Exchange Server by using one of the following methods:

n Use the Data Wizard.
n Open the source database and target mailboxes from the Ontrack PowerControls main

window.

Note: You cannot open the same PST file as both source and target.

Mailbox Criteria
When selecting the EDB Source Files, you can use the "Mailbox Criteria (optional)" box to limit the
number of mailboxes that are opened and displayed in the Source pane. This box appears on the
Source Selection dialog box (opened by clicking File then Open Source) or the Source Selection
page of the Data Wizard.

When you enter a string in the Mailbox Criteria box, Ontrack PowerControls matches your entry
against the display name and alias of the mailboxes to select data in the source database. Only
mailboxes matching your entries are displayed on the Source pane.

Note:WithMicrosoft Exchange Server 2013 and later, Ontrack PowerControls matches your
Mailbox Criteria box string entry against the display nameonly.

The mailbox criteria uses a simple "string contains" match and is not case sensitive. You can use a
semi-colon to separate and enter multiple strings. If you want to include a semi-colon in one of your
entries, use double quotes around that entry.

Mailbox criteria only works with mailbox stores, it does not work with public folder stores. If you use
mailbox criteria on a public folder store, it is not used and all public folders are opened.

Note: Anymailboxes which do notmatch the entered string do not appear in the Source pane
andare not included in any subsequent tasks, such as searching, copying, and exporting of the
entire database.

Multi-Tenancy Support
Microsoft Exchange Server 2010 and later includes features that aid multi-tenancy deployments.
Ontrack PowerControls provides support for the Exchange Hosted Organizations feature
(introduced in Microsoft Exchange Server 2010 SP1) and Address Book Policies (introduced in
Microsoft Exchange Server 2010 SP2).
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When selecting the Microsoft Exchange Server 2010 and later EDB Source File or Target Server, you
can use the Multi-Tenancy Criteria box to limit the number of mailboxes that are opened and
displayed in the Source and Target panes. The Multi-Tenancy Criteria box appears on the
following pages of the Data Wizard:

n Source Selection page
n Target Selection page

When Multi-Tenancy Support is enabled, you can filter a source or target from a list of hosted
organizations or Address Book Policies (ABPs), as well as select and open all mailboxes or view
mailboxes not contained in any hosted organization (hosted environment only).

Activate Multi-Tenancy Support using the Security tab on the Preferences dialog box. For more
information, see "Security Tab".

Outlook Anywhere and Autodiscover
In Microsoft Exchange Server, the Outlook Anywhere feature (also known as RPC over HTTP) allows
clients to connect using HTTP. This enables users outside of an organization's network to connect to
the Microsoft Exchange Server without having to use a VPN. Outlook Anywhere is supported by
Microsoft Outlook 2003 and later, and Microsoft Exchange Server 2007 and later.

Note:Microsoft Outlook 2003 is not supported forMicrosoft Exchange Server 2013 or later.

With Microsoft Exchange Server 2013 and later, Direct RPC access to the Microsoft Exchange
Server is no longer supported, so Outlook Anywhere is required to connect to the server.

Ontrack PowerControls supports connecting to a Microsoft Exchange Server target using Outlook
Anywhere

Note:WithMicrosoft Outlook 2016 and later, only connectionwith Autodiscover is supported.

Autodiscover simplifies the process of connecting to a Microsoft Exchange Server by returning the
connection settings when requested by a client application. Clients such as Microsoft Outlook
can retrieve the connection settings by issuing a request to Autodiscover with the user's SMTP
email address. These settings are then used to configure the user's profile and connect.
Autodiscover is supported by Microsoft Outlook 2007 and later, and Microsoft Exchange Server
2007 and later.

Note:Microsoft Exchange Server 2007 is not supported forMicrosoft Outlook 2016 or later.

Ontrack PowerControls supports using Autodiscover when connecting to a Microsoft Exchange
Server target.

If you are using Outlook Anywhere to connect to a target Microsoft Exchange Server, Ontrack
PowerControls uses Autodiscover to determine the correct connection policies. If Autodiscover is
not in use or cannot determine the connection polices, the Outlook Anywhere page appears.
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The Outlook Anywhere page follows the Target Selection page on the Data Wizard and records
the protocol and verification method used when Ontrack PowerControls connects to a target
Microsoft Exchange Server. The Outlook Anywhere page displays the values from the most recent
successful connection using Outlook Anywhere. The values are empty if no previous connection
exists.

You can configure Ontrack PowerControls to use Outlook Anywhere and Autodiscover on the
Target Options tab of the Preference dialog box, where the Microsoft Exchange Server group
contains the following check boxes:

n Use Autodiscover to detect Microsoft Exchange Server connection settings
n Use Outlook Anywhere to connect to Microsoft Exchange Server

The following table explains the actions Ontrack PowerControls performs based on the possible
combinations of selecting or clearing these two check boxes.

Use Autodis-
cover to detect

Microsoft
Exchange Server
connection set-

tings

Use Outlook
Anywhere to
connect to
Microsoft
Exchange
Server

Action

Selected (and
Autodiscover

response
successful)

Selected Ontrack PowerControls connects to the target Microsoft
Exchange Server with Outlook Anywhere using the settings
returned by Autodiscover.

Selected (and
Autodiscover

not contacted)

Selected If a server name was entered on the Target Selection page,
Outlook Anywhere page appears. If no server name was
entered, an error message appears and the wizard stays on
the Target Selection page.

Selected (and
Autodiscover

response
successful)

Cleared Ontrack PowerControls connects to the target Microsoft
Exchange Server with RPC over TCP/IP using the server
returned by Autodiscover.

Selected (and
Autodiscover

not contacted)

Cleared If a server name was entered on the Target Selection page,
Ontrack PowerControls connects to the target Microsoft
Exchange Server with RCP over TCP/IP. If no server name was
entered, an error message appears and the wizard stays on
the Target Selection page.

Cleared Selected The Outlook Anywhere page appears.

Cleared Cleared Ontrack PowerControls connects to the target Microsoft
Exchange Server with RCP over TCP/IP.

For more information, see "Target Options Tab".
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Connecting to Office 365
When connecting to a hybrid environment (where both on-premise and Office 365 mailboxes are
present), the following apply:

n Selecting All Mailboxes (on-premise) filters out Office 365 mailboxes and displays only on-
premise mailboxes.

n Mailbox creation creates mailboxes in the on-premise environment, but only if connecting
to on-premise mailboxes. This includes connect-to-all.

n Copy edb to root of server (with mailbox creation) "Creates mailboxes in the on-premise
environment, but only if connecting to on-premise mailboxes. This includes connect-to-all.

n Copy mailbox to root of server (with mailbox creation) "Creates mailboxes in the on-premise
environment, but only if connecting to on-premise mailboxes. This includes connect-to-all

n Multi-tenancy filters out Office 365 mailboxes and displays only on-premise mailboxes. If the
ABP contains both on-premise and Office 365, only on-premise mailboxes are displayed. If
ABP contains only Office 365 mailboxes, no mailboxes are displayed.

Keyboard Shortcuts
The following table contains keyboard shortcuts for many of the common tasks performed when
using Ontrack PowerControls.

Menu Bar Keyboard Shortcut
File Menu

Open Source Ctrl+S

Open Target PST Ctrl+T

Open Target Microsoft Exchange Server Ctrl+E

Close Store Ctrl+L

Use Data Wizard Ctrl+W

Exit Alt+F4

Edit Menu

Copy Selection to Clipboard Ctrl+C

Paste Copied Item(s) Ctrl+V

Paste Special Ctrl+Y

Delete DEL

Rename Ctrl+R

New Folder Ctrl+N

New Mailbox Ctrl+M

Move To Folder (Microsoft Exchange Server as a target - Find window) Ctrl+Shift+V
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Menu Bar Keyboard Shortcut
Cut (Microsoft Exchange Server as a target - Find window) Ctrl+X

View Menu

Refresh Screen F5

Tools Menu

Export Ctrl+P

Export Organizational Forms Ctrl+G

Create Mailbox List Ctrl+Alt+L

Integrity Check Ctrl+I

Create Reports Ctrl+Q

Find F3

Online Help

View Help F1

Opening a Microsoft Exchange Server as a Target
You can open live Microsoft Exchange Servers as a target within Ontrack PowerControls using the
Data Wizard or Main Window. This means you can connect to one live Microsoft Exchange Server
at a time, establishing a single mailbox connection or connecting to all accessible mailboxes and
displaying a list of the mailboxes found in that Microsoft Exchange Server. A status indicator tells
you if you have permission rights to view a mailbox.

Note: TheMicrosoft Exchange Server as a target feature is only supported if the system running
Ontrack PowerControls is on the samedomain as theMicrosoft Exchange Server.

Recommendation: If connecting to a Microsoft Exchange Server 2010 CAS Array, use the fully
qualified domain name of the CAS Array for the Server Name (for example,
casarray.domain.name).

Mailbox Access
When connecting to a single mailbox, the Target pane populates with only the specified single
mailbox. When connecting to all mailboxes on a Microsoft Exchange Server, the Target pane
populates with the list of mailboxes found in that Microsoft Exchange Server.

Note: You can connect to only one liveMicrosoft Exchange Server at a time. If you attempt to
connect to an additional liveMicrosoft Exchange Server while a server is already open, the current
server connection closes.

If your Administrator is running Ontrack Administrative Server (OAS) and has the Mailbox Permission
plug-in activated, your access to mailboxes within a mailbox store (private EDB file) may be
affected depending on the permission settings.
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If permission to access a mailbox is denied, you are not able to access the contents of that
specific mailbox. The inaccessible mailbox either in the Source or Target pane displays with an
inaccessible icon , or is hidden depending on your Preference setting. For more information,
see "Setting Preferences".

Note:Contact your Ontrack Administrative Server systems administrator if you needaccess to
inaccessiblemailboxes.

An EDB file that is denied access through the OAS Mailbox Permission setting affects:

n Find Window: An inaccessible mailbox's contents cannot be processed during a search.
n Message Views: Any message items in an inaccessible mailbox are not displayed in a

Conversation Table View or an Attachment Table View.
n CAS as a Target: Only accessible mailbox messages in the EDB source are processed when

populating a CAS profile.
n Exporting: Inaccessible mailboxes cannot be exported.
n Copying: Inaccessible mailboxes cannot be copied.
n Integrity Checking: Inaccessible mailboxes cannot have an Integrity Check performed on

them.
n Properties: An inaccessible mailbox's properties cannot be viewed.
n Reports: Reports cannot be generated for inaccessible mailboxes.

Connection Interruption

If errors are encountered that interrupt the communication between Ontrack PowerControls and
the Ontrack Administrative Server, an error appears. You can choose to retry the failed
communication attempt. If the error is transient (for example, a temporary network failure) and
has been addressed, retrying allows Ontrack PowerControls to continue.

Note: If the error cannot be overcome, ormore than 8minutes has passed since the fault
occurred, a successful retry is not possible.

Mailbox Functions
Paste, Paste Special, folder creation, folder renaming, and the search functions are available for
the accessible mailboxes. A mailbox or server cannot be renamed.

Using the Data Wizard
The Data Wizard guides you through the loading of the Microsoft Exchange Database (EDB), PST
files, or content analysis store (CAS) files into Ontrack PowerControls, and shows you how to
specify the target PST file or Microsoft Exchange Server.
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Configuring Ontrack PowerControls
If Ontrack Administrative Server is connected and activated, you may have to manually locate a
server if Ontrack PowerControls cannot locate one automatically. By default, the automatic
location is attempted. If it fails, an error message appears.

If you select "No," Ontrack PowerControls closes. If you select "Yes," the Connection Point Manager
window appears.

Figure 2-1: Connection Point Manager

To add a server

1. Clear Use Active Directory to locate server if it is selected.
2. ClickAdd. The Server Informationwindow appears.
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Figure 2-2: Enter Server Information

3. Enter the Server address name or IP address and clickOK.

Before You Use the Data Wizard
Use the Ontrack PowerControls ExtractWizard if you have not yet restored backed-up Microsoft
Exchange Server Information Store data. The Ontrack PowerControls ExtractWizard reads previous
Microsoft Exchange Server backups and restores EDB files to any machine, volume, or folder. For
more information, see theOntrack PowerControls ExtractWizard User Guide.

Opening the Data Wizard
The first time you start Ontrack PowerControls, the Data Wizard opens at the Source Selection
page.

When working in the main window, you can return to the Data Wizard at any time.

To manually start the Data Wizard

n On the Filemenu, click Use Wizard.

Data Wizard: Source Selection
On the Source Selection page of the Data Wizard, specify the type and path of the source from
the following options:

n A PST file
n An EDB file
n A Content Analysis Store

Note:
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n If you do not want to select a source file at this time, click Skip.
n If you do not want to run the Data Wizard every time you start Ontrack PowerControls, clear

the Run on Startup check box.

To specify a PST file as the source

1. On the Source Selection page, clickOutlook Data File (*.pst) in Select Source list.
Note: You can also openMicrosoft Explorer, click the PST file youwant to open as the
source, then drag it to the Select Source list and skip the next step.

Figure 2-3: Selecting a PST file as the source

2. In theOutlook Data File (*.pst)box, click Browse to open the Create PST File window and
locate the source PST file.

3. ClickNext.

To specify an EDB file as the source

1. On the Source Selection page, click EDB File (*.edb) in Select Source list.
Note: You can also openMicrosoft Explorer, click the EDB file youwant to open as the
source, then drag it to the Select Source list and skip to step 6.
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Figure 2-4: Selecting an EDB file as the source

2. In the EDB Path (*.edb)box, click Browseand use the Open window to locate the source
EDB file.

3. In the Log File Path (*.log, *.pat, *.chk)box, click Browse to and use the Browse For Folder
window to choose the log files associated with the source EDB file.

Important:After you select an EDB file, the Log File Path box defaults to the source EDB file
path, even if the log files are not in the samedirectory as the source EDB file. Therefore,
make sure you enter the correct log file path in the Log File Path box.

4. In the Temporary File Path (*.idx, *.dat, *lkp)box, accept the default location for .idx and
.dat files, or specify a new location if they require more hard drive space. For more
information, see "Guidelines for Selecting a Microsoft Exchange Server Database".

5. If you want to view a filtered display of mailboxes in the Source pane, use theMailbox
Criteria (optional)box. For more information, see "Mailbox Criteria".

6. If multi-tenancy support is enabled, do one of the following in theMulti-Tenancy Criteria
box:

n If "Enforce ABP or Hosted Organization for current user" is not selected on the Security
tab on the Preferences dialog box, use the Multi-Tenancy Criteria box to select
hosted organizations or Address Book Policies from source or target dialog boxes.

n If "Enforce ABP or Hosted Organization for current user" is selected on the Security tab
on the Preferences dialog box, use the Multi-Tenancy Criteria box to view the
organization or assigned address book policy.

38



Figure 2-5: Selecting an EDB file as the sourcewithmulti-tenancy support

7. ClickNext.

To specify a Content Analysis Store as the source

1. On the Source Selection page, clickContent Analysis Store (*.cas) in Select Source list.
Note: You can also openMicrosoft Explorer, click theCAS youwant to open as the source,
then drag it to the Select Source list and skip the next step.
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Figure 2-6: Selecting aCAS as the source

2. In theContent Analysis Store Path (*.cas)box, click Browse to open the Create Content
Analysis File window and locate the source CAS.

3. ClickNext.

The EDB or PST file appears in the Single Mailbox Recovery Source pane.

Figure 2-7: Source pane for an EDB file
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Tip: You can use Windows Explorer to open an EDB, PST, or CAS file. In Windows Explorer, double-
click the file or drag into the Ontrack PowerControls Source pane.

Guidelines for Selecting a Microsoft Exchange Server
Database

1. For the best results when using an online incremental or differential backup:
l Put the .edb, .stm, and .pat files in one directory.
l Put the associated log files (for example, .log, .chk) in one directory.

Note: The two directories can be different.

Note:Ontrack PowerControls does not require .stm or .log files, but you should include them
to ensure that all email data is recovered

2. If you are using an offline backup: You need to use the .edb and .stm files. To ensure that all
email data is recovered, you should also include all .log files, as well as .pat and .chk files if
they exist. Ontrack PowerControls performs its own verification process and will include the
.log and .pat files to determine if it needs them to recover the data.

3. For best results when specifying a temporary file path for .idx and .dat files: Make sure you
have a sufficient amount of hard drive space for .dat and .idx files. These files may require
hard drive space equal to the size of the .log files. Therefore, you may need to change the
default file path for .idx and .dat files if you need more space.

Ontrack PowerControls never modifies an .edb file or its associated files (for example, .log,
.stm, .pat, .chk); however, it does create .dat and .idx files the first time you open an .edb
file from a directory that contains log files. Each time you reopen the .edb file, Ontrack
PowerControls uses the information in the .dat and .idx files to open the .edb file more
quickly.

Note:OnlyMicrosoft Exchange Server 2000 and 2003 use .stm files.

Data Wizard: Target Selection
On the Target Selection page of the Data Wizard, specify the type and path of the target location
for the data you want to restore from the following options:

n "To specify a PST file as the target for restored data "
n "To specify a content analysis store"
n "To specify a Microsoft Exchange Server as the target for a single on-premise mailbox"
n "To specify a single Office 365 mailbox as the target (Hybrid Modern Authentication) "
n "To specify a Microsoft Exchange Server as the target for all mailboxes"
n "To specify a Microsoft Exchange Server as the target for specific mailboxes with multi-

tenancy support"
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An option to open Public Folders is available upon connection to a Microsoft Exchange Server.
Ontrack PowerControls connects to all public folders hosted by the target Microsoft Exchange
server, not specific databases or Public Folders mailboxes.

Note:Click Skip if you do not want to select a target file at this time.

To specify a PST file as the target for restored data

1. On the Target Selection page, clickOutlook Data File (*.pst) in Select Target list.

Figure 2-8: Selecting the PST File option on the Target Selection page

2. Do one of the following:
l If you know the target PST file path, type it in theOutlook Data File (.pst)box.
l Click Browse to open theCreate PST Filewindow and navigate to the desired location.

Create a new PST file by typing a name in the File namebox, or select an existing PST file.
Next, clickOpen. The path of the target PST file appears in the Target PST File Pathbox.

3. ClickNext.
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To specify a content analysis store

1. On the Target Selection page, clickContent Analysis Store (*.cas) in Select Target list.

Figure 2-9: SelectingContent Analysis Store on the Target Selection page

2. Do one of the following:
l If you know the target CAS file path, enter it in theContent Analysis Store Pathbox.
l Click Browse to open theCreate Content Analysis Filewindow. and navigate to the

desired location. Create a new CAS file by typing a name in the File namebox or select
an existing CAS file. Next, clickOpen. The path of the target CAS file appears in the
Content Analysis Store Pathbox.

3. ClickNext.
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To specify a Microsoft Exchange Server as the target for a single on-premise mailbox

1. On the Target Selection page, click Single Mailbox (on-premise) in Select Target list.

Figure 2-10: Selecting SingleMailbox (on-premise) displays the targetMicrosoft Exchange
Server

2. In the E-mail Addressbox, type the email address name.

Tip: If you are not using Autodiscover and you do not know the full nameof themailbox,
type the first letter of themailbox in the E-mail Addressbox, and clickNext. In theCheck
Namewindow that appears, select themailbox from the list, and clickOK. If you are using
Autodiscover, youmust type the full email address in the E-mail Addressbox.

3. WithConnect To Public Folders selected, you can open public folders as a target for
restoring public folders or messages. If you do not want to restore to public folders, clear this
check box. For more information, see "Restoring to Public Folders".

4. TheConnect using Autodiscover check box determines whether Ontrack PowerControls
will use Autodiscover to connect to Microsoft Exchange Server. The default setting is
selected or cleared using the Target Options tab on the Preferences window.

5. If you are not connected to a domain, the Enter Passwordwindow appears. In this window,
enter a user name that has full rights to the mailbox, a password, and a domain name. Then
clickOK. This window may appear again, which requires you to reenter this information.

6. ClickNext.
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To specify a single Office 365 mailbox as the target (Hybrid Modern Authentication)

1. On the Target Selection page, click Single Mailbox (Office 365) in Select Target list.

Figure 2-11: Selecting SingleMailbox (Office 365) displays the target Office 365mailbox

2. In the E-mail Addressbox, type the email address name.
Note: For example of proper environment setting see "EWS Configuration".

3. In theClient IDbox, type Client ID associated with the email address.
4. In the Tenant IDbox, type Tenant ID associated with the email address.
5. In theClient Secretbox, type Client Secret associated with the email address.
6. With Connect To Public Folders selected, you can open public folders as a target for

restoring public folders or messages. If you do not want to restore to public folders, clear this
check box.

7. ClickNext.
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To specify a Microsoft Exchange Server as the target for all mailboxes

1. On the Target Selection page, clickAll Mailboxes (on-premise) in Select Target list.

Figure 2-12: Selecting All Mailboxes (on-premise) displays the targetMicrosoft Exchange
Server

2. In theDomain Controller and Server Nameboxes, the domain controller and server names
auto-populate.

Note: ForMicrosoft Exchange Server 2010, specify the nameof theClient Access Server
(CAS) that provides access to themailboxes youwant to access (not themailbox server,
unless themailbox server has the client access role installed).

Note: Themailboxes foundwill depend on both the DomainController andMicrosoft
Exchange Server entered. Only thosemailboxes accessible through the enteredMicrosoft
Exchange Server and listed in the Active Directory of the given DomainController will
attempt to be opened.

Note: ForMicrosoft Exchange Server 2013 or later, specify the nameof any of yourMicrosoft
Exchange 2013 or later Servers, or leave this field blank to auto detect. Themailboxes found
depend on theDomainController with only thosemailboxes listed in the Active Directory of
the given DomainController opened, subject to permissions.
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3. WithConnect to Public Folders selected, you can open public folders as a target for
restoring public folders or messages. If you do not want to restore to public folders, clear this
check box. For more information, see "Restoring to Public Folders".

4. If you are not connected to a domain, the Enter Passwordwindow appears. In this window,
enter a user name that has full rights to the mailbox, a password, and a domain name. Then
clickOK. This window may appear again, which requires you to reenter this information.

5. ClickNext.

To specify a Microsoft Exchange Server as the target for specific mailboxes with multi-tenancy
support

1. On the Target Selection page, click Specified Mailboxes (on-premise) in Select Target list.
2. Do one of the following:

l If "Enforce ABP or Hosted Organization for current user" is cleared on the Security tab on
the Preferences dialog box, use the Multi-Tenancy Criteria box to select hosted
organizations or Address Book Policies from source or target dialog boxes.

l If "Enforce ABP or Hosted Organization for current user" is selected on the Security tab on
the Preferences dialog box, use the Multi-Tenancy Criteria box to view the organization
or assigned address book policy.
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Figure 2-13: Selecting SpecifiedMailbox (on-premise) displays the targetMicrosoft
Exchange Server

3. In theDomain Controller and Server Nameboxes, the domain controller and server names
auto-populate.

Note: ForMicrosoft Exchange Server 2010, specify the nameof theClient Access Server
(CAS) that provides access to themailboxes youwant to access (not themailbox server,
unless themailbox server has the client access role installed).

Note: Themailboxes foundwill depend on both the DomainController andMicrosoft
Exchange Server entered. Only thosemailboxes accessible through the enteredMicrosoft
Exchange Server and listed in the Active Directory of the given DomainController will
attempt to be opened.

Note: ForMicrosoft Exchange Server 2013 or later, specify the nameof any of yourMicrosoft
Exchange 2013 or later Servers, or leave this field blank to auto detect. Themailboxes found
depend on theDomainController with only thosemailboxes listed in the Active Directory of
the given DomainController opened, subject to permissions.

4. WithConnect to Public Folders selected, you can open public folders as a target for
restoring public folders or messages. If you do not want to restore to public folders, clear this
check box. For more information, see "Restoring to Public Folders".
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5. If you are not connected to a domain, the Enter Passwordwindow appears. Enter a user
name that has full rights to the mailbox, a password, and a domain name, then clickOK. This
window may appear again, requiring you to reenter this information.

6. ClickNext.

Data Wizard: Outlook Anywhere
With the Outlook Anywhere page, you can adjust the settings for using Outlook Anywhere to
connect to the target Microsoft Exchange Server. This page appears if you are using Outlook
Anywhere, but not Autodiscover, to connect to Microsoft Exchange Server. This page also
appears if you are using Outlook Anywhere and Autodiscover to connect, but the Autodiscover
service cannot be contacted.

If Ontrack PowerControls is configured to use Outlook Anywhere, but "Connect using
Autodiscover" is not selected on the Data Wizard: Target Selection page, the Outlook Anywhere
page appears so you can configure the Outlook Anywhere connection. If "Connect using
Autodiscover" is selected, the Outlook Anywhere page does not appear, as Autodiscover
automatically configures the connection.

Note: TheOutlook Anywhere page displays the values from themost recent successful
connection usingOutlook Anywhere. The values are empty if no previous connection exists.

Figure 2-14: Outlook Anywhere page
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To complete the Outlook Anywhere page

1. On the Outlook Anywhere page, do the following:
n In the http://drop-down list, enter or select the URL to use when connecting the

Microsoft Exchange proxy server.
n If youwant to connect using only secure sockets layer, selectConnect using SSL only

and enter the connection URL in the https://drop-down list. You can require the use
of an authentication of certificate by selectingOnly connect to proxy servers that
have principal name in their certificateand entering or selecting the principal name.

2. Select from the following to use HTTP on the first connection, and TCP/IP on all subsequent
connections based on the speed of your network:

n On fast networks, connect using HTTP first, then connect using TC/IP
n On slow networks, connect using HTTP first, then connect using TC/IP

Note:Outlook defines a fast connection as a connection that is faster than 128 kilobits per
second (Kbps).

3. In the Use this authentication when connecting to my proxy server for Exchangedrop-
down list, select from the following:

n Basic: Basic authentication uses clear text to send user and password information for
authentication. If selected, the Connect using SSL only box is selected automatically
and cannot be changed. This prevents passwords from being sent to the Microsoft
Exchange proxy server in clear text when Basic authentication is used.

n NTLM Authentication: If selected, NTLM authentication is used. This is a
challenge/response scheme in which a hash of the password is used for
authentication. The password is not sent over the network.

n Negotiate Authentication: If selected, Kerberos is used for authentication, if possible.
Otherwise, NTLM authentication is used.

4. ClickNext.

Data Wizard: Connection Settings
With the Connection Settings page, you can adjust the settings to connect to the target Microsoft
Exchange Server. This page appears if Autodiscover fails to connect to the target server or
Autodiscover is not enabled in on the Preferences dialog box.
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Figure 2-15: Connection Settings page

To complete the Connection Settings page

1. On the Connection settings page, type the server name of the Target Server.
2. In the Securitydrop-down list, select the method of security when logging on to the target

server network.
3. The Connect using Outlook Anywhere check box determines whether Ontrack

PowerControls will use Outlook Anywhere (also known as RPC over HTTP) to connect to
Microsoft Exchange Server. The default setting is selected or cleared using the Target
Options tab on the Preferences window. If you choose Connect using Outlook Anywhere,
do the following:

n In the https://drop-down list, enter or select the URL to use when connecting the
Microsoft Exchange proxy server.

n If youwant to connect using only secure sockets layer, selectConnect using SSL only
and enter the connection URL in the https://drop-down list. You can require the use
of an authentication of certificate by selectingOnly connect to proxy servers that
have principal name in their certificateand entering or selecting the principal name.

4. Select from the following to use HTTP on the first connection, and TCP/IP on all subsequent
connections based on the speed of your network:

n On fast networks, connect using HTTP first, then connect using TC/IP
n On slow networks, connect using HTTP first, then connect using TC/IP

Note:Outlook defines a fast connection as a connection that is faster than 128 kilobits per
second (Kbps).
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5. In the Use this authentication when connecting to my proxy server for Exchangedrop-
down list, select from the following:

n Basic: Basic authentication uses clear text to send user and password information for
authentication. If selected, the Connect using SSL only box is selected automatically
and cannot be changed. This prevents passwords from being sent to the Microsoft
Exchange proxy server in clear text when Basic authentication is used.

n NTLM Authentication: If selected, NTLM authentication is used. This is a
challenge/response scheme in which a hash of the password is used for
authentication. The password is not sent over the network.

n Negotiate Authentication: If selected, Kerberos is used for authentication, if possible.
Otherwise, NTLM authentication is used.

6. ClickNext.

Data Wizard: Now Processing Data File
TheNow Processing Data Filepage of the Data Wizard reports the processing of the EDB file in
three stages:

1. Pre-scanning the log files (integrity check)
2. Scanning the log files (playing the log files)
3. Hashing the EDB file (building a folder hierarchy)

When the processing is complete, the Data Wizard closes.

Note: If Ontrack PowerControls encounters bad ormissing log files during log playing, youwill be
given the option to continuewithout playing the logs. If you choose to continue, Ontrack
PowerControls processes the EDBwithout logs.

Results of Data Wizard
When you complete the Data Wizard, the Source and Target panes in the main window now
contain a source EDB file, PST file, CAS, target PST file, a target Microsoft Exchange Server, or target
CAS.

52



Source pane with a PST file Source pane with an EDB file Source pane with CAS files

Figure 2-16: Source paneswith PST, EDB, andCAS files

Target pane with a
PST file

Target pane for a Microsoft
Exchange Server

Target pane with CAS files
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Figure 2-17: Target panes for PST files, Microsoft Exchange Server, andCAS file

Opening the Source Database and Target
Mailboxes from the Main Window
Instead of using the Data Wizard to open the source databases and target mailboxes, you can
open them from the main window.

Before You Proceed
Before you proceed with opening source databases and target mailboxes, here is important
information that will help enable smooth operation of Ontrack PowerControls.

Ontrack PowerControls ExtractWizard
Use the Ontrack PowerControls ExtractWizard if you have not yet restored backed-up Microsoft
Exchange Server Information Store data. The Ontrack PowerControls ExtractWizard reads previous
Microsoft Exchange Server backups and restores EDB files to any machine, volume, or folder. For
more information, see theOntrack PowerControls ExtractWizard User Guide.

Note: Due to the database nature of the PST file andMAPI subsystem, PSTs openedas source are
modified.

Opening a Source and a Target from the Main Window
The section explains how to perform the following tasks from the Main Window:

n "To open a source file".
n "To open an existing target PST".
n "To create a new target PST".
n "To open an existing target content analysis store".
n "To open a new target content analysis store".
n "To open a Microsoft Exchange Server as the target for restored data for a single on-

premise mailbox"
n "To open an Office 365 single mailbox as the target for restored data"
n "To open a Microsoft Exchange Server as the target for restored data for all mailboxes"
n "To open a Microsoft Exchange Server as the target for restored data for Specific Mailboxes

with multi-tenancy support"

54



To open a source file

1. Do one of the following:
n On the Filemenu, clickOpen Source.

n On the toolbar, click theOpen Source icon .

Important: Before you select a source EDB file in the window below, see "Guidelines for
Selecting a Microsoft Exchange Server Database".

2. Follow the instructions in the "Data Wizard: Source Selection" topic "Data Wizard: Source
Selection ".

3. ClickOK. The EDB, PST, or CAS file appears in the Ontrack PowerControls Source pane.

To open an existing target PST

1. Do one of the following:
n On the Filemenu, point toOpen\Create Target, thenOpen Target PST, and click

Open Existing.

n On the toolbar, click theOpen Target PST icon .

2. In theOpen Target PSTwindow, navigate to the desired location, and select an existing PST
file.

3. ClickOpen. The PST file appears in the Ontrack PowerControls Target pane.

Tip: In Windows Explorer, you can drag a PST file into the Ontrack PowerControls target
pane.

To create a new target PST

1. On the Filemenu, point toOpen\Create Target, thenOpen Target PST, and clickCreate
New.

2. In theCreate PST Filewindow, navigate to the desired location. You may want to create a
new folder.

3. In the File namebox, type a name for the new PST file.
4. ClickOpen. The PST file appears in the Ontrack PowerControls Target pane.

Note:WithMicrosoft OfficeOutlook 2003, you have to choose between the 97 and 2003
version of the PST.
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Figure 2-18: Target pane for a PST file

To open an existing target content analysis store

1. Do one of the following:
n On the Filemenu, point toOpen\Create Target, then clickOpen Target Content

Analysis Storeand clickOpen Existing.....

n On the toolbar, click theOpen Target Content Analysis Store icon .

2. In theOpening a Content Analysis Filewindow, navigate to desired location and select an
existing CAS file.

3. ClickOpen. The CAS file appears in the Ontrack PowerControls Target pane.

To open a new target content analysis store

1. Do one of the following:
n On the Filemenu, point toOpen\Create Target, then clickOpen Target Content

Analysis Storeand clickCreate New..... TheCreate Content Analysis File window
appears.

n On the toolbar, click theOpen Target Content Analysis Store icon . TheOpening
a Content Analysis Filewindow appears.

2. In theOpening a Content Analysis Filewindow, navigate to desired location and in type a
File Name for the new CAS file.

3. ClickOpen. The CAS file appears in the Ontrack PowerControls Target pane.

To open a Microsoft Exchange Server as the target for restored data for a single on-premise
mailbox

1. Do one of the following to display the Target Selectionpage of the Data Wizard:
n On the Filemenu, clickOpen\Create Target, then clickOpen Target Exchange

Server.

n On the toolbar, click theOpen Target Exchange Server icon .
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2. Follow the instructions in the "Data Wizard: Target Selection" topic "To specify a Microsoft
Exchange Server as the target for a single on-premise mailbox".

To open an Office 365 single mailbox as the target for restored data

1. Do one of the following to display the Target Selectionwindow:
n On the Filemenu, clickOpen\Create Target, and then clickOpen Target Exchange

Server.

n On the toolbar, click theOpen Target Exchange Server icon .

2. Follow the instructions in the "Data Wizard: Target Selection" topic "To specify a single Office
365 mailbox as the target (Hybrid Modern Authentication) ".

To open a Microsoft Exchange Server as the target for restored data for all mailboxes

1. Do one of the following to display theConnect To Exchange Serverwindow:
n On the Filemenu, clickOpen\Create Target, and then clickOpen Target Exchange

Server.

n On the toolbar, click theOpen Target Exchange Server icon .

2. Follow the instructions in the "Data Wizard: Target Selection" topic "To specify a Microsoft
Exchange Server as the target for all mailboxes".

To open a Microsoft Exchange Server as the target for restored data for Specific Mailboxes with
multi-tenancy support

1. Do one of the following to display theConnect To Exchange Serverwindow:
n On the Filemenu, clickOpen\Create Target, and then clickOpen Target Exchange

Server.

n On the toolbar, click theOpen Target Exchange Server icon .

2. Follow the instructions in the "Data Wizard: Target Selection" topic "To specify a Microsoft
Exchange Server as the target for specific mailboxes with multi-tenancy support".

Opening Multiple Sources and Targets
You can display multiple sources in the Source pane and multiple targets in the Target pane.
Sources include EDB, PST, and CAS files. Targets include PSTs, CAS, and Microsoft Exchange
Servers. See the instructions for using the Data Wizard or the main window to open one source or
one target at a time.
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Multiple sources Multiple targets

Figure 2-19: Multiple sources and targets can be displayed

Closing Sources and Targets
You can close sources and targets from the Ontrack PowerControls main window.

To close a source

1. In the Source pane, select a source EDB, PST, or CAS file.
2. Do one of the following:

n On the Filemenu, clickClose Store.
n Right-click the selection, and on the context menu clickClose Store.

To close all sources

1. In the Source pane, right-click the sources root node.
2. On the context menu, clickClose All Stores.

To close a target

1. In the Target pane, select a PST file, Microsoft Exchange Server database, or CAS file.
2. Do one of the following:

l On the Filemenu, clickClose Store.
l Right-click the selection, and on the context menu clickClose Store.
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Deleting Items in the Target Pane
Using the Delete key to remove an item (for example, folder, message) from the Ontrack
PowerControls Target pane permanently deletes the item, similar to using Shift+Delete in Microsoft
Office Outlook.

Note:Messages within a content analysis store profile folder cannot be deleted.

Creating New Mailboxes
You can create new mailboxes by either using the Mailbox Creation wizard or the Copy and Paste
functions. Possible uses for this function are migrating user accounts from an older version of
Microsoft Exchange Server or archiving legacy data.

Note: To useMailbox CreationWizard on your computer, youmust have the Exchange Server
Management Tools for the version ofMicrosoft Exchange Server where youwill be creating
mailboxes. Ensure the Exchange ServerManagement Tools andMicrosoft Exchange Server
version, service pack, and roll up level are the same version. For supported operating systemand
prerequisite requirements for the Exchange ServerManagement Tools, please refer to the
Exchange ServerManagement Tools documentation for your specific version.

User Permission
In order to create mailboxes, the following are required:

n You must have the necessary Active Directory permissions to create a mailbox on the
selected Microsoft Exchange Server.

n Both the user account logons and the Name field must be unique to create a new user
account and mailbox. If you are creating a mailbox for an existing user, the Name field must
match the full name of the existing user.

Tip: It is recommended that anyone creating mailbox-enabled users have fundamental
knowledge of Microsoft Exchange Server administration and Active Directory.

Preference Settings
The Target Options tab of the Preferences dialog box contains a Mailbox Creation group with the
following option:

n Allow mailbox creation during copy

When selected, a copy operation can create new mailboxes, so a copy operation can create a
target mailbox for a source mailbox to allow it to be copied.

59



When cleared, new mailboxes are not created and only mailboxes that match an existing
mailbox can be copied. Any mailboxes that do not match a target mailbox are skipped.

The Security tab of the Preferences dialog box contains the following option regarding mailboxes:

n List inaccessible mailboxes

When selected, mailboxes always appear in the Target pane and mailboxes will indicate if they
are accessible. Otherwise, inaccessible mailboxes are not displayed.

For more information, see "Setting Preferences".

Creating Mailboxes
You can create mailboxes with the Mailbox Creation wizard or by copying a single mailbox. You
can also copy the root of a source EDB to the root of a target Microsoft Exchange Server.

If the mailbox already exists and is accessible, it is added to the target directory and shown as
accessible. If the source mailbox did not exist in the target directory, a new mailbox is created on
either a new user account or an existing user account. If the mailbox you create is not accessible,
it appears in the target directory and shown as inaccessible.

Note:Mailbox creation on disabled user accounts is not supported.

Note: The targetMicrosoft Exchange Servermust be in the samedomain as theOntrack
PowerControlscomputer.

Note: In aMicrosoft Exchange Server 2010 environment installed using the /hosting switch,
mailboxes can only be created in the domain, not an Exchange HostedOrganization.

Note: In aMicrosoft Exchange Server 2010 or 2013 environment that has deployedAddress Book
Policies, an Address Book Policy cannot be assignedwhen creating amailbox.

Creating Mailboxes Using the Mailbox Creation Wizard
You can manually create a single mailbox on a target Microsoft Exchange Server by using the
Mailbox Creation wizard to specify user account and mailbox information.

To create a Microsoft Exchange Server 2007 mailbox using the wizard

1. Open a target Microsoft Exchange Server in Ontrack PowerControls.
2. Do one of the following to open the Mailbox Creation wizard:

n Right-click the target Microsoft Exchange Server root directory and clickNew
Mailbox.

n On the Editmenu, clickNewMailbox.
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Figure 2-20: User Information page forMicrosoft Exchange Server 2007

3. On the User Informationpage, enter the following:
n Organizational unit: This field is pre-populated. You can change it by clicking Browse.
n First name: (Optional) Enter the first name of the user. If a user account already exists,

but there is no mailbox based on this Name, the mailbox is created on the existing
user account.

n Initials: (Optional) Enter the initials of the user.
n Last name: (Optional) Enter the last name of the user. If a user account already exists,

but there is no mailbox based on this Name, the mailbox is created on the existing
user account.

n Name: This field auto-populates as the First name, Initials, and Last name are entered.
This field can also be modified.

n User logon name (User Principal Name):Create a user logon name for the new
account. If this name matches the same field of an existing user account, an error
appears at the end of the process indicating that it is a duplicate.

n UPN suffix: This field adds the Organizational Unit selected as the second half of the
logon name email address.

n User logon name (pre-Windows 2000):A user logon name for older versions of
Windows.

n Password and Confirm Password: The password must meet the domain's minimum
password requirements or the user/mailbox creation will fail.

n Save as default password: Select to designate the entered password as the default.
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4. ClickNext.

Figure 2-21: Mailbox Settings page forMicrosoft Exchange Server 2007

5. On theMailbox Settingspage, do the following:
n Alias: Enter the alias for the mailbox user.
n Server:Auto-populated with the Storage groupandMailbox database. Ensure these

settings are correct.
n Mailbox database: The mailbox database is automatically selected by the Microsoft

Exchange Server if not specified. To specify the mailbox database, select the check
box which enables the drop-down list of all available mailbox databases.

n Managed folder mailbox policy: (Microsoft Exchange Server 2007 only) To apply a
managed folder policy to your mailbox, select the check box which enables the
drop-down list of all available managed folder mailbox policies in the organization.

n Exchange ActiveSync mailbox policy: (Microsoft Exchange Server 2007 only) To
apply an ActiveSync mailbox policy to your mailbox, select the check box which
enables the drop-down list of all available ActiveSync mailbox policies in the
organization.

6. Click Finish. The mailbox information is validated and the mailbox is created.
Note: If theManaged foldermailbox policy check box is selected, awarning appears
stating: "When assigning amanaged foldermailbox policy withmanaged custom folders to
amailbox, Microsoft OfficeOutlook clients older thanMicrosoft OfficeOutlook 2007 do not
have all available client features and clients older thanMicrosoft OfficeOutlook 2003 SP2
are not supported. Are you sure youwant to assign amanaged foldermailbox policy to this
mailbox?"
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To create a Microsoft Exchange Server 2010 (and later) mailbox using the wizard

1. Open a target Microsoft Exchange Server in Ontrack PowerControls.
2. Do one of the following to open the Mailbox Creation wizard:

n Right-click the target Microsoft Exchange Server root and clickNewMailbox
n On the Editmenu, clickNewMailbox.

Figure 2-22: User Information page forMicrosoft Exchange Server 2010 and later

3. On the User Informationpage, enter the following:
n Organizational unit: The Organizational Unit is automatically selected by the

Microsoft Exchange Server if not specified. You can change it by selecting the
Specify the Organizational unit rather than using a default one check box. Select this
check box to enable the Browsebutton where you can select a different
Organizational unit.

n First name: (Optional) Enter the first name of the user. If a user account already exists,
but there is no mailbox based on this Name, the mailbox is created on the existing
user account.

n Initials: (Optional) Enter the initials of the user.
n Last name: (Optional) Enter the last name of the user. If a user account already exists,

but there is no mailbox based on this Name, the mailbox is created on the existing
user account.
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n Name: This field auto-populates as the First name, Initials, and Last name are entered.
This field can also be modified.

n User logon name (User Principal Name):Create a user logon name for the new
account. If this name matches the same field of an existing user account, an error
appears at the end of the process indicating that it is a duplicate.

n UPN suffix: This field adds the Organizational Unit selected as the second half of the
logon name email address.

n User logon name (pre-Windows 2000):A user logon name for older versions of
Windows.

n Password and Confirm Password: The password must meet the domain's minimum
password requirements or the user/mailbox creation will fail.

n Save as default password: Select this check box to designate the entered password
as the default.

4. ClickNext.

Figure 2-23: Mailbox Settings page forMicrosoft Exchange Server 2010 and later

5. Enter the followingMailbox Settings:
n Alias: Enter the Alias for the mailbox user.
n Mailbox database: The mailbox database is automatically selected by the Microsoft

Exchange Server if not specified. To specify the mailbox database, select the check
box which enables the drop-down list of all available mailbox databases.
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n Managed folder mailbox policy: (Microsoft Exchange Server 2010 only) To apply a
managed folder policy to your mailbox, select the check box which enables the
drop-down list of all available managed folder mailbox policies in the organization.

n Exchange ActiveSync mailbox policy: To apply an ActiveSync mailbox policy to your
mailbox, select the check box which enables the drop-down list of all available
ActiveSync mailbox policies in the organization.

Note: If theManaged foldermailbox policy check box is selected, awarning appears
stating: "When assigning amanaged foldermailbox policy withmanaged custom
folders to amailbox, Microsoft OfficeOutlook clients older thanMicrosoft Office
Outlook 2007 do not have all available client features and clients older thanMicrosoft
OfficeOutlook 2003 SP2 are not supported. Are you sure youwant to assign a
managed foldermailbox policy to this mailbox?"

6. ClickNext. The mailbox information is validated.
7. If you are creating aMicrosoft Exchange Server 2010 (or later) mailbox, and theArchive

Settingspage appears. Select theCreate an archive mailbox for this account to associate
an online archive mailbox with the user account. To specify the mailbox database, select
the check box which enables the drop-down list of all available mailbox databases.

Figure 2-24: Archive Settings for Microsoft Exchange Server 2010 and later

Note: If usingMicrosoft Exchange Server 2010 SP1 and later or Microsoft Exchange Server
2013, themailbox database can be selected.

8. Click Finish. The mailbox is created.
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Creating Mailboxes Using Copy and Paste
You can create new mailboxes by using the Copy and Paste functions. Mailbox creation through
copying can be made available or unavailable by selecting or clearing an option in the Mailbox
Creation group on the Target Options page of the Preferences dialog box.

Note: Source archivemailboxes are treated like regularmailboxes for the purposes of copy and
creation.When copying an archivemailbox to a targetMicrosoft Exchange Server root, the
applicationwill attempt to identify an existing target usermailbox. If one cannot be found, a new
mailbox is created and copied to. Target archivemailboxes will not be the destination of a single
ormultiplemailbox copy operation.

To create a single mailbox using copy and paste

1. Verify thatAllow mailbox creation during copy option in Preferences is selected. For more
information, see "Target Options Tab".

2. Right-click the single mailbox in the Source pane and clickCopy.
3. Highlight the target Microsoft Exchange Server and click Paste.

Note: If Paste is not available, you do not have access rights to the sourcemailbox.

Ontrack PowerControls queries the Active Directory for an existing mailbox-enabled user
account based on the source mailbox's GUID and name information. If the search finds
both (a full match), Ontrack PowerControls copies the mailbox to that full matching user's
mailbox. If the search finds only a name match, it is considered a partial match. The name
match includes checks for both the source mailbox name and alias (if it is available) in the
target environment. When a partial match is found, the target mailbox may not be for the
same user as the source mailbox. You are then prompted on how to proceed (either by
skipping, copying to the matching mailbox, or creating a new mailbox and copying into
that – see below for further details).

Note: Alias is not present inMicrosoft Exchange Server 2013 and later sources, so only a
match on themailboxGUID is considered a full match forMicrosoft Exchange Server 2013
and later sourcemailboxes. If no full matching user account exists, theMailbox Creation
wizard opens.

4. If a full matchingmailbox is not found in the target, theMailbox Copywizard opens the
Mailbox Copy Options page.

5. If nomatch is found on the target, do one of the following inNo Matchgroup:
n Select Skip Mailbox to skip this mailbox and not copy it. (The Mailbox Creation wizard

closes and the process ends.)
n SelectCreate and copy to newmailbox to proceed with the Mailbox Creation wizard

and create a new target mailbox for this copy.
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Figure 2-25: Mailbox CopyOptions page - NoMatch

6. If a partial match is found on the target,do one of the following in Partial Matchgroup:
n Select Skip Mailbox to skip this mailbox and not copy it. (The Mailbox Creation wizard

closes and the process ends.)
n SelectCopy to existing mailbox to copy the mailbox. (The Mailbox Creation wizard

closes and the copy begins.)
n SelectCreate and copy to newmailbox to proceed with the Mailbox Creation wizard

and create a new target mailbox for this copy.
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Figure 2-26: Mailbox CopyOptions page - Partial Match

7. ClickNext.
8. If you selected theCreate and copy to newmailbox option: Confirm the content of the User

Informationpage is correct or make any changes and clickNext.
9. Confirm the content of theMailbox Settings is correct or make any changes and click Finish

(orNext, if using Microsoft Exchange Server 2010 or later). The mailbox information is
validated.

Note: If the sourcemailbox does not have an alias (as is the casewithMicrosoft Exchange
Server 2013), the UPN, user logon name (pre-Windows 2000), andAlias are auto-generated
based on the sourcemailbox name.

10. If you are usingMicrosoft Exchange Server 2010 or later, theArchive Settingspage appears.
Select theCreate an archive mailbox for this accountto associate an online archive
mailbox with the user account. To specify the mailbox database, select the check box
which enables the drop-down list of all available mailbox databases.
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Figure 2-27: Archive Settings for Microsoft Exchange Server 2010 and later

Note: If usingMicrosoft Exchange Server 2010 SP1 and later or Microsoft Exchange Server
2013, themailbox database can be selected.

11. Click Finish. The mailbox is created and the copy proceeds. Progress information appears in
a Report dialog box.

12. Click Print to print the report, Save to save the report to your hard drive, orClose to close the
Copy Progress window. The mailbox from the source EDB you copied is now a new mailbox
in the Target pane.

To create multiple Microsoft Exchange Server mailboxes using copy and paste

1. Verify thatAllow mailbox creation during copy option in Preferences is selected. For more
information, see "Target Options Tab".

2. Do one of the following:
n Right-click the EDB file root node in the source tree and clickCopy. Then highlight the

target Microsoft Exchange Server and click Paste.
Note: If Paste is not available, you do not have access rights to the sourcemailbox.

n Select the EDB file root node in the source tree and drag it to the Microsoft Exchange
Server node in the target tree.
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TheNewMailboxwizard opens the Mailbox Copy Options page, which allows you to
customize the behavior when copying all the mailboxes in the source EDB. Here you
configure the wizard to process the possible scenarios of no match, partial match, and
public folder mailboxes during the copy. While the likelihood of each scenario during the
copy is unknown, the Mailbox Copy Option page allows you to instruct the wizard how to
process each one if it occurs during the copy.

3. If nomatch is found on the target for one the sourcemailboxes, choose one of the following
inNo Matchgroup:

n Select Skip Mailbox to skip the mailbox and not copy it. Mailboxes with no match
found during the copy are skipped.

n SelectCreate and copy to newmailbox to create a target mailbox and copy to it.
Mailboxes with no match found during the copy have a new target mailbox created
and copied to that new target mailbox.

4. If a partial match is found on the target for of the sourcemailboxes, choose one of the
following in Partial Matchgroup:

n Select Skip Mailbox to skip the mailbox and not copy it. Mailboxes with a partial
match found during the copy are skipped.

n SelectCopy to existing mailbox to copy the mailbox to the existing mailbox (no new
mailbox is created). Mailboxes with a partial match found during the copy are
copied to the partial matching mailbox.

n SelectCreate and copy to newmailbox to create a new target mailbox and copy to
the mailbox to that target. Mailboxes with a partial match found during the copy
have a new target mailbox created and copied to that new target mailbox.
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Figure 2-28: Mailbox CopyOptions page

5. If the source EDB originates fromaMicrosoft Exchange Server 2013 and later and the target
is connected to All Public Folders, choose one of the following in the Public Folder
Mailboxes group:

n Select Skip Mailbox to not copy the public folders contained in Public Folder
mailboxes found during the copy.

n SelectCopy to public folders to copy the public folders in Public Folder mailboxes
found during to copy to the target's All Public Folders.
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Figure 2-29: Mailbox CopyOptions - Public FolderMailboxes

6. ClickNext.
If you selectedCreate and copy to a newmailbox in No Match or Partial Match, the
Mailbox Creation wizard proceeds. Otherwise, the copy begins.

7. Confirm the content of the User Informationpage is correct or make any changes and click
Next.
Note: Not all fields can be changed.

8. Confirm the content of theMailbox Settings is correct or make any changes and clickNext.
Note: When copyingmultiplemailboxes, the UPN, user logon name (pre-Windows 2000),
andAlias for newmailboxes are auto-generated based on the sourcemailbox. If the source
mailbox contains an alias (Microsoft Exchange Server 2010 and earlier) this is used. If the
sourcemailbox does not contain an alias (as is the casewithMicrosoft Exchange Server
2013), the sourcemailbox name is used (after removing any illegal characters).
Alternatively, a different type value can be used. By selecting the 'Alias base' check box,
these fields are set to an auto-generated value that is a number appended to the Alias
base (or just a number if the Alias base is empty). If you choose, you can change the field
values on the NewMailbox Summary page for anymailbox being created as part of the
copy.
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Figure 2-30: Mailbox Settings (Microsoft Exchange Server 2010 and later) - Multiple copy

Figure 2-31: Mailbox Settings (Microsoft Exchange Server 2007 and earlier) - Multiple copy
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Note: IfManaged folder mailbox policy is selected, awarning appears stating: "When
assigning amanaged foldermailbox policy withmanaged custom folders to amailbox,
Microsoft OfficeOutlook clients older thanMicrosoft OfficeOutlook 2007 do not have all
available client features and clients older thanMicrosoft OfficeOutlook 2003 SP2 are not
supported. Are you sure youwant to assign amanaged foldermailbox policy to this
mailbox?"

9. If you are usingMicrosoft Exchange Server 2010 or later, theArchive Settingspage appears.
Select theCreate an archive mailbox for this accountto associate an online archive
mailbox with the user account. To specify the mailbox database, select the check box
which enables the drop-down list of all available mailbox databases.

Figure 2-32: Archive Settings for Microsoft Exchange Server 2010 and later

Note: If usingMicrosoft Exchange Server 2010 SP1 and later or Microsoft Exchange Server
2013, themailbox database can be selected.

10. ClickNext. Ontrack PowerControls analyzes the source and target selections to determine
the new mailboxes that will be created on the target. While performing this analysis, the
Identifying New Mailboxes page appears and displays progress information.

Note: If the 'Alias base' check box on theMailbox Settings page is selected, the UPN, user
logon name, andAlias are auto-generated using the Alias base field value. Otherwise, the
values are set based on the sourcemailbox. This initial auto-generated value can be
modified on the NewMailbox Summary page using the Edit Mailbox Itemdialog box.

11. When Ontrack PowerControls finishes analyzing, the progress information clears and the
Mailbox Creation wizard displays the New Mailbox Summary page.
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12. On the New Mailbox Summary page, review the list of mailboxes to be created.

Figure 2-33: NewMailboxes Summary page

13. If youwant to edit amailbox, do the following:
n Select the mailbox and click Edit Item or double-click the mailbox.
n Use the Edit Mailbox Item dialog box to make changes to any target information and

clickOK to validate the new content.

75



Figure 2-34: Edit Mailbox Itemdialog box

n If the information you supply is not valid, an error message appears. Correct the issue
on the Edit Mailbox Item dialog box and clickOK.

14. On the New Mailbox Summary page, clear the check box for any mailboxes you want to
skip entirely (do not create and copy). You can select or clear the entire list by clicking
Check All or Uncheck All.

15. Select Report file if you want to generate a CSV file listing the Source Mailbox Name, Target
User Name, User Principal Name, and Alias for each mailbox created during the copy.

16. Click Finishand the copy proceeds with progress information appearing in the Report
dialog box.

17. Click Print to send the report to a printer, Save to save the report to a hard drive, orClose to
close the Copy Progress window. Each mailbox from the source EDB you copied that did
not previously exist is now listed as a new mailbox in the Target pane.

Licensing Information
License information for the Microsoft Exchange Server database currently in use can be obtained
by right-clicking on the source root in the Source pane and selecting Save Licensing Information.

The file saves into a text format and automatically names it "ServerProperties.txt."
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Auditing Failure
If your Administrator is running the Ontrack Administrative Server auditing service, any failure of the
audit log warns you with a message, giving you the option to retry, re-connect, or abort Ontrack
PowerControls or Ontrack PowerControls ExtractWizard. Once the audit log is confirmed to have
failed, Ontrack PowerControls or Ontrack PowerControls ExtractWizard starts the process of
shutting down.

Contact your Administrator if restarting the applications is not successful.
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Chapter 3: Finding Messages
Overview
The Find in Source window lets you search a source EDB, PST, or CAS file for message items that are
defined by such criteria as keywords, message senders and recipients, and message creation
dates. In addition, this window lets you define the scope of your search: an EDB, PST, or CAS file,
one or more mailboxes or folders (for example, Inbox), dates, or even previous search results.

The Find in Exchange Server Target window adds the ability to search a live Microsoft Exchange
Server target and perform actions on the search results.

Guidelines for Using the Find Window
n The Find Nowbutton only becomes available ifat least one of the following conditions is

met:
l At least one Search in check box is selected.
l The Sent from or Sent tobox contains at least one character.
l TheCreated Dated after orCreated Dated before check box is selected.

n Each Search in check box that you select is run as a separate query, and the results of the
query are combined (i.e., OR'd together). For example, if you enter "solution" in the Search
for wordsbox, and then select theMessage SubjectandMessage Body check boxes,
Ontrack PowerControls will return message items that contain "solution" in either the
message subject or message body.

n If you select one or more Search in check boxes, but specify no additional search criteria,
Ontrack PowerControls will return all of the message items in the folder(s) undergoing the
search.

n Ontrack PowerControls can search multiple information stores at the same time. In the Find
in Source window, click Browseand you will see a tree view of all of the open source data
stores. You can then select multiple mailboxes or folders to include in your search.

n Ontrack PowerControls does not return duplicates of a message item during a search as
long as the "Check for duplicate messages during search" preference is selected. For
example, if the same message item exists in two or more data stores, only the first message
item found is listed in the search results.

n The contents of an inaccessible EDB mailbox cannot be searched.
n Messages in the Microsoft Exchange Server 2010 or later Recoverable Items folder are

included in search results only if the Show Recoverable Itemspreference is enabled. For
more information about setting preferences, see "Security Tab" .

n If you use the "Mailbox Criteria (optional)" box on the Select Source Files dialog box or the
Source Selection page of the Data Wizard, only EDB mailboxes containing your entry (or
entries) are displayed on the Source pane. Any mailboxes that do not match the entered
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string(s) do not appear in the Source pane and are not be included in any subsequent tasks
(such as searching, copying, and exporting of the entire database). For more information,
see "Mailbox Criteria".

n If you use the "Multi-Tenancy Criteria" box on the Select Source Files dialog box, the Source
Selection page of the Data Wizard, the Connect to Exchange Server dialog box, or the
Target Selection page of the Data Wizard, only mailboxes contained in the selected
Address Book Policy or Organization appear in the Source or Target panes. Only these
mailboxes are included in any subsequent tasks (such as searching, copying, and exporting
of the entire database). For more information, see "Multi-Tenancy Support".

Searching Sources
The Find in source window provides the ability to search single or multiple mailboxes and perform
actions on the search results.

Tip: CAS and PST files are searchable in the Source pane but not in the Target pane.

The actions allowed to perform on search results are copying or exporting message items,
performing Integrity Checks, and viewing message items using the Message Views options. You
can have several Find in Source windows open at a time.

To search for message items in sources

1. In the Source pane, select the folder (for example, EDB or PST file, mailbox, Inbox) you want
to search. The folder(s) you select defines the scope of your search.

2. Do one of the following:
l Click Find in the toolbar to display the Find in Source window. The name of the folder

you selected appears next to the Search in folderbox.
l Right-click the file and click Find.
l On the Toolsmenu, click Find.
l Press F3

Note: The first time you search for amessage item, the Search in folder option is
automatically selected. For information on using the Search in results option, see "Searching
Within Results".

3. To search multiple mailboxes or folders, click Browse. In the Select Folder(s)window, select
the items you want to search. In the illustration below, two folders have been selected.
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Figure 3-1: You can selectmultiple folders ormailboxes to search.

Note: If you select the Search Subfolders check box, Ontrack PowerControls includes
subfolders in the search.

4. ClickOK to return to the Find in Source window.
5. In the Search for words box, enter one or more words or phrases if you want to execute a

keyword search. Keep in mind the following points:
l Put a space between words or phrases to perform an AND operation (i.e., all words must

be matched in order to include a message item with the search results).
l Put a comma between words or phrases to perform an OR operation (i.e., only one of

the words must be matched in order to include a message item with the search results).
l Put quotation marks around word phrases (i.e., the exact phrase must be matched in

order to include a message item with the search results).

Example: Search for words:dog cat mouse, rat

Search results: Message items that contain ["dog" AND "cat" AND "mouse"] OR ["rat"]
are included in the search results.

6. In the Exclude wordsbox, enter words or phrases if you want to perform a NOT operation. If
matched, these words or phrases will exclude a message item from the search results. The
rules for using spaces, commas, and quotation marks apply when excluding words from a
search.

Example: Search for words: dog cat mouse, rat

Exclude words: bird
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Search results: Message items that contain ["dog" AND "cat" AND "mouse"] OR ["rat"]
BUT NOT ["bird"] are included in the search results.

7. For Search in, select one or more of the following check boxes:Message Subject,Message
Body,Attachment File Name(s), orAttachment Text. Each Search in check box that you
select is run as a separate query, and the results of the query are combined (i.e., OR'd
together).

Note:Ontrack PowerControls has the ability to searchmultiple levels of embedded
message items. SelectAttachment Text in the Select in check box. See "Searching
Embedded Message Items" for more information.

Note about searching within attachments: Ontrack PowerControlsdoes not searchwithin
archive file types (such as .zip or .rar files). Formore information, see "Searching Within
Attachments".

8. In the Sent fromand Sent toboxes, enter the appropriate names, if desired. Using the Sent to
box is particularly useful if you are trying to find a message item sent to multiple people. The
rules for using spaces, commas, and quotation marks apply when using the Sent fromand
Sent toboxes.

9. ForDate, select an action performed on the document (such as Received, Sent, or Due) as
a search criteria, if desired. This searches for documents based on when that action
occurred.

10. ForAfterand Before, select the appropriate check box, if desired. You may select both
check boxes. Then type or select the part of the date you want to change.
l After: Searches for documents created on or after the selected date.
l Before: Searches for documents created on or before the selected date.

11. When you have finished specifying search criteria, click Find Now. The results of your search
appear in the message item list. In Search Results column, the Date displays the time of the
action selected in the Time search criteria.

12. To preview the message items returned by the search, click the Preview check box.
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Figure 3-2: Findwindowwith results andmessage pane

Searching Embedded Message Items
You can search multiple levels of embedded message items in Ontrack PowerControls.

Note: Searching attachments (email and non-email) is available only when the Agent for
Advanced Searching forMicrosoft Exchange Server is enabled. See "Enabling the Licensed
Agents" in the Readme file.

To search embedded message items

1. Perform steps 1 through 6 in "Searching Sources".
2. For Search in, clickAttachment Text.
3. Continue with step 8 in the "Searching Sources"process.

Searching Within Results
The Search in results option lets you refine the search process using the previous search results.
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To search within results

1. To make the Search in results option available, you must perform at least one search.
2. Modify the search criteria as desired. For information on specifying search criteria, see

"Searching Sources".
3. Select the Search in results option at the top left of the Find in Source window.
4. Click Find Now. The results of your new search appear in the message item list.
5. To preview the message items returned by the search, click the Preview check box.

Figure 3-3: Checking the Preview option adds amessage Previewpane

Viewing Previous Search Results
You can click the Previous button multiple times to return to any previous search criteria and
search results. This button becomes unavailable when there are no more previous results.
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To view previous search results

1. Perform at least two searches so the Previousbutton becomes available.
2. Click Previous. The results of the previous search appear in the in the message item list.
3. You can now view the previous search, or you can modify the search criteria and conduct

a new search. For information on specifying search criteria, see "Searching Sources".

Clearing Fields and Results
If you click the Clear Fields button, all of the search criteria that you entered in the Find in Source
window are returned to the default settings. If you click the Clear Results button, all current and
past search results are cleared.

Searching Microsoft Exchange Server Target
You can search a live Microsoft Exchange Server target and delete, move, copy, or export the
search results. This means you can search and delete, or move specific message items from a
Microsoft Exchange Server target. You can have only one search session Find in Exchange Target
window open at one time.

Note:Only accessiblemailboxes and public folders of theMicrosoft Exchange Server can be
searched.

Tip: CAS and PST files are not searchable in the Target pane but are searchable in the source
pane.

To search a Microsoft Exchange Server target

1. Do one of the following to display the Find in Exchange Targetwindow:
l Right-click the valid object in the Target pane and click Find.
l On the Toolsmenu, click Find.

l On the toolbar, click the Find icon .
l Press F3.

2. Conduct search as described in "Searching Sources".

Tip: Microsoft Exchange Server target search results can have an Integrity Check performed
either by right-clicking the message or clicking Integrity Check in the Tools menu.

Managing Message Items
Once you have performed a target search, several functions are available on the search results
including cut, move, export, copy, and delete.
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Moving Message Items
Moving message items from the search results to another folder within the target directory
removes the message items from the original location. You can move message items by using the
Move To Folder function, or by dragging to the destination folder.

Move to Folder

Ontrack PowerControls presents you with a Move To Folder option and a corresponding Move
Items destination selection window.

Note:Message items cannot bemoved to aContent Analysis Store (CAS).

To move to folder using Move To Folder

1. Do one of the following to display theMove Itemswindow:
l Right-click the message item(s) in the search results and clickMove To Folder.
l On the Editmenu, clickMove To Folder.

2. Select a folder as the destination and clickOK. TheCopy Progresswindow appears.
3. Select Print to print the progress report, Save to save the progress report to your hard drive,

orClose to close the window.

Dragging a Message

Dragging a Find in Target search result list has a "Move" option. This option behaves in the same
manner as the Move to Folder function or cut and paste.

To drag to a folder

1. Right-click the message item in the search results and drag to a mailbox in the Target pane.
2. At the destination mailbox, a shortcut menu appears with the options of Paste,Move, Paste

Special, orCancel. Select one and theCopy Progresswindow appears.
3. Click Print to print the progress report, Save to save the progress report to your hard drive, or

Close to close the window.

Copying Message Items
You can copy message items to Microsoft Exchange Server and PST file targets. Only valid targets
are displayed in the Copy Items window.

Copy to Folder

Ontrack PowerControls presents you with a Copy To Folder option which copies the item and
keeps it in its original location to be pasted in a designated location.
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To copy to folder

1. On the Editmenu, clickCopy To Folder. TheCopy Itemswindow appears.
2. Select a folder as the destination and clickOK. The message item is now copied and pasted

to the designated location.
3. In theCopy Progresswindow, click Print to print the progress report, Save to save the

progress report to your hard drive, orClose to close the window.

Cutting and Deleting Message Items
The target search results has two new actions, cutting message items and deleting message items,
which are only available in the target search results window.

Cutting Message Items

Cutting a message item moves the item from the original location to a given target.

Deleting Message Items

Deleting a message item in the search results works in a similar manner as deleting message items
from the main target list. When you delete message items from the search results list, they are also
deleted from the main target list if the same message item is currently displayed.

Note: You cannot deletemessage items from themain target list if the Find in Exchange Target
dialog is open.

Saving and Using Search Profiles
Ontrack PowerControls allows you to save search criteria to a text file for the purpose of using the
search criteria in future searches. There are two menu commands that allow you to perform these
functions: "Save Criteria" and "Use Previous Criteria." In addition, if you want to modify the search
criteria in a search profile, you can edit the text file with a text editor.

When creating a search profile, you can save the following search criteria. The "Search For,"
"Exclude Words," "Sent from," and "Sent to" fields have a maximum of 4,095 characters.

n Search for words
n Exclude words
n Search in
n Sent from
n Sent to
n Created Dated after
n Created Dated before

Note: The saved criteria of a content analysis store profile folder can be used for a search.
Conversely, the saved criteria for a search can be used to create a content analysis store profile
folder. Formore information on content analysis stores, see "Content Analysis Store".
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To create a search profile

1. Open the Find in Source window, and enter search criteria.
2. On the Filemenu in the Find in Source window, click Save Criteria.
3. In the Save Aswindow, specify a name and location for the search profile text file.
4. Click Save.

To edit a search profile

1. Locate and open the search profile that you want to edit.
2. Modify the search criteria as desired and save the text file.

To use a search profile when performing a search

1. Open the Find in Source window.
2. On the Filemenu in the Find in Source window, click Use Previous Criteria.
3. In theOpenwindow, locate and open the search profile that you want to use for your

search.
4. ClickOpen. The Find in Source window is populated with the search criteria specified in the

search profile.

Using Multiple Search Windows
Ontrack PowerControls allows you to open multiple instances of the Find in Source window to
search any combination of information stores at the same time. There is no limit other than system
resources for the number of concurrent searches you can initiate.

When searching on a live Microsoft Exchange Server target, you are able to have only one
instance of a search session Find in Exchange target window at one time.

Note: If you are usingmultiple instances of the Find in Sourcewindow to searchwithin the same
mailbox, youmay notice a slowdown in performance.

Searching Within Attachments
In both the Find in Source and Find in Exchange Target windows, you can search the text of email
attachments. The Searching within Attachments feature supports Unicode text and is available for
EDB, PST, CAS sources, and Microsoft Exchange Server targets. Ontrack PowerControls supports
Microsoft Office documents and many other popular file types. For a list of supported file types,
see the FAQs at www.ontrackpowercontrols.com/support/product-support/.

Note about the licensing agent: The "Agent for Advanced Searching"must be enabled in order to
search attachments. Formore information, see "Enabling the LicensedAgents" in the Readme file.
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Figure 3-4: Select the Attachment Text option to include in your search

To search within attachments

1. In the Find in Source or Find in Exchange Target window, select theAttachment Text check
box.

2. Specify other desired search criteria. For more information, see "Searching Sources".
3. Click Find Now. If Ontrack PowerControls matches a keyword or phrase in the text of the

attachment, it will return a "Hit" just as it would if it found a keyword or phrase in the body or
subject of a message item.

Exceptions When Searching Within Attachments
Ontrack PowerControls does not search for the following items:

n Archive files (for example, .zip, .rar)
n Binary files (for example, .dll, .exe, .jpg)
n Metadata associated with files (for example, author and company information in an .xls file)

Other Ontrack PowerControls Features Available
Through the Find Window
In addition to the search features described in the previous sections, there are several Ontrack
PowerControls features available through the Find window.
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Opening and Saving Attachments in the Find Window
To open an attachment's file type in the Find window, you must have an application installed on
your computer that can perform this function. If no associated program is available for the
attachment file type, Ontrack PowerControls presents a message window saying the attachment
cannot be viewed.

For instructions on opening and saving attachments, see "Opening Attachments"and "Saving
Attachments".

Exporting Message Items from the Find Window
The Export feature allows you to copy individual message items from the Find window to a local or
network drive destination. You can choose to save exported message items as plain text files (.txt),
Microsoft Office Outlook files (.msg), or Outlook Data files (.pst). For more information, see
"Exporting Messages".

To export message items from the Find window

1. In the Find in Source or Find in Exchange Target window, perform a search.
2. In the Resultsarea, select the message items you want to export.
3. On the Toolsmenu in the Find in Source or Find in Exchange Targetwindow, click Export.
4. In the Exportwindow, specify options and click Export. For more information on the export

options, see "Exporting Messages".

Restoring Message Items from the Find Window
The results of conducting a search appear in the message item list in the Find window. You can
restore the message items in this list by dragging them or copying and pasting them into the target
folder. If you want to maintain the directory structure of restored individual message items, use the
Paste Special command.

You can also restore message items by browsing in the main window and dragging or copying
and pasting from the main window to the target. You do not need to search to restore message
items. For more information, see "Restoring Microsoft Exchange Server Data".

Performing an Integrity Check on Message Items in the Find
in Source Window
The Find in Source window allows you to perform an integrity check on one or more message items
in the Results area. During the integrity check, Ontrack PowerControls verifies that it can read all of
the properties of the message items.

Note:Only accessiblemailboxes can have an Integrity Check performed.
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To perform an integrity check on message items in the Find in Source window

1. In the Find in Source window, perform a search.
2. In the Resultsarea, select the message items for which you want to perform an integrity

check.
3. On the Toolsmenu in the Find in Source window, click Integrity Check. The Integrity Check

window appears.

Search Results Report
You can save a text-based report of the search results to your local drive without having to copy or
export any of the search results. The search results report is saved into a file that includes the
search criteria, date/time the search was started, and a report of message items that matches the
criteria.

Save Report
You can save the search results report once a search has been performed and either completed
or stopped.

The Save Report button creates two text-based reports. One report contains a search session
summary (Summary Report) and the other report contains search session message item results
(Message Report).

Summary Report
The information included in the Summary report is the search session details and the user-defined
search criteria for the search.

Message Report
The information included in the Message report is based on the column headings in the search
results, message type, attachments, From and To, etc.

To save the report

1. After conducting the search, click Save Report. The Browse For Folderwindow appears.
2. Select the destination for the report and clickOK. The search results reports creates both a

Message Report and a Summary Report, and are saved on your hard drive in a .txt format.
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Figure 3-5: Summary andMessages Reports

The files are named using the date of the search and a suffix indicating the type of report.
For example, if you run a search on 5/8/2007, the report names are:
SearchResults_20070508_Summary.txt for the summary report, or
SearchResults_20070508_Messages.txt for the message report.

For cases where you choose to create more than one set of reports on the same date, files
are named using an incremental numbering convention starting with "1." If you run a
second search on 5/8/2007, the report names are:
SearchResults_20070508(1)_Summary.txt for the summary report, or
SearchResults_20070508(1)_Messages.txt for the message report.

3. ClickingCancelduring the report generation progress terminates the process and any
reports created for this Save Report action are deleted from the report destination.

Using the Report
The text summary or message report is tab delimited and can be imported into a spreadsheet if
desired. Simply drag the .txt file from its location into a blank spreadsheet. The source # in the
search results is replaced with the full path to its location in the report.
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Chapter 4: Exporting Messages
Overview
You can export mail from an EDB, PST, or CAS source file or live target Microsoft Exchange Server to
a local or network drive destination. Exported messages can be saved as Microsoft Office Outlook
files (.msg), saved as plain text files (.txt), or become contents of a PST file. This can assist you in
copying old email backups into an alternate or non-email system. You can export at all levels
(mailbox, folder, and individual messages) for the corresponding file type.

You can export at all levels: an EDB file, a PST file, a CAS file, a CAS profile folder, a mailbox, a folder,
and individual messages.

You can also export forms from an organizational forms library in a public folder EDB or source
public folder mailbox. These exported files can be saved as Microsoft Office Outlook forms (.oft).

General Information about Exporting Messages
n When saving exported message items as plain text files (.txt) or Microsoft Office Outlook files

(.msg), the file name for an exported message is its subject. The file name for an exported
organizational form is the form's name. When saving exported message items to Outlook
Data files (.pst), the file name is either based on the name of the mailbox or set by the user
depending on the level of the source being exported. A duplicate file name will create a file
with the same name but with an (x) appended to the filename: x = 1 for the first duplicate, x =
2 for the next duplicate, and so on. If the subject or form name contains illegal file name
characters, each offending character will be replaced with an underscore.

n Associated messagesand folder propertieswill not be exported.
n When exporting individual messages, you have the option to keep the folder/mailbox

hierarchy, similar to the paste special feature. When exporting a mailbox or folder, you have
the option to also export the subfolders.

n Messages in the Microsoft Exchange Server 2010 and later Recoverable Items folders can be
exported if the Show Recoverable Itemspreference is enabled.

n When exporting the Recoverable Items folder, it is renamed to distinguish the copied version
from the actual version. The folder is renamed using the localized short date in parenthesis
and appended to the folder name. Example: "Recoverable Items (1/22/2009)"

n If you use the "Mailbox Criteria (optional)" box on the Source Selection page of the Data
Wizard, only EDB mailboxes containing your entry (or entries) are displayed on the Source
pane. Any mailboxes that do not match the entered string(s) do not appear in the Source
pane and are not be included in any subsequent tasks (such as searching, copying, and
exporting of the entire database). For more information, see "Mailbox Criteria".

n If you use the "Multi-Tenancy Criteria" box on the Source Selection page of the Data Wizard,
the Connect to Exchange Server dialog box, or the Target Selection page of the Data
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Wizard, only mailboxes contained in the selected Address Book Policy or Organization
appear in the Source or Target panes. Only these mailboxes are included in any subsequent
tasks (such as searching, copying, and exporting of the entire database). For more
information, see "Multi-Tenancy Support".

About Message (.msg), Text (.txt), and PST
Export
The file type for an exported message can be either Microsoft Office Outlook (.msg) or plain text
(.txt) or PST.

Message (.msg) export

A .msg file (OLE compound document) can be imported directly into Microsoft Office Outlook.
This file type encapsulates the entire message including attachments.

Text (.txt) export

A .txt file is created with the following information. Note that neither message attachments nor
message properties are exported.

PST export

The Export to PST option allows you to generate PST files at all levels of the following:

n Off-line private store EDB files
n Off-line public store EDB files (Microsoft Exchange Server 2010 and earlier)
n CAS files
n PST files

You can also export to PST files from a target and source Find window. For more information, see
"Exporting to PST".

Exporting Messages
You can export an EDB file, a source PST file, a source CAS file, a source CAS profile folder,
mailboxes, folders, messages, and a live Microsoft Exchange Server target.

Note:Only accessiblemailbox items can be exported. If you are exporting aCAS file, only
accessiblemailboxes are included in the export.

The section explains how to perform the following export tasks from the Ontrack PowerControls
main window:

n "To export an entire source private EDB file, mailbox, or PST file"
n "To export a source PST folder, a folder, a CAS file, a profile CAS folder, or a public EDB file"
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n "To export a mailbox or a folder from a Microsoft Exchange Server target"
n "To export individual source or target messages"
n "To export individual messages from the Find window to a TXT or MSG file"

To export an entire source private EDB file, mailbox, or PST file

1. In the Source pane, select the root of the EDB file, mailbox, or PST file.
2. Do one of the following:

n On the Toolsmenu, click Export.

n

On the toolbar, click the Export icon .
n Right-click the EDB file, and on the shortcut menu, click Export. The Export EDB, or

Export Mailboxwindow appears.

Figure 4-1: PST, MSG, or TXT format can be selected for export

3. If you want to export multiple objects (mailboxes, PST files), click Browseand in the Selected
Mailboxes dialog box, select the mailbox or PST file you want to export, then clickOk. (You
can select more than one).

4. In the Formatbox, select PST,MSG, or TXT. If you selected PST, Export results to multiple PSTs is
selected by default.

5. If you want to limit the documents exported by when an action was performed (such as
Received, Sent, or Due), select Filter Byand do the following:

n In theDatebox, select an action performed on the document.
n ForAfterand Before, select the appropriate check box, if desired. You may select

both check boxes. Then type or select the part of the date you want to change.After
searches for documents created on or after the selected date. Before searches for
documents created on or before the selected date.

6. In the Export to Folder or Export to Filebox, specify the location of the exported EDB file.
7. Click Export.
8. In the Export Progresswindow, verify the EDB file was successfully exported, and clickClose.
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To export a source PST folder, a folder, a CAS file, a profile CAS folder, or a public EDB file

1. In the Source pane, select a PST folder, a folder, a CAS file, a profile CAS folder, or a public
EDB file root.

2. Do one of the following:
n On the Toolsmenu, click Export.

n

On the toolbar, click the Export icon .
n Right-click a PST folder, a folder, a CAS file, a profile CAS folder, or a public EDB root,

and on the shortcut menu, click Export. The Export EDB, Export Folder, or Export CAS
window appears.

Figure 4-2: Export Folders window

3. In the Formatbox, select PST,MSG, or TXT.
4. In the Export to File or Export to Folderbox, do one of the following:

n If you selected the PST format, enter the name of the resulting PST file. If you are
exporting a mailbox, the name of the PST file defaults to the name of mailbox (which
can be modified).

n If you selected theMSGor TXT format, enter the location of the exported mailbox,
folder, or public EDB file.

5. Select the Export Subfolders check box if you want to export all of the subfolders for the
selected mailbox or folder.

Note: This option is selected automatically when exporting the EDB public root.
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6. If you want to limit the documents exported by when an action was performed (such as
Received, Sent, or Due), select Filter Byand do the following:

n In theDatebox, select an action performed on the document.
n ForAfterand Before, select the appropriate check box, if desired. You may select

both check boxes. Then type or select the part of the date you want to change.After
searches for documents created on or after the selected date. Before searches for
documents created on or before the selected date.

7. Click Export.
8. In the Export Progresswindow, verify the mailbox or folder was successfully exported, and

clickClose. The mailbox or folder appears in the specified location. For PSTs, the exported
mailbox or folder is included in the PST file.

To export a mailbox or a folder from a Microsoft Exchange Server target

1. In the Target pane, select a PST file, a mailbox or a profile CAS folder, or the public EDB file
root.

2. Do one of the following:
n On the Toolsmenu, click Export.

n

On the toolbar, click the Export icon .
n Right-click the mailbox, folder, or public EDB root, and on the shortcut menu, click

Export. The Export Mailbox or Export Folderwindow appears.

Figure 4-3: Export Mailboxes window
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3. In the Formatbox, select PST,MSG, or TXT.
4. In the Export to File or Export to Folderbox, do one of the following:

n If you selected the PST format, enter the name of the resulting PST file. If you are
exporting a mailbox, the name of the PST file defaults to the name of mailbox (which
can be modified).

n If you selected theMSGor TXT format, enter the location of the exported mailbox,
folder, or public EDB file.

5. Select the Export Subfolders check box if you want to export all of the subfolders for the
selected mailbox or folder.

Note: This option is selected automatically when exporting the EDB public root.

6. If you want to limit the documents exported by when an action was performed (such as
Received, Sent, or Due), select Filter Byand do the following:

n In theDatebox, select an action performed on the document.
n ForAfterand Before, select the appropriate check box, if desired. You may select

both check boxes. Then type or select the part of the date you want to change.After
searches for documents created on or after the selected date. Before searches for
documents created on or before the selected date.

7. Click Export.
8. In the Export Progresswindow, verify the mailbox or folder was successfully exported, and

clickClose. The mailbox or folder appears in the specified location. For PSTs, the exported
mailbox or folder is included in the PST file.

To export individual source or target messages

1. In the Source or Target pane, select one or more messages from the message list.
2. Do one of the following:

n On the Toolsmenu, click Export.

n

On the toolbar, click the Export icon .
n Right-click the selection, and on the shortcut menu, click Export. The Export Messages

dialog box appears.
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Figure 4-4: PST, MSG, or TXT format can be exported

3. In the Formatbox, select PST,MSG or TXT.
4. Select theMaintain Message Path option if you want to maintain the directory structure of

the exported messages.
5. If you are exporting message from the Source pane to PST, you can also select Skip mailbox

folder to merge the exported message into the resulting PST without maintaining the
mailbox folder.

6. If you want to limit the documents exported by when an action was performed (such as
Received, Sent, or Due), select Filter Byand do the following:

n In theDatebox, select an action performed on the document.
n ForAfterand Before, select the appropriate check box, if desired. You may select

both check boxes. Then type or select the part of the date you want to change.After
searches for documents created on or after the selected date. Before searches for
documents created on or before the selected date.

7. In the Export to File or Export to Folderbox, do one of the following:
n If you selected the PST format, enter the name of the resulting PST file.
n If you selected theMSGor TXT format, enter the location of the exported mailbox,

folder, or public EDB file.
8. Click Export.
9. In the Export Progresswindow, verify the mailbox or folder was successfully exported, and

clickClose. The messages appear in the specified location. For PSTs, the exported mailbox
or folder is included in the PST file.
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To export individual messages from the Find window to a TXT or MSG file

1. In the Find in Source or Find in Exchange Target window, select one or more messages from
the message list.

2. Right-click the selection, and on the shortcut menu, click Export.
3. In the Formatbox, selectMSG or TXT.

Figure 4-5: Exporting theMSGor TXT format

4. If youwant tomaintain the directory structure of the exportedmessages, select the
Maintain Message Path option.

5. If you want to limit the documents exported by when an action was performed (such as
Received, Sent, or Due), select Filter Byand do the following:

n In theDatebox, select an action performed on the document.
n ForAfterand Before, select the appropriate check box, if desired. You may select

both check boxes. Then type or select the part of the date you want to change.After
searches for documents created on or after the selected date. Before searches for
documents created on or before the selected date.

6. In the Export To Folderbox, specify the location for the exported messages.
7. Click Export.
8. In the Export Progresswindow, verify your messages were successfully exported, and click

Close. The messages appear in the specified location.

Exporting to PST
You can export to a PST file from the Source and Target panes, the Source and Target Message
lists, and the Source and Target Find windows.
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Exporting to PST from the Source Pane
When exporting to PST from the Source Pane, follow the instructions To export individual source or
target messages in "Exporting Messages".

In the Export to File or Export to Folder box, enter the name of the resulting PST file. The exported
mailbox or folder is included in the PST file.

Figure 4-6: Exporting to PST from the Source Pane

Exporting to PST from the Target Pane
When exporting to PST from the Target Pane, follow the instructions To export a mailbox or a folder
from a Microsoft Exchange Server target in "Exporting Messages".

If you want to export all of the subfolders for the selected mailbox or folder, select the Export
Subfolders check box

Note: You can only export a singlemailbox on the target, notmultiplemailboxes.

In the Export to File or Export to Folder box, enter the name of the resulting PST file. The exported
mailbox or folder is included in the PST file.
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Figure 4-7: Exporting to PST from the Target Pane

Exporting to PST from the Message List
When exporting messages from the Message List view, you can use the Skip Mailbox Folder option
on the Export dialog box to merge the exported message into the resulting PST without
maintaining the mailbox folder.

Figure 4-8: Exporting to PST from theMessage List
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Exporting to PST from the Find Window
The following two options are available when exporting to PST from the Find window.

n Export results to multiple PSTs: If selected, search results are exported based on which
mailbox or CAS profile folder they were originally stored in. One PST will be created for every
mailbox and CAS profile folder. IfMaintain Message Path is also selected, the directory
structure of the exported messages inside PST is maintained. In such cases, PST files receive
the name of the respective mailbox or CAS profile folder in which the messages were found.
Exported public EDB files are named "All Public Folders.pst."

n Export results to single PST: If selected, search results are exported to a single PST. IfMaintain
Message Path is also selected, the directory structure of the exported messages inside PST is
maintained. IfMerge Mailboxes is selected, results are exported to a single PST file with all
the standard PST folders. With Export results to a single PST, you can choose a name for a PST
file.

To export individual messages from the Find window to a PST file

1. In the Find in Source or Find in Exchange Target window, select one or more messages from
the message list.

2. Right-click the selection, and on the shortcut menu, click Export.
3. In the Formatbox, select PST.

Figure 4-9: Exporting the PST format

4. In the Export to Filebox, specify the location for the exported messages.
5. Do one of the following:
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n To export all of the selected messages to one PST, choose Export results to single PST.
n To export messages from different mailboxes, CAS profiles, or public folders in

respectively named separate PST files, choose Export results to multiple PSTs.
6. If youwant tomaintain the directory structure of the exportedmessages, select the

Maintain Message Path option.
7. If you selected Export results to single PST you can chooseMerge Mailboxes. This option

removes the mailbox level from the directory structure of the exported messages. For more
information, see the Scenarios section that follows.

8. If you want to limit the documents exported by when an action was performed (such as
Received, Sent, or Due), select Filter Byand do the following:

n In theDatebox, select an action performed on the document.
n ForAfterand Before, select the appropriate check box, if desired. You may select

both check boxes. Then type or select the part of the date you want to change.After
searches for documents created on or after the selected date. Before searches for
documents created on or before the selected date.

9. Click Export.
10. In the Export Progresswindow, verify your messages were successfully exported, and click

Close.

When exporting message from the Source pane, you can also use the Skip Mailbox Folder option
on the Export dialog box. This option merges the exported message into the resulting PST without
maintaining the mailbox folder.

Note: Before exporting to PST, ensure that you have sufficient disk space available at the
destination of the PST export.

Scenarios
Scenarios for exporting multiple mailboxes from the Find Window to a single PST
Scenario 1
A folder with the mailbox name for every mailbox in which messages are found is created in the
new PST. The message path is maintained, even if the higher level folder does not contain
messages. The PST name is created by the user.
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Figure 4-10: Scenario 1

Scenario 2
Folders in which messages are found are created in the resulting PST. The message path is
maintained from the root level (even if the higher level folder does not include messages). Mailbox
names are removed. If the folder already exists, the messages found in a different folder with the
same name and at the same hierarchy level are placed in the existing folder in the resulting PST.
The PST name is created by the user.

Figure 4-11: Scenario 2
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Scenario 3
All messages found are exported to the PST at the root level. The PST name is created by the user.

Figure 4-12: Scenario 3

Scenario 4
A folder with the mailbox name for every mailbox in which messages are found is created in a new
PST. Messages found in these mailboxes reside in these new mailbox folders, without the folder
structure in which they were located originally. PST name is created by the user.

Figure 4-13: Scenario 4
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Scenarios for exporting multiple mailboxes from the Find Window to multiple PSTs
Scenario 5
All the folders with messages found are created, starting from the first PST level folder and not the
mailbox name. PST is named after the corresponding EDB mailbox name.

Figure 4-14: Scenario 5

Scenario 6
All the messages are located in the root of the PST. PST is named after the corresponding EDB
mailbox name.

Figure 4-15: Scenario 6

Using an Exported PST
To use an exported PST

1. Navigate to where the PST was created.
2. Drag the PST into Ontrack PowerControls in either the source or the Target pane. The Select

Source Fileswindow appears.
3. In the Select Source Fileswindow, clickOK.

The PST now appears in the target or source directory.
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Appending Messages to Existing PST Files
You can configure Ontrack PowerControls to append messages to existing PST files. Selecting the
Append to existing PST files during export option on the Preferences dialog box updates
previously exported PST files with new messages from the export process.

If this option is cleared, Ontrack PowerControls does not append messages to an existing PST file,
but creates a new PST file with a number in parenthesis added to the name of the exported PST file.
For example, if John Doe.pst already exists, a new PST files is created and named John Doe(1).pst.
If John Doe(1).pst also exists, then the most recently exported PST would be named John Doe
(2).pst.

Note: You can only appendmessages to existing PST files which are not password protected.

To append messages to existing PST files

1. On the Editmenu, click Preferences, then clickGeneral.
2. On the General tab of the Preferences dialog box, selectAppend to existing PST files during

exportand clickOK.
3. Perform the export to PST. For more information, see To export to PST in "Exporting Messages"
4. Do one of the following:

n If you selected Export results to single PST, choose the existing PST file to which you
want to append the new messages.

n If you selected Export results to multiple PSTs, choose a folder with PSTs you exported
previously,

5. In the Export Progress window, verify new messages were successfully added to existing PST,
then clickClose.

Note: There is a 2GB limit for Microsoft OfficeOutlook 97-2002 style PSTs. Formore information, see
"Limits for PST and Folder Targets"

Setting a Global Limit for PST Files
When exporting PST files, you can define the maximum size of single Unicode PST file using the
Target Options tab of the Preference dialog box or the Command Line.

Target Options tab
When Limit maximum PST file size is selected, Ontrack PowerControls automatically creates a new
PST file when the size in theMB field is reached during export. Ontrack PowerControls saves the
processed PST file with its original name and creates the next file with the same name and a _
001.pst suffix, with the folders structure similar to the original file. Ontrack PowerControls then
continues exporting messages to the newly created _001.pst file, saves it at the maximum size, and
continues the process, increasing the numbered suffix (_001.pst, _002.pst, _003.pst ...) until the
entire original PST file is exported.
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Ontrack PowerControls appends files to existing ones also enforces the global size limit so it tries to
add files into existing pst file and if it reaches size limit it overflows to another file.

If files are present from a previous PST file export in which where size limit was reached (For
example, OriginalFileName.pst, OriginalFileName001.pst, and OriginalFileName002.pst)Ontrack
PowerControls exports files to OriginalFileName002.pst until the limit is reached and continues,
creating OriginalFileName003.pst.

Note:Microsoft supports PST files up to 47.5GBwith an absolute limit of 50GB, so theMB field should
not exceed 48640.

Exporting Organizational Forms
Microsoft Exchange Organizational Forms libraries are stored in public folder databases or public
folder mailboxes. When a public folder EDB or public folder mailbox containing one or more
Organizational Forms folders is loaded as a source in Ontrack PowerControls, you can export the
forms from the Organizational Forms library folder(s).

To export organizational forms

1. In the source tree, select the root of the public folder EDB or public folder mailbox.
2. Do one of the following to open the Export Organizational Formsdialog box:

n On the Toolsmenu, click Export Organizational Forms.
n PressCtrl+G.
n Right-click the selection, and on the shortcut menu, click Export Organizational

Forms.

Figure 4-16: Export Organizational Forms dialog box
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3. In the Look Indrop list, select the organizational forms folder containing the forms you want
to export.

Note:Organizational Forms Library folders can be stored in different public folder databases
or public foldermailboxes. All public folder databases andmailboxes list all public folders
andOrganizational Forms Library folders, not just those they store content for. Only the
Organizational Forms Library folders storedwithin the selected public folder database or
mailboxwill contain items.

4. In the table, select the form(s) you want to export.
5. Click Export. The Export Formsdialog box appears with OFT selected in the Format list box.

Figure 4-17: Export Forms dialog box

6. In the Export Tobox, enter the folder path to where you want the forms exported.
Note: You can use the browse button to open the Browse For Folder dialog box to select the
path.

7. Click Export.
8. Use the Export Progress dialog box to verify your forms were successfully exported, and click

Close.
9. On the Export Organizational Forms dialog box, clickClose.

About the Export Progress Window
Each time you attempt to export messages, the Export Progresswindow appears. This window
displays the following information:

n Source and target
n Export start time
n Number of folders to export
n Number of messages to export
n Warnings or errors encountered during the export process. If an error occurs on a message,

the message subject and source path along with an error message will be displayed. If the
message does not have a subject, the date (created) and message sender will be
displayed instead.

n Total folders and messages successfully exported
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Figure 4-18: The export progress is shown

Note:

n If an error occurs that Ontrack PowerControls can recover from, such as a corruption that
prevents it fromgetting amessage property, Ontrack PowerControls will log an error, stop
processing thatmessage, and continue.

n If an error occurs fromwhichOntrack PowerControls cannot recover, such as amajor
corruption error, Ontrack PowerControls will log an error to the Export Progress windowand
stop exporting.

Saving and Printing the Report
The contents of the export report can be saved by clicking Save. This opens a Save File dialog box
allowing you to select the location and name of the file. The default name of the report is
"ExportProgress.txt."

The export report can also be printed by clicking Print.
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Chapter 5: Restoring Microsoft
Exchange Server Data
Overview
The first part of this chapter provides you with a quick look at restoring your Microsoft Exchange
Server database, so you can begin to use the Microsoft Exchange Server application of Ontrack
PowerControls immediately. The second part of this chapter provides examples of restoring
messages, folders, mailboxes, and even an entire EDB file to the desired destination.

Note: The concepts in this chapter apply to EDB, PST, andCAS files (unless otherwise noted), even
though all of the examples of sources are EDB files.

Note: If you use the "Mailbox Criteria (optional)" box on the Select Source Files dialog box or the
Source Selection page of the DataWizard, only EDBmailboxes containing your entry (or entries)
are displayed on the Source pane. Anymailboxes that do notmatch the entered string(s) do not
appear in the Source pane andare not be included in any subsequent tasks (such as searching,
copying, and exporting of the entire database). Formore information, see "Mailbox Criteria".

Note: If you use the "Multi-TenancyCriteria" box on the Select Source Files dialog box, the Source
Selection page of the DataWizard, theConnect to Exchange Server dialog box, or the Target
Selection page of the DataWizard, onlymailboxes contained in the selectedAddress Book Policy
or Organization appear in the Source or Target panes. Only thesemailboxes are included in any
subsequent tasks (such as searching, copying, and exporting of the entire database). Formore
information, see "Multi-Tenancy Support".

Quick Look at Restoring Your Microsoft
Exchange Server Data
Restoring data from a source EDB, PST, or CAS file to a target destination is a simple process. Just
drag or use the Copy and Paste/Paste Special commands.

n "Restoring Your Microsoft Exchange Server Data in Three Easy Steps"
n "Limits for PST and Folder Targets"
n "About Restoring Messages to a Microsoft Exchange Server"
n "About the Copy Progress Window "
n "Creating, Renaming, and Deleting Folders in the Target Pane"
n "Copying and Pasting or Dragging"
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Restoring Your Microsoft Exchange Server Data in Three
Easy Steps
If you copy an EDB file, a PST file, a mailbox, or a folder from the Source pane and paste it to any
target destination, Ontrack PowerControls will preserve the directory structure of all restored
messages. When restoring individual messages, you must use the Paste Special command to
preserve their directory structure.

To restore individual messages with copy-paste

1. In the Source pane or Find in Source window, copy messages from the message list.
2. In the Target pane, paste the messages into a folder.
3. In theCopy Progresswindow, verify that your messages were successfully copied, and click

Close.

To restore individual messages with copy-paste special

1. In the Source pane or Find in Source window, copy messages from the message list.
2. In the Target pane, use Paste Special to paste the messages into a folder, mailbox, PST root,

or Microsoft Exchange Server root.
3. In theCopy Progresswindow, verify that your messages were successfully copied, and click

Close.

Tip: Use the Paste Special command to retain the directory structure of messages copied
from the Find in Source or Find in Exchange Targetwindow, because messages in this
window often come from several source locations.

To restore a folder, a mailbox, an EDB file, a CAS file, or a PST file

1. In the Source pane, copy a folder, a mailbox, an EDB file, a CAS file, or a PST file.
2. In the Target pane, paste the copied item into a folder, mailbox, PST root, or Microsoft

Exchange Server root.
3. In theCopy Progresswindow, verify that your messages were successfully copied, and click

Close.
Note: You cannot open the same PST as a source and target. In addition, you cannot
restoremessages froma PST file to aMicrosoft Exchange Server root node.

To restore data even faster by dragging

n Example: To restore an entire EDB file, drag it to the target Microsoft Exchange Server root.

Limits for PST and Folder Targets
When restoring Microsoft Exchange Server Data to a target PST or folder, Microsoft Office Outlook
97-2002 style PSTs have the following limits:

Global Limits for PST Limit
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The global limit can be set for any PST file. For more information, see "Setting a Global Limit for PST
Files".

16,383 Messages Per Folder (for example, Inbox) Limit

When a target folder (for example, Inbox) reaches 16,383 messages, Ontrack PowerControls
creates a new PST folder for the additional messages. The new folder has the same name as the
original target folder plus an appended number in parentheses: Inbox (1), Inbox (2), and so on.
Ontrack PowerControls creates the folder path in the new folder and continues to restore
Microsoft Exchange Server data where it left off.

Note: If you have upgraded the PST file to a large table format, the PST can hold 64,000messages
per folder. However, when a target folder (for example, Inbox) reaches 16,383messages, Ontrack
PowerControls still creates a new PST folder for the additional messages.

To turn off the preference setting for the PST messages per folder limit
If you do not want Ontrack PowerControls to create new folders when the number of messages
reaches 16,383, do the following:

1. On the Editmenu, click Preferences.
2. In the Preferenceswindow, click the Target Options tab, and then clear theCreate new PST

folders when PST message/folder limits are reached check box.

Note: If you turn off the preference, all messages above themessages per folder limit will fail to
copy correctly, and the PST filemay becomecorrupt.

About Restoring Messages to a Microsoft Exchange Server
You must have sufficient access rights to all of the Microsoft Exchange Server mailboxes you are
trying to restore messages to.

Restoring Messages to Microsoft Exchange Server 2007 and later

In Microsoft Exchange Server 2007 and later, the permission that controls whether or not any
mailbox can be copied to is Full Mailbox Access. You must have Full Mailbox Access set to "Allow"
in order to copy to a mailbox other than the one you logged in under.

About the Copy Progress Window
Each time you attempt to restore messages to the Target pane, theCopy Progresswindow
appears. This window displays the following information about the copy operation:

n Time of copy operation
n Number of messages, associated messages, and folders
n Errors, if any

113



n Mailboxes that Ontrack PowerControls connected to or failed to connect to when copying
to a Microsoft Exchange Server

n Copy results

Important:Viewing the copy results in Copy Progress window is especially important when
attempting to restore multiple items to a Microsoft Exchange Server root node. That is because
Ontrack PowerControls restores one mailbox at a time; therefore, the only way you will know if all
of the mailboxes were successfully copied to the Microsoft Exchange Server will be to look at the
copy results listed in this window.

If you do not have full access rights to the mailboxes you are trying to restore messages to, Ontrack
PowerControls will be unable to connect to the mailboxes. For more information, see "About
Restoring Messages to a Microsoft Exchange Server".

Creating, Renaming, and Deleting Folders in the Target Pane
The Target pane has folders in which you can place your restored messages. However, you may
want to create new folders for your messages. You can also rename or delete any folder in the
Target pane.

To create a new folder in the Target pane

1. In the Target pane, select a folder, a PST root node, or a Microsoft Exchange Server mailbox.
2. Do one of the following:

l On the Editmenu, clickNew Folder.
l Right-click and on the shortcut menu, clickNew Folder.
l PressCtrl+N.

3. In theCreate NewMail Folderwindow, name the folder and clickOK. A subfolder is created
in the target folder.

To rename a folder in the Target pane

1. In the Target pane, select a folder.
2. Do one of the following:

l On the Editmenu, click Rename.
l Right-click and on the shortcut menu, click Rename.
l PressCtrl+R.

3. Type a new name for the folder.

Note: You can also renamea PST root.

To delete a folder in the Target pane

1. In the Target pane, select a folder.
2. Do one of the following:
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l On the Editmenu, clickDelete.
l Press theDelete key.

Copying and Pasting or Dragging
In Ontrack PowerControls, you can restore data to the Target pane by using Copy-Paste, Copy-
Paste Special, or dragging.

Note: If you copy the Recoverable Items folder, it is renamed to distinguish the copied version from
the actual version. The folder is renamed using the localized short date in parenthesis and
appended to the folder name. Example: "Recoverable Items (10/22/2009)"

To copy an item in the Source pane or Find window

1. In the Source pane or Find in Source window, select messages, a folder, a mailbox, or the
entire EDB file.

Note: In the Find in Sourcewindow, you can only selectmessages.

2. Do one of the following:
l On the Editmenu, clickCopy.
l Right-click the selected item(s), and on the shortcut menu, clickCopy.
l Click the Copy Mail Item icon on the toolbar.
l PressCtrl+C.

To paste an item in the Target pane

1. In the Target pane, select a folder, a mailbox, the PST root node, or the Microsoft Exchange
Server root node.

2. Do one of the following:
l On the Editmenu, click Paste.
l Right-click the selected item, and on the shortcut menu, click Paste or Paste Special. For

more information on using the Paste Special command, see "Restoring Messages with
Copy-Paste".

l

Click the Paste icon on the toolbar.
l PressCtrl+V (Paste) orCtrl+Y (Paste Special).

To drag an item to the Target pane

n Drag an item from the Source pane into a folder in the Target pane. Dragging achieves the
same results as copying and pasting.
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To use drag when right-clicking a source item

1. In the Source pane, select one or more messages.
2. Right-click the selected messages and drag them to a folder in the Target pane.
3. When you let go of the mouse, a shortcut menu appears. On the shortcut menu, click Paste

or Paste Special. For more information on using the Paste Special command, see "Restoring
Messages with Paste Special".

Examples of Restoring Your Microsoft Exchange
Server Data
This section provides examples of restoring messages, folders, mailboxes, and even an entire EDB
file to the desired destination. In each case, it provides guidelines for restoring messages.

Note: The concepts in this chapter apply to both EDB and PST files (unless otherwise noted), even
though all of the following examples are EDB files.

Restoring Messages with Copy-Paste
The following instructions show you how to restore individual messages to a folder in a target PST
file or Microsoft Exchange Server by using Copy-Paste. Keep in mind that dragging achieves the
same results.

Guidelines for Restoring Messages

n You can copy messages from the message list in the Source pane or the Find in Source
window.

n You can drag or copy and paste to restore individual messages to a folder in the Target
pane.

n You cannot drag or copy and paste to restore individual messages to a PST root node, a
Microsoft Exchange Server root node, or a Microsoft Exchange Server mailbox. However,
you can use Paste Special to restore individual messages to these locations.

n Dragging or copying and pasting to restore individual messages does not preserve the
directory structure of the restored messages. If you want to preserve the directory structure
of restored individual messages, use Paste Special.

n You cannot copy-paste inaccessible mailboxes.

Tip: For information on Paste Special, see "Restoring Messages with Paste Special".

To restore messages with copy-paste

1. In the Source pane or Find in Source window, copy messages from the message list.
2. In the Target pane, paste the messages into a folder (for example, Inbox) in the target PST

file or Microsoft Exchange Server.
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3. In theCopy Progresswindow, verify that your messages were successfully copied. You can
also print or save the copy report by doing one of the following.

l Click Print to print the copy report.
l Click Save to save the copy report as a text file.

4. In theCopy Progresswindow, clickClose to return to the main window.

Results of Restoring Messages with Copy-Paste

All unduplicated messages appear in the target folder.

Restoring Messages with Paste Special
You can use the Paste Special command to preserve the directory structure of restored individual
messages. The Paste Special command is especially useful when restoring messages from the
message list in the Find window, since these messages often come from several source locations.

Guidelines for Restoring Messages with Paste Special

n You can use the Paste Special command to restore individual messages to any target
destination. Using the Paste Special command preserves the directory structure of the
restored messages.

n You can use the Paste Special command to restore individualmessages only. You cannot
use the Paste Special command to restore an entire EDB file, a mailbox, or a folder.

n You cannot use Paste Special to restore messages to a public folder.
n If the target is a PST root node or folder, Ontrack PowerControls creates a folder to represent

each mailbox. Each mailbox is a subfolder of the folder the user selected for the Paste
Special operation.

n If the target is a Microsoft Exchange Server mailbox or folder, Ontrack PowerControls
copies all messages to the target. Each mailbox is a subfolder of the folder the user selected
for the Paste Special operation.

n If the target is a Microsoft Exchange Server root node, the Paste Special code attempts to
connect to each mailbox one at a time and copies each message to its corresponding
mailbox and folder. If the folder does not exist, it will be created. If the mailbox does not
exist, Ontrack PowerControls logs an error in the copy results, skips the entire mailbox, and
continues the Paste Special operation.

Note: You cannot restoremessages froma PST file to aMicrosoft Exchange Server root
node.

To restore messages to a PST root or folder with Paste Special
If the target is a PST root node or folder, Ontrack PowerControls creates a folder to represent each
mailbox. Each mailbox is a subfolder of the folder you selected for the Paste Special operation.
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1. In the Source pane or Find in Source window, copy messages from the message list.
2. In the Target pane, use Paste Special to paste the messages into a PST root node or folder.
3. In theCopy Progresswindow, verify that your messages were successfully copied. You can

also print or save the copy report by doing one of the following.
l Click Print to print the copy report.
l Click Save to save the copy report as a text file.

4. In theCopy Progresswindow, clickClose to return to the main window.

Results of Restoring Messages to a PST Root Node or Folder with Paste Special

All unduplicated messages appear in the target destination, and their directory structure will be
preserved.

To restore messages to a Microsoft Exchange Server mailbox or folder with Paste Special
If the target is a Microsoft Exchange Server mailbox or folder, Ontrack PowerControls copies all
messages to the target. Each mailbox is a subfolder of the folder you selected for the Paste
Special operation.

1. In the Source pane or Find in Source window, copy messages from the message list.
2. In the Target pane, use Paste Special to paste the messages into a Microsoft Exchange

Server mailbox or folder.
3. In theCopy Progresswindow, review your results to make sure all the messages were copied

to the target destination. You can also print or save the copy report by doing one of the
following.
l Click Print to print the copy report.
l Click Save to save the copy report as a text file.

4. In theCopy Progresswindow, clickClose to return to the main window.

Results of Restoring Messages to a Microsoft Exchange Server Mailbox or Folder with Paste
Special

Each mailbox is a subfolder of the target destination, and all unduplicated messages are restored.
In addition, their directory structure is preserved.
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Figure 5-1: Results of using Paste Special on a targetMicrosoft Exchange Servermailbox

To restore messages to a Microsoft Exchange Server root node with Paste Special
If the target is a Microsoft Exchange Server root node, Ontrack PowerControls attempts to
connect to each mailbox one at a time and copies each message to its corresponding mailbox
and folder. If the folder does not exist, it is created. If the mailbox does not exist, Ontrack
PowerControls logs an error in the Copy Progress window, skips the entire mailbox, and continues
the Paste Special operation.

Important: The source mailbox must exist on the target Microsoft Exchange Server, and you must
have full mailbox access rights to all of the Microsoft Exchange Server mailboxes to which you are
trying to restore messages. For more information on access rights, see "About Restoring Messages
to a Microsoft Exchange Server".

1. Select one or more messages from the message list in the Find in Source window or the
Source pane.

2. In the Source pane or Find in Source window, copy messages from the message list.
3. In the Target panes use Paste Special to paste the messages into a Microsoft Exchange

Server root node.
4. In theCopy Progresswindow, verify your results to make sure that your messages from all

mailboxes were copied to the target destination. You can also print or save the copy report
by doing one of the following:

l Click Print to print the copy report.
l Click Save to save the copy report as a text file.

5. In theCopy Progresswindow, clickClose to return to the Ontrack PowerControls main
window.

Results of Restoring Messages to a Microsoft Exchange Server Root Node with Paste Special

All unduplicated messages are restored in each mailbox that Ontrack PowerControls can
connect to, and the directory structure of the messages is preserved.

When attempting to restore multiple mailboxes to a Microsoft Exchange Server root node, you
must look at the Copy Progress window to verify that your messages from all mailboxes were
successfully copied to the Microsoft Exchange Server. That is because Ontrack PowerControls
displays only one mailbox at a time in the Target pane.

Restoring a Folder
The following instructions show you how to restore a folder to any target destination by using Copy-
Paste. Keep in mind that dragging achieves the same results.

Guidelines for Restoring a Folder
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n You can drag or copy and paste to restore a folder to a target PST root node or folder, or to
a Microsoft Exchange Server mailbox or folder. If the folder does not exist in the target
destination, it is created.

n You cannot restore a folder to a Microsoft Exchange Server root node.
n You cannot restore a private folder to a public folder. But you can restore messages from a

private folder to a public folder.
n You cannot use the Paste Special command to restore a folder. You can use the Paste

Special command to restore individual messages only.
n If you copy the Recoverable Items folder, it is renamed to distinguish the copied version

from the actual version. The folder is renamed using the localized short date in parenthesis
and appended to the folder name. Example: "Recoverable Items (10/22/2009)"

To restore a folder

1. In the Source pane, copy a folder (for example, Inbox).
2. In the Target pane, paste the folder into a folder, mailbox, or PST root node.
3. In theCopy Progresswindow, verify your results to make sure that your messages from all

mailboxes were copied to the target destination. You can also print or save the copy report
by doing one of the following.
l Click Print to print the copy report.
l Click Save to save the copy report as a text file.

4. In theCopy Progresswindow, clickClose to return to theOntrack PowerControlsmain
window.

Results of Restoring a Folder

All unduplicated messages in the folder are restored and their directory structure is preserved. If
the folder does not exist in the target destination, it is created.

Note: No folder is created because the copied folder (Inbox) already exists in the targetMicrosoft
Exchange Servermailbox.

Restoring a Mailbox
The following instructions show you how to restore a mailbox to any target destination by using
Copy-Paste. Keep in mind that dragging achieves the same results.

Guidelines for Restoring a Mailbox

n You can drag or copy and paste to restore a mailbox to a target PST root node or folder, or
to a Microsoft Exchange Server root node, mailbox, or folder.

n If you restore a mailbox to a target PST root node: Messages from folders in the source PST
are restored to corresponding folders in the target PST (for example, messages from the
source Inbox are restored to the target Inbox). If a corresponding folder does not exist in the
target destination, it is created.
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n If you restore a mailbox to a target PST folder, or to a Microsoft Exchange Server, mailbox,
or folder: If the mailbox does not exist in the target destination, a folder with its name is
created.

Important: If you want to restore a mailbox to a target Microsoft Exchange Server root
node, the source mailbox must exist on the target Microsoft Exchange Server, and you
must have full mailbox access rights to all of the Microsoft Exchange Server mailboxes you
are trying to restore messages to. For more information on access rights, see "About
Restoring Messages to a Microsoft Exchange Server".

n You cannot restore a mailbox to a public folder. But you can restore messages from a
mailbox to a public folder.

n You cannot use the Paste Special command to restore a mailbox. You can use the Paste
Special command to restore individual messages only.

To restore a mailbox

1. In the Source pane, copy a mailbox (for example, User 1).
2. In the Target pane, paste the mailbox into a folder, mailbox, PST root node, or Microsoft

Exchange Server root node.
3. In theCopy Progresswindow, verify your results to make sure that your messages from all

mailboxes were copied to the target destination. You can also print or save the copy report
by doing one of the following.
l Click Print to print the copy report.
l Click Save to save the copy report as a text file.

4. In theCopy Progresswindow, clickClose to return to the Ontrack PowerControls main
window.

Results of restoring a mailbox

All unduplicated messages in a mailbox are restored and their directory structure is preserved.

If the mailbox does not exist in the target destination, a folder with its name is created. However, if
you restore a mailbox to a target PST root node, a mailbox is not created. Instead, messages from
folders in the source PST are restored to corresponding folders in the target PST.

Restoring an EDB File
The following instructions show you how to restore an entire EDB file to any target destination with
Copy-Paste. Keep in mind that dragging achieves the same results.

Guidelines for Restoring an EDB File

n It is recommended that you restore an EDB file to a target Microsoft Exchange Server root
node.
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n You can drag or copy and paste to restore an entire EDB file. You cannot use the Paste
Special command to restore an EDB file. You can use the Paste Special command to
restore individual messages only.

Important: If you restore an EDB file to a target Microsoft Exchange Server root node, the
source mailbox must exist on the target Microsoft Exchange Server, and you must have full
mailbox access rights to all of the Microsoft Exchange Server mailboxes to which you are
trying to restore messages. For more information on access rights, see "About Restoring
Messages to a Microsoft Exchange Server".

To restore an EDB file

1. In the Source pane, select the EDB file.
2. On the Editmenu, clickCopy.
3. In the Target pane, select the Microsoft Exchange Server root node.
4. On the Editmenu, click Paste.
5. In theCopy Progresswindow, review your results to make sure all the messages were copied

to the target destination. You can also print or save the copy report by doing one of the
following.
l Click Print to print the copy report.
l Click Save to save the copy report as a text file.

6. In theCopy Progresswindow, clickClose to return to the Ontrack PowerControls main
window.

Results of restoring an EDB file

Ontrack PowerControls attempts to connect to each mailbox in the Target pane one at a time
and copies each message to its corresponding mailbox and folder. If the folder does not exist, it
will be created. If the mailbox does not exist, Ontrack PowerControls displays an error in the Copy
Progress window, skips the entire mailbox, and continues the operation.

Restoring to Public Folders
The following instructions show you how to restore messages or public folders to a public folder
target. An option to open public folders is available upon connection to a Microsoft Exchange
Server.

Important: Ontrack PowerControls opens public folders and your mailbox when you connect to a
Microsoft Exchange Server target. You will see those folders that you have permission to see.

Guidelines for Restoring to Public Folders

n You can restore folders from a pub.edb database or Public Folder mailbox to a public folder
target. All public folder permissions are transferred to the target folders. However, folder
permissions may not transfer if the version of the source Microsoft Exchange Server is
different than the version of the target Microsoft Exchange Server.
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Note: Public folder permissions cannot be transferred toMicrosoft Exchange Server 2013 or
later targets.

n You can restore messages from any database source or search results to a public folder
target.

n You cannot restore a folder or non-Public Folder mailbox from a mailbox database to a
public folder target. But you can restore messages in a folder or non-Public Folder mailbox
to a public folder.

n You cannot use Paste Special when restoring messages to a public folder target.

Note: The ability to restore to public folders is also available at the command line.

To restore messages to a target Public Folders

1. In the Source pane or Find in Source window, copy messages from the message list.
2. In the Target pane, paste the messages into the target root public folder or a folder in the

public folder.
3. In theCopy Progresswindow, verify that your messages were successfully copied. You can

also print or save the copy report by doing one of the following.
l Click Print to print the copy report.
l Click Save to save the copy report as a text file.

4. In theCopy Progresswindow, clickClose to return to the Ontrack PowerControls main
window.

To restore a folder from a public database or Public Folder mailbox to a target Public Folders

1. In the Source pane copy a folder from a public database, or Public Folder mailbox in a
Microsoft Exchange Server 2013 or later mailbox database.

2. In the Target pane, paste the folder into the target root public folder or a folder in the public
folder.

3. In theCopy Progresswindow, verify that your messages were successfully copied. You can
also print or save the copy report by doing one of the following.
l Click Print to print the copy report.
l Click Save to save the copy report as a text file.

4. In theCopy Progresswindow, clickClose to return to the Ontrack PowerControls main
window.

Note: Public folders can be stored in different public folder databases or public foldermailboxes.
All source public folder databases andmailboxes list all public folders, not just those they store
content for. Only the public folders storedwithin the selected public folder database ormailbox
will contain items in the Source pane.

Results of Restoring to Public Folders

When you restore folders from a pub.edb database or Public Folder mailbox to a public folder
target, the following occurs:
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n All public folder permissions are transferred to the target folders. However, folder permissions
may not transfer if the version of the source Microsoft Exchange Server is different than the
version of the target Microsoft Exchange Server.

Note: Public folder permissions cannot be transferred toMicrosoft Exchange Server 2013 or
later targets.

n The Microsoft Exchange Server user doing the restore will be added to all public folder
permissions with owner rights.

n If you have IFS (also known as "M:drive") enabled on your Microsoft Exchange Server,
permissions for child folders may be merged with permissions for parent folders.
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Chapter 6: Using the Command Line
Overview
The command line feature allows you to easily batch repetitive processes such as multiple copy
and export tasks without initiating the Ontrack PowerControls user interface. This feature is
extremely beneficial in Ontrack PowerControls production environment implementations.

Note:Onlymessage containers (such asmailboxes, folders, entire EDB) can be selected for
copy/export. All messages contained are copied/exported. Individualmessages cannot be
selected from the command line.

Command Line Syntax
The syntax is as follows:

<< >> Required for all operations

< > Required for copy/export operations

[ ] Optional

Command Line Syntax

powercontrols <<Operation>> [Program Options] [Operation options] <<Source Store>> [Source
options] <Source Folder Path> <Target Store>[Target options] <Target Folder Path>

<<Operation>>

-copy

Copy source selection to the data store specified by the Target details.

-export

Export source selection, creating a new item type specified by the –f option, in the
specified Target Folder Path.

-list

List top level folders or mailboxes for source selection.

-integ

Perform integrity check of source selection.

-h

Open the Command Line options help.

[Program Options]
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-Server[=Address]

This program option provides control of the choice of Ontrack Administrative Server (OAS).
Without an address the switch forces the display of the Ontrack Administrative Server Connection
Point Manager dialog box. This dialog box allows you to use a server different from the server
advertised in the Active Directory. Without an address this option is only valid when running in GUI
mode.

Address

(address=<address>);(port=<port>)

Force a connection attempt at the specified address and port. For example: "-
server=(address=192.168.0.2);(port=49152)" forces a connection to a server
running on IP address 192.168.0.2 on port 49152.

[Operation options]

-f:<format option>

The format option will be the data type created during an –export command.

msg

Export message as .msg (.msg is the default).

txt

Export message as .txt.

pst

Export message to a PST.

-p:<format option>

97

Create a 97-2002 style PST (ANSI) during export.

2003

Create a 2003 style PST (Unicode) during export.

Note: See "Exporting Messages" for further detail.

-r

Include all subfolders of source selection in the export/copy function.

-d:<date criteria>

received

sent
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due

expires

created

modified

starts

ends

completed

any

Note: Date criteria can be used only with -copy and -export operations.

Note:Option “any” can be used for filtering through all date types specific for all item types
available in the given data set.

-a:<mm/dd/yyyy>

Process messages dated on or after this date (optional).

-b:<mm/dd/yyyy>

Process messages dated on or before this date.

-c:<AND or OR operators>

Adds logical operators OR/AND into several dates criteria.

Note: -c parameter is optional, if skipped set toOR.

-o <path ending with output filename>

Generate a process log.

-v

Write verbose data to the output file (-o c:\output.txt).

Note: If the file exists, Ontrack PowerControls will append to the output progress file. If the file
does not exist, Ontrack PowerControls will create it.

-type<item type criteria> message

post

note

calendar

contact

task
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journal

distlist

Note: Type criteria can be used only with -copy and -export operations.

<Source Store>

Full path of EDB file, CAS file, or PST file

[Source options]

-l <log file path>

-t <temp file path>

-m <mailbox criteria>

Filter available mailboxes by text string. Use ; to separate multiple strings.

Note: Formore information, see "Mailbox Criteria".

-a

Automatically open the specified EDB source and view it in the source tree
without using the Data Wizard.

< Source Folder Path >

The internal path to the desired data; the mailbox to the source folder, profile folder, or
$ROOT for all folders.

If specifying amailbox, the mailbox name can be its display name.

If specifying a sourcemailbox that is in the current environment, the mailbox name can be
its display name or the UPN (for example, mailbox@domain.local).

If specifyingmultiple folders ormailboxes, separate their names with a pipe “|” symbol (for
example, folder1|folder2|folder3).

Note: If the "Enforce ABP or HostedOrganization for current user" security preference is selected
on the Security tab of the Preferences dialog box, onlymatchingmailboxes can be accessed. For
more information, see "Multi-Tenancy Support".

<Target Store>

The ServerName;mailbox , path to folder, or Full path and name of PST.

Note: The ServerNamecan be omitted if Autodiscover is being used.

Note: The Target Store is not needed for export. Default path for output will be the current path of
the command line.

[Target options]

-pub
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Connects to target's Public Folders

-partialmatch:<copy|skip>

copy

Allow copy of partial match mailboxes into target.

skip

Skip all partial match mailboxes during copy.

-autodiscover:<on|off>

on

Use Autodiscover to connect to the target mailbox.

off

Do not use Autodiscover to connect to the target mailbox.

-outlookanywhere:<on|off>

on

Use Outlook Anywhere to connect to the target mailbox.

off

Do not use Outlook Anywhere to connect to the target mailbox.

<Outlook Anywhere Required Options> (Not needed and ignored if –autodiscover:on is
specified)

-proxy <proxy server>

Name of Exchange proxy server for Outlook Anywhere.

-authentication:<authentication mode>

basic

Use basic authentication.

ntlm

Use NTLM authentication.

negotiate

Use Negotiate authentication.

[Outlook Anywhere Options] (ignored if –autodiscover:on is specified)
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-ssl

Use SSL for Outlook Anywhere connection, required if using basic authentication.

-principal <certificate principal name>

Principal name to look for when validating proxy server certificate.

-httpfirstonfast

On fast networks, use HTTP to connect first, then use TCP/IP.

-httpfirstonslow

On slow networks, use HTTP to connect first, then use TCP/IP.

<Target Folder Path>

Target destination: the full path, including mailbox to the target folder to be copied/exported to,
$ROOT for root datastore folder, or $PUBLIC_ROOT for root of "All Public Folders".

$ROOT

Examples of Using the Command Line
The following examples are for pre-populate EDB file, copy, export, integrity check, and list (such
as report information about the database).

Example 1: Pre-populate the EDB file, log and temp path fields of the Open Source dialog.

powercontrols c:\ExchangeDb.edb -l c:\Log_Dir -t c:\Temp_Dir

<Operation> Explanation
Pre-populate the EDB file, log and temp path fields of the open source
dialog

<Source Store> Explanation

c:\ExchangeDb.edb Path to the EDB file

-l c:\Log_Dir Log file path

-t c:\Temp_Dir Temporary file path

Example 2:Open an EDB file from the command line without using the Data Wizard.

powercontrols c:\ExchangeDb.edb -l c:\Log_Dir -t c:\Temp_Dir -a

<Operation> Explanation
c:\ExchangeDb.edb Path to the EDB file

-l c:\Log_Dir Log file path

-t c:\Temp_Dir Temporary file path

-a Automatically open the source without using the Data Wizard
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Example 3:Copy mbxUser 's Inbox and all subfolders from c:\ExchangeDb.edb to the Inbox in
c:\Target.pst. c:\OutputReport.txt will contain the copy report.

powercontrols –copy –r –o c:\OutputReport.txt c:\ExchangeDb.edb -l c:\LogDir
-t c:\TempDir mbxUser\inbox c:\Target.pst $ROOT

<Operation> Explanation
-copy Perform a copy operation

[Operation options] Explanation

-r Copy subfolders

-o c:\OutputReport.txt Output report file name

<Source Store> Explanation

c:\ExchangeDb.edb Path to the database file name

[Source options] Explanation

-l c:\LogDir Log file path

-t c:\TempDir Temporary file path

<Source Folder Path> Explanation

mbxUser\inbox Source folder to copy

<Target Store> Explanation

c:\target.pst Target data store

<Target Folder Path> Explanation

$ROOT Copy to the root folder of the data store

Example 4:Copy mbxUser 's Inbox and all subfolders from c:\ExchangeDb.edb to mbxUser 's Inbox
on an active Microsoft Exchange Server ExchangeTarget.

powercontrols c:\OutputReport.txt will contain the copy report. –copy –r –o
c:\OutputReport.txt c:\ExchangeDb.edb -l c:\LogDir -t c:\TempDir
mbxUser\inbox ExchangeTarget;mbxUser inbox

<Operation> Explanation
-copy Perform a copy operation

[Operation options] Explanation

-r Copy subfolders

-o c:\OutputReport.txt Output report file name

<Source Store> Explanation

c:\ExchangeDb.edb Path to the database file name

[Source options] Explanation

-l c:\LogDir Log file path
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<Operation> Explanation
-t c:\TempDir Temporary file path

<Source Folder Path> Explanation

mbxUser\inbox Source folder to copy

<Target Store> Explanation

ExchangeTarget;mbxUser Target data store (Microsoft Exchange Server name and logon ID)

<Target Folder Path> Explanation

inbox Copy to the inbox

Example 5: Export mbxUser 's mailbox and all subfolders from ExchangeDb.edb as text to
c:\ExportDir.

powercontrols –export –r -f:txt –o c:\OutputReport.txt c:\ExchangeDb.edb -l
c:\LogDir -t c:\TempDir mbxUser c:\ExportDir

<Operation> Explanation
-export Perform an export operation

[Operation options] Explanation

-r Export subfolders

-f:txt Messages will be exported as .txt

-o c:\OutputReport.txt Export report file name

<Source Store> Explanation

c:\p cdata.edb Path to the database file name

[Source options] Explanation

-l c:\LogDir Log file path

-t c:\TempDir Temporary file path

<Source Folder Path> Explanation

mbxUser Source folder to copy

<Target Store> Explanation

c:\ExportDir Target data store

Example 6: Provides information on the databases including a list of mailboxes.

powercontrols -list -o c:\mblist.txt c:\ExchangeDb.edb -l c:\LogDir -t
c:\TempDir

-list Perform a list operation

[Operation options] Explanation

-o c:\mblist.txt Output report file name
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<Source Store> Explanation

c:\ExchangeDb.edb Path to the database file name

[Source options] Explanation

-l c:\LogDir Log file path

-t c:\TempDir Temporary file path

Example 7: Provides information on the databases including a list of mailboxes filtered by mailbox
criteria.

powercontrols -list -o c:\mbxlist.txt c:\ExchangeDb.edb -l c:\LogDir -t
c:\TempDir –m mbxUser1;mbxUser2

<Operation> Explanation
>-list Perform a list operation

<Operation> Explanation

-o c:\mblist.txt Output report file name

<Source Store> Explanation

c:\ExchangeDb.edb Path to the database file name

[Source options] Log file path

-l c:\LogDir Temporary file path

-t c:\TempDir Only open pcuser1 and pcuser2 mailboxes

Example 8: Perform an integrity check on an entire EDB.

powercontrols -integ -r –o c:\OutputReport.txt c:\ExchangeDb.edb -l c:\LogDir
-t c:\TempDir $ROOT

<Operation> Explanation
-integ Perform an integrity check on a database

[Operation options] Explanation

-o c:\OutputReport.txt Output report file name

<Source Store> Explanation

c:\ExchangeDb.edb Path to the database file name

[Source options] Explanation

-l c:\LogDir Log file path

-t c:\TempDir Temporary file path

<Source Folder Path> Explanation

$ROOT Root of the EDB (entire EDB)
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Example 9: Copy a folder from a pub EDB to public folders (only copy messages dated after
01/01/2000).

powercontrols –copy –r –o c:\OutputReport.txt -d:created-a:01/01/2000
c:\ExchangePUB.edb -l c:\LogDir -t c:\TempDir newsgroups
ExchangeTarget;mbxUser –pub $PUBLIC_ROOT

<Operation> Explanation
-copy Perform a copy operation

[Operation options] Explanation

-r Copy subfolders

-o c:\OutputReport.txt Output report file name

-d:created-a:01/01/2000 Only copy messages that were created after this date

<Source Store> Explanation

c:\ExchangeDb.edb Path to the database file name

[Source options] Explanation

-l c:\LogDir Log file path

-t c:\TempDir Temporary file path

<Source Folder Path> Explanation

newsgroups Source folder to copy

<Target Store> Explanation

ExchangeTarget;mbxUser Target data store (Microsoft Exchange Server name and
logon ID)

<Target Options> Explanation

-pub Copy to public folders

<Target Folder Path> Explanation

$PUBLIC_ROOT Public folders root

Example 10: Perform an integrity check on an entire Content Analysis Store.

powercontrols -integ -r –o c:\OutputReport.txt c:\source.cas $ROOT

<Operation> Explanation
-integ Perform an integrity check on a database

[Operation options] Explanation

-r Check subfolders

-o c:\OutputReport.txt output report file name

<Source Store> Explanation

c:\source.cas Path to the Content Analysis Store file name
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<Operation> Explanation
<Source Folder Path> Explanation

$ROOT Root of the CAS (entire CAS)

Example 11:Copy Profile1 from c:\source.cas to the root in c:\target.pst.

powercontrols -copy -r –o c:\OutputReport.txt c:\source.cas Profile1
c:\Target.pst $ROOT

<Operation> Explanation
-copy Perform a copy operation

[Operation options] Explanation

-r Copy subfolders

-o c:\OutputReport.txt output report file name

<Source Store> Explanation

c:\source.cas Path to the Content Analysis Store file name

<Source Folder Path> Explanation

Profile1 Source folder to copy

<Target Store> Explanation

c:\target.pst Target data store

<Target Folder Path> Explanation

$ROOT Copy to the root folder of the data store

Example 12: Export Profile2 from source.cas as text to c:\export.

powercontrols -export -r -f:txt –o c:\OutputReport.txt c:\source.cas Profile2
c:\ExportDir

<Operation> Explanation
-export Perform an export operation

[Operation options] Explanation

-r Export subfolders

-f:txt Messages will be exported as .txt

-o c:\OutputReport.txt Export report file name

<Source Store> Explanation

c:\source.cas Path to the Content Analysis Store file name

<Source Folder Path> Explanation

Profile2 Source folder to copy

<Target Store> Explanation

c:\ExportDir Target data store
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Example 13:Copy all subfolders and messages from the mbxUser mailbox in c:\ExchangeDb.edb
to the mailbox at mail@exchserver.local. Use Autodiscover to connect, but do not use Outlook
Anywhere to connect.

powercontrols -copy -r -o c:\OutputReport.txt c:\ExchangeDb.edb -l c:\LogDir
-t c:\TempDir mbxUser mailbox1@exchserver1.local -autodiscover:on -
outlookanywhere:off $ROOT

<Operation> Explanation
-copy Perform a copy operation

[Operation options]

-r Copy subfolders

-o c:\OutputReport.txt Output report file name

<Source Store> Explanation

C:\ExchangeDb.edb Path to the database file

[Source options] Explanation

-l c:\LogDir Log file path

-t c:\TempDir Temporary file path

<Source Path> Explanation

mbxUser Source folder to copy

<Target Store> Explanation

;mailbox@exchserver1.local Target mailbox (autodiscovery provides the Exchange
environment)

[Target options] Explanation

-autodiscover:on Use Autodiscover to connect. Autodiscover will detect the
Exchange server

-outlookanywhere:off Do not use Outlook Anywhere to connect

<Target Path> Explanation

$ROOT Copy to the root of the mailbox

Example 14:Copy all subfolders and messages from the mbxUser mailbox in c:\ExchangeDb.edb
to the mailbox at mbxUser@exchserver1.local. Do not use Autodiscover to connect. Use the
Outlook Anywhere with settings as follows: proxy server is
exchservervas.exchserver.local,connecting using SSL, use basic authentication.

powercontrols -copy-r –o c:\OutputReport.txt c:\ExchangeDb.edb -l c:\LogDir -
t c:\TempDir mbxUser ExchangeTarget;mbxUser@ExchangeTarget.local -
autodiscover:off -outlookanywhere:on -proxy ExchangeCAS.ExchangeTarget.local
-authentication:basic -SSL $ROOT
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<Operation> Explanation
-copy Perform a copy operation

[Operation options]

-r Copy subfolders

-o c:\OutputReport.txt Output report file name

<Source Store> Explanation

c:\ExchangeDb.edb Path to the database file

[Source options] Explanation

-l c:\LogDir Log file path

-t c:\TempDir Temporary file path

<Source Path> Explanation

mbxUser Source folder to copy

<Target Store> Explanation

ExchangeTarget;mbxUser@ExchangeTarget.local Target Exchange server and mailbox.
Server must be specified because
Autodiscover is not being used

<Target options> Explanation
-autodiscover:off Do not use Auto Discover to connect to

target mailbox.

-outlookanywhere:on Use Outlook Anywhere to connect to the
target mailbox.

<Outlook Anywhere Required Options> Explanation

-proxy ExchangeCAS.ExchangeTarget.local Name of Exchange proxy server for Outlook
Anywhere.

-authentication:basic Use basic authentication

<Outlook Anywhere Options> Explanation

-SSL Use SSL for Outlook Anywhere connection,
required if using basic authentication

<Target Folder Path> Explanation

$ROOT $ROOT for the root of the mailbox "mbxUser"

Example 15: Export mbxUser 's mailbox and all subfolders from ExchangeDb.edb as text to
c:\ExportDir (export only messages with create date after 01/01/2000 and before 05/01/2000, or
with send date after 01/01/2000 and before 05/01/2000).

powercontrols –export –r -f:txt –o c:\OutputReport.txt -d:created-
a:01/01/2000-b:05/01/2000-c:OR -d:sent-a:01/01/2000-b:05/01/2000
c:\ExchangeDb.edb -l c:\LogDir -t c:\TempDir mbxUser c:\ExportDir
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<Operation> Explanation
–export Perform an export operation

[Operation options] Explanation

-r Export subfolders

-f:txt Messages will be exported as .txt

-o c:\OutputReport.txt Export report file name

-d:created-a:01/01/2000-
b:05/01/2000-c:OR -d:sent-
a:01/01/2000-b:05/01/2000

Date criteria - only export messages that were created
between 01/01/2000- 05/01/2000 or were sent between
01/01/2000- 05/01/2000

<Source Store> Explanation

c:\ExchangeDb.edb Path to the database file name

[Source options] Explanation

-l c:\LogDir Log file path

-t c:\TempDir Temporary file path

<Source Folder Path> Explanation

mbxUser Source folder to copy

<Target Folder Path> Explanation

c:\ExportDir Target data store

Example 16: Export mbxUser 's mailbox and all subfolders from ExchangeDb.edb as text to
c:\ExportDir (export only (message type or calendar type items) that have any date property
after 01/01/2000 and before 05/01/2000).

powercontrols –export –r -f:txt –o c:\OutputReport.txt -type:message;calendar
-d:any-a:01/01/2000-b:05/01/2000

c:\ExchangeDb.edb -l c:\LogDir -t c:\TempDir mbxUser c:\ExportDir
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Chapter 7: Reporting
Overview
This section shows you how to create reports, view the statistics in the generated reports, and save
the reports as either tab-delimited or comma-delimited text files. Any data store opened as a
source can be the source of a report.

Note: If you use the "Mailbox Criteria (optional)" box on the Select Source Files dialog box or the
Source Selection page of the DataWizard, only EDBmailboxes containing your entry (or entries)
are displayed on the Source pane. Anymailboxes that do notmatch the entered string(s) do not
appear in the Source pane andare not be included in any subsequent tasks (such as searching,
copying, and exporting of the entire database). Formore information, see "Mailbox Criteria".

Note: If you use the "Multi-TenancyCriteria" box on the Select Source Files dialog box, the Source
Selection page of the DataWizard, theConnect to Exchange Server dialog box, or the Target
Selection page of the DataWizard, onlymailboxes contained in the selectedAddress Book Policy
or Organization appear in the Source or Target panes. Only thesemailboxes are included in any
subsequent tasks (such as searching, copying, and exporting of the entire database). Formore
information, see "Multi-Tenancy Support".

Creating Reports
You can generate reports on an EDB, PST, or CAS source data store in Ontrack PowerControls. The
reports contain statistics about the data store such as sizes and counts for attachments and
messages, and may be generated per attachment type, domain, mailbox, database, and date.
The Mailbox and Date reports are available for Priv EDB data sources only.

Note:Only accessiblemailboxes can generate a report.

To create one or more reports

1. In the Source pane, select an EDB, PST, or CAS data source.
2. On the Toolsmenu, clickCreate Reports. TheCreate Reportswindow appears.

l If you selected a Priv EDB as the source for the report, the list pane displays all mailboxes
in the EDB.

l If you selected a PST or Pub EDB as the source, the list pane displays all folders
immediately under the root of the PST or Pub EDB.
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Figure 7-1: TheCreate Reports dialog box
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Figure 7-2: TheCreate Reports window for aCAS

3. Do one of the following:
l For Priv EDB: UnderMailboxes, select the mailboxes to be included in the report(s). All

mailboxes are selected by default.
l For Pub EDB or PST: Under Folders, select the folders to be included in the report(s). All

folders are selected by default.
l For CAS: Under Profile Folders, select the folders to be included in the report(s). All folders

are selected by default.
4. Under Reports, select one or more reports that you would like to create:

l Attachment Statistics
l Domain Statistics
l Messages by Database
l Messages by Profile Folder: This report is available for CAS data sources only.
l Messages by Mailbox: This report is available for Priv EDB data sources only.
l Messages by Date: If you select this report, then specify the appropriate options for

received date range and date unit (for example, hour, day, week, month). This report is
available for Priv EDB and CAS data sources only.

5. UnderMessage Options, select the appropriate deleted item retention option(s). Both
options are selected by default. For PST sources, the first option is cleared. You cannot
modify the default options for PST sources.
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l Include messages in deleted item retention: Select this option to include messages in
deleted item retention.

Note for Microsoft Exchange Server 2010 and 2013 sources:When the Show
Recoverable Items preference is enabled (formore information, see "Security Tab"),
themessages in the Recoverable Items folder are included in the reports for
Microsoft Exchange Server 2010 and 2013 sources only if the Include messages in
deleted item retention check box is selected. If the preference setting is cleared,
then the Include messages in deleted item retention check box is unchecked and
disabled forMicrosoft Exchange Server 2010 and 2013 reports.

l Include messages not in deleted item retention: Select this option to include messages
that are not in deleted item retention. In most cases, this option represents most of the
messages in the source data store.

6. ClickGenerate Reports. The Reportswindow appears. For more information the contents of
the reports, see "Viewing Reports".

Viewing Reports
The Reports window shows the progress of the report generation and also shows the reports
themselves. This window consists of a tabbed view of the reports, with each tab containing a
single report.

Figure 7-3: The Reports progress window
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Single Instance Storage (SIS) vs. Cumulative Counts
The Attachment Statistics and Messages by Database reports use the terms "SIS" (Single Instance
Storage) and "Cumulative" when referring to the number and size of attachments in the data
store. The term "SIS" counts attachments only once and does not include their duplicates. The term
"cumulative" refers to all of the attachments or messages, including their duplicates.

Example: An attachment of type .doc of size 100 KB is being shared by three messages. As the
table shows, the SIS size more closely estimates how much of the EDB size is attributed to the
attachment.

The cumulative size more closely estimates how much of the EDB size is attributed to attachments if
the data store did not have SIS.

Method of Counting Attach-
ments/Messages

Total # of .doc Attach-
ments

Total Size of .doc
Files

SIS Count 1 100 KB

Cumulative Count 3 300 KB

Attachment Statistics Report
The Attachment Statistics report provides statistics on all of the attachments contained in
messages in the selected source. The attachments are categorized by extension, which appears
in upper case letters (for example, .doc, .xls). Attachments without extensions are put into a
separate row called "No Extension."

Column Heading Description

Attachment Extension Attachment type by extension (for example, .doc, .ppt, .pdf).

Cumulative Number of
Attachments Found in
Messages

Cumulative number of attachments of each type found in the
processed messages.

Cumulative Size of
Attachments

Cumulative size of attachments of each type found in
messages.

Average Attachment Size Cumulative size of attachments of each type divided by the
cumulative number of attachments found in messages.
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Column Heading Description

Percent of Total by Number Number of attachments of each type divided by total
attachments of all types.

Percent of Total by Size Total size of attachments of each type divided by the total size
of attachments of all types.

SIS Number of Attachments SIS number of attachments of each type. NA for PST sources.

SIS Size of Attachments SIS size of attachments of each type. NA for PST sources.

SIS Percent of Total by Size SIS size of attachments of each type divided by SIS size of
attachments of all types in attachment table. NA for PST
sources.

Domain Statistics Report
The Domain Statistics report provides statistics on messages grouped by the domain from which
the messages were sent.

The domain is determined using the PR_SENDER_ADDRTYPE in combination with the PR_SENDER_
EMAIL_ADDRESS as follows:

l If PR_SENDER_ADDRTYPE is "EX" or "SYSTEM," then it is a Microsoft Exchange Server
message and the domain is "internal."

l If PR_SENDER_ADDRTYPE is "SMTP", then the domain is whatever follows the @ in the PR_
SENDER_EMAIL_ADDRESS property.

l If PR_SENDER_ADDRTYPE is something else, then the domain is "unknown."

Column
Heading

Description

Domain The name of the domain (for example, www.ontrack.com) from which
the message was sent. All messages whose domain cannot be
determined are placed into an "unknown" domain. All Microsoft
Exchange Server messages are placed into an "internal" domain.

Number of
Messages

Total count of messages that were received from each domain.

Total Size of
Messages

Total size of all messages that were received from each domain.
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Column
Heading

Description

Percent of
Total by
Number

Number of messages from each domain divided by the total number of
messages from all domains.

Percent of
Total by Size

Total size of messages from each domain divided by the total size of
messages from all domains.

Messages by Database Report
The Messages by Database report provides statistics on the database that contains the processed
messages. In the current version of Ontrack PowerControls, reports are limited to a single EDB or
PST, which means the database report has only one row of information. For example, the
database report for Priv1.edb has one row of information listing all message statistics for Priv1.edb
and its mailboxes.

Column Heading Description

Database (EDB, PST,
or CAS)

The database name (for example, Priv1.edb, Pub1.edb, Microsoft
Office Outlook.pst, User1.cas).

Cumulative Number
of Messages

Cumulative number of messages.

Cumulative Size of
Messages

Cumulative size of all messages processed.

Average Size of
Messages

Cumulative size of messages divided by cumulative number of
messages.

Cumulative Size of
Attachments

Cumulative size of attachments in all messages processed.

SIS Size of
Attachments

SIS total size of attachments. This column applies only to EDB sources.
For PST and CAS data stores, this column is NA.
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Figure 7-4:  TheCreate Reports dialog box for a Priv EDB source

Messages by Mailbox Report
The Messages by Mailbox report provides message statistics for all selected mailboxes in a Priv EDB
data store.

Note: This report is available only for a Priv EDB.

Column Head-
ing

Description

Mailbox Name of the mailbox: Display name (alias)

Number of
Messages

Total number of messages in the mailbox.

Total Size of
Messages

Total size of all messages in the mailbox.

Average Size
of Messages

Total size of messages divided by number of messages.
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Column Head-
ing

Description

Total
Attachment
Size

Total size of attachments in all messages in this mailbox. Attachments in
messages in this mailbox that are also in messages in another mailbox are
counted in both mailboxes.

Shared
Attachment
Size

Size of attachments that are found more than once, either multiple times in
this mailbox or in this mailbox and other mailboxes. Calculated as total size of
attachments minus the non-shared attachment size.

Non-shared
Attachment
Size

Size of attachments that are not shared with other messages.

Internal
Received
Messages

Received messages of type "EX" or "SYSTEM."

SMTP
Received
Messages

Received messages of type "SMTP."

Other
Received
Messages

Received messages not of type "EX," "SMTP," or "SYSTEM."

Note: For a definition of "receivedmessage," see the "Glossary".

Messages by Date Report
The Messages by Date report provides statistics for messages in a date range, such as 1/1/2004 to
1/1/2005, and a unit of hours, days, weeks, or months. The report is keyed off of the received date
of the message.

Note: This report is available only for a Priv EDB andCAS files.

Column Heading Description

Hour/Day/Week/Month The date unit that was selected in the Create Reports window.
Examples are: Hour: "12/25/2004 - 9 PM" Day: "12/25/2004" Week:
"12/26/2004 - 1/1/2005" (Weeks start on Sunday and end on
Saturday.) Month: "12/2004"
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Column Heading Description

Internal Received
Messages

Received messages of type "EX" or "SYSTEM."

Total Size of Internal
Received Messages

The sum of the internal received message sizes.

SMTP Received Messages Received messages of type "SMTP."

Total Size of SMTP
Received Messages

The sum of the SMTP received message sizes.

Other Received Messages Received messages not of type "EX," "SMTP," or "SYSTEM."

Total Size of Other
Received Messages

The sum of the other received message sizes.

Note: For a definition of "receivedmessage," see the "Glossary".

Messages by Profile Folder
The Messages by Profile Folder report provides statistics for messages in a profile folder, the number
of messages, total size of messages, average size of messages, total attachment size, shared
attachment size, non-shared attachment size, internal received messages, SMTP received
messages, and other received messages. The report is keyed off of the profile folder.

Note: TheMessages by Profile Folder report only includes information gathered fromaccessible
mailboxes.

Note: This report is available only for aCAS.

Column Head-
ing

Description

Profile Folder Title of the profile folder.

Number of
Messages

Total number of messages in the profile folder.

Total Size of
Messages

Total size of all messages in the profile folder.

Average Size
of Messages

Total size of messages in the profile folder divided by number of messages.
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Column Head-
ing

Description

Total
Attachment
Size

Total size of attachments in all messages in the profile folder.

Shared
Attachment
Size

Size of attachments that are found more than once, either multiple times in
this profile folder or in this profile folder and other profile folders.

Non-shared
Attachment
Size

Size of attachments that are not shared with other messages.

Internal
Received
Messages

Received messages of type "EX" or "SYSTEM."

SMTP Received
Messages

Received message of type "SMTP."

Other
Received
Messages

Received messages not of type "EX," "SMTP," or "SYSTEM."

Note: For a definition of "receivedmessage," see the "Glossary".

Sorting Reports
Sorting of reports is available after the reporting process has finished. The order in which statistics
first appear in the Reports window is based on the ascending order of statistics in the first column
(for example, for the Attachment Statistics column, .doc precedes .txt). However, you can sort
statistics based on any column heading.

To sort the statistics in a report

1. Click a column heading to sort the statistics based on that heading. An arrow appears
indicating the sort direction. An up arrow indicates the statistics appear in ascending (A-Z)
order. A down arrow indicates that the statistics appear in descending (Z-A) order.

2. To reverse the order of the statistics based on that column heading, click the column
heading again. The arrow reverses directions.

An Example of Sorting
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The Attachment Statistics report is originally sorted based on the ascending order of attachment
extensions (for example, .doc precedes .txt). If you click the Attachment Extension heading, the
down arrow appears and statistics are sorted in descending order (for example, .txt precedes
.doc).

If you click the "Number of Attachments Found in Messages" column heading, the up arrow
appears and statistics are sorted based on ascending order. This means that the attachment
extension occurring least frequently in the data source appears first in the report.

Saving Reports
You may save the currently active report as either a tab-separated or comma-separated text file.
The report name defaults to the name shown on the report tab, without the spaces and with a .txt
extension (for example, MailboxReport.txt). The file type defaults to a tab-separated text file.

To save a report

1. In the Reportswindow, make the desired report active by clicking its tab (for example,
Attachment Report, Database Report).

2. Click Save.
3. In the Save Reportwindow, specify the name, location, and file type for the report. You may

save the report as either a tab-separated or comma-separated text file.
4. Click Save to return to the Reportswindow.
5. Repeat steps 1-4 for each report you want to save.
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Chapter 8: Content Analysis Store
Overview
The content analysis store (CAS) enables you to automate and save search results by selecting
sources. Sources include entire EDB files, individual mailboxes from an EDB, or folders from an EDB.
Any number of sources is allowed, including multiple EDBs.

After selecting specific sources, you can create profile folders as subfolders to the content analysis
store. Each profile folder has the same criteria as the search criteria, such as, "From," "To," "Subject,"
etc. Only messages matching the criteria are contained in the profile. Multiple profile folders are
possible. Every profile folder processes simultaneously. This allows you to make many separate
searches (profiles) for the same set of sources.

After the processing is complete, you can open the content analysis store as a source. This allows
you to use the CAS for searching, copying, exporting, and integrity checks. It allows you to copy
the data out of the CAS into PSTs or to a Microsoft Exchange Server. It allows you to repeatedly use
a specific set of profile results without having to rerun the profile processing. The results of the profile
can be saved between sessions using the CAS. You can also save the CAS on one computer and
reopen it on a different computer to share the results of a profile.

Content analysis stores provide a method for an email administrator to perform content analysis
offline from their production server. This feature:

n Minimizes the time it takes to detect/filter out emails that include specific content.
n Minimizes the time it takes to detect/filter out a specific type of email file that is being sent or

received (for example, specific extension, subject, date).
n Analyzes the number of emails being sent/received that contain what could be legally

damaging content (for example, admission of guilt).
n Analyzes the number of emails being sent/received that contain politically incorrect

content (for example, tasteless jokes, pornography).
n Analyzes the number of emails with confidential content that go out unprotected -

unencrypted.
n Minimizes the time it takes to determine if someone is using the system for unauthorized

activity (for example, spamming, inappropriate downloads, starting a business).

Creating a Content Analysis Store
A new content analysis store can be created from the File menu, from the toolbar, or from the Data
Wizard. After the CAS file is created, a new content analysis store shows in the Target pane.
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To create a content analysis store using the toolbar

1. On the toolbar, click theCreate/Open Target Content Analysis Store icon located on
the toolbar. TheOpening a Content Analysis Filewindow appears.

2. Enter a File nameand in the Look inbox, select a destination.
3. ClickOpen. The name of the store defaults to the file name you entered in step 2. It can be

renamed as any other target folder.

To open or create a target Content Analysis Store using the menu

1. To display theOpening a Content Analysis Filewindow, on the Filemenu, point toOpen
Target Content Analysis Storeand clickOpen Existing orCreate New.

2. If creating a new target CAS, enter a File nameand clickOpen.
3. If opening an existing target CAS, select the CAS from the list and clickOpen.

To open or create a target Content Analysis Store using the Data Wizard

1. On the Filemenu, click Use Wizard.
2. On the Source Selection page, clickContent Analysis Store (.cas) in Select Source list.

Figure 8-1: Selecting aCAS on the Source Selection page

3. On theContent Analysis Store (.cas)box, click Browse to open the Create Content Analysis
File window and locate the source CAS.

4. ClickNext.
5. On the Target Selection page, clickContent Analysis Store (.cas) in Select Target list.
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Figure 8-2: SelectingContent Analysis Store on the Target Selection page

6. Do one of the following:
n If you know the target CAS file path, type it in theContent Analysis Store Pathbox.
n Click Browse to open theCreate Content Analysis Storewindow, and navigate to the

desired location. Then create a new CAS file by typing a name in the File namebox,
or select an existing CAS file. Then clickOpen. The path of the target CAS file appears
in theContent Analysis Store Pathbox.

7. ClickNext.

Creating a Content Analysis Store with Microsoft Exchange
Server 2010 and 2013 Data
Any source or target content analysis store (CAS) created with Microsoft Exchange Server 2010
and 2013 data is subject to different handling based on the Recoverable Items preference
settings. For more information, see "Security Tab".

When a CAS is created, whatever the Recoverable Items preference setting is at that time will be
stored with that CAS. If you attempt to open a CAS as a source or target, the preference stored in
the CAS is checked against the current preference setting. If they do not match, the following
message displays: "The current `Show Recoverable Items' preference setting does notmatch the
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setting for theContent Analysis Store. TheContent Analysis Store cannot be opened unless its
setting is changed. To change the setting theContent Analysis Store, click `OK.' TheContent
Analysis Storewill be openedas a target and all profiles will be reprocessed. Click `Cancel' to
cancel opening theContent Analysis Store."

Note: If aMicrosoft Exchange Server 2010 or 2013 source EDB file hasmulti-tenancy criteria
applied, it cannot be added to a target CAS file.

Creating and Processing Content Analysis Store Profile
Folders
A content analysis store profile folder is created as a subfolder of the content analysis store to filter
EDB messages (only) based on the profile criteria.

When the profile folder is created, a folder appears under the content analysis store and Ontrack
PowerControls searches all the sources in the content analysis store for messages that match the
criteria for the profile folder.

During processing (searching), the profile folder is green and its status will indicate that processing
is taking place. The status bar at the lower left also indicates the status. The message pane on the
right populates with the results when the profile folder is selected or when the screen is refreshed.

Deduplication can be performed on a per profile basis and if selected does not return duplicates
of a message during a search. For example, if the same message exists in two or more data stores,
only the first message found is listed in the search results. Selecting this option may result in slower
search performance.

Note:Only accessiblemailboxes in the EDB source can populate theCAS target profile with
messages.

Note: If a source EDB is openedwithmulti-tenancy restrictions, it cannot be used as a source for a
target CAS.

To create and process a content analysis store profile folder

1. Select a target content analysis store root.
2. In the Profilemenu on the menu bar, clickCreate Profile. TheCreate Profilewindow opens

with "Profile1" as the default Profile Name. Once created, the content analysis store profile
folder can be renamed just as any folder would be.

3. Enter the criteria for the content analysis. This window offers similar search options as the Find
window. For more information, see "Finding Messages".

Note: The profile criteria can be saved and imported.
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Figure 8-3: TheCreate Profile Folder window is used to enter profile criteria

4. ClickOK. Ontrack PowerControls indicates that a profile is processing when the color of the
profile folder is green and its status states "Processing." When the profile is selected, the
status shown in the status bar at the lower left of the main window indicates that the profile is
processing. For more information, see "Profile Processing Statuses ".

5. When the processing for a profile is complete, the color of the profile icon changes from
green to blue and its status states "Completed." All messages from the content analysis store
EDBs that match the criteria are contained in the profile folder.

Note: Acontent analysis store cannot be openedas a source until all profile processing
has completed.

Figure 8-4: Messages displayed after profile folder created

Note: If the same source is added to the content analysis store twice for processing,
Ontrack PowerControls ignores the second copy. The source is not listed twice nor is an
error message displayed.
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DB # Column
The content analysis store profile folder message views include a column to display a database
number to enable you to trace back to the actual database in the content analysis store. This
number does not correlate to the profile folder number or source #, i.e., "Profile1" or "Source 1"
does not necessarily correlate with DB #1. The correlation is between the profile folder message
and the source database.

Example:

Figure 8-5: The Database numbers are tied to the actual database.

Note: Database (DB) numbers are tied to the actual database, not the folder so each folder from
the same EDBwill have the sameDB number. DB numbers increment from 1 for each different
database added to the content analysis store, not for each folder.

Profile Processing Statuses
When the profile is processing, there are four possible statuses that are displayed: Processing,
Suspended,Completed, andCompleted with errors.

Figure 8-6: Profile Processing Status folders are indicated by different colors
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Processing

After entering the profile criteria, the profile is created and is represented by a folder under the
content analysis store. During processing (searching), the profile folder is green and its status states
"Processing." Selecting the profile folder or pressing F5 populates the message pane with
messages when the processing is complete.

Processing occurs when a new profile is created, when removing a source, when adding a
source, when editing a profile, when copying a source profile folder to a target content analysis
store, or when resuming a suspended profile.

Note: If unrecoverable errors are encountered during processing then the profile is not fully
processed and is blue in color with a red ! indicating the error.

Suspended

Processing can be suspended on any profile folder during processing. Suspended profile folders
are red in color. The status also indicates that the profile is suspended. For more information, see
"Suspending and Resuming Content Analysis Store Profile Folders".

Completed

Once the processing is complete, the profile folder turns blue and its status states "Completed."

Completed with errors

If Ontrack PowerControls detects corruption or some other issues while processing, the profile
folder status states "Completed with errors." To obtain details on the error, view the Properties on
the profile folder by right-clicking on the profile folder and selecting Properties.

Figure 8-7: An errormessage displays when processing cannot be completed

Saving and Importing Profile Criteria
Profile criteria can be saved and later imported into a new profile in the Create Profile window to
save time.
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To save a profile criteria

1. On the Filemenu, click Save Criteria.
2. In the Save Aswindow, enter a File nameand click Save. Be sure to note where the criteria

file is being saved in the Look in:box.

Note: The profile folder name is not saved.

To import saved profile criteria

1. On the Filemenu, click Use Previous Criteria.
2. In theOpenwindow, select the previously saved profile criteria .txt file.
3. ClickOpen. All previously saved profile criteria, except for the Profile Name, reads from the

file and is placed into theCreate Profile fields.
4. Enter a new Profile Name.

Note: Search criteria fromprevious and current versions of Ontrack PowerControls can be
imported intoOntrack PowerControls for find and profile criteria.

Suspending and Resuming Content Analysis Store Profile
Folders
You can pause the processing of one or more profile criteria folders and then resume processing
at a later time. Suspended profile folders are red in color and then turn to green when processing is
resumed. The folder then turns to blue when processing is complete. For more information, see
"Profile Processing Statuses ".

Processing of all profiles is suspended automatically if you exit Ontrack PowerControls or if you
close the content analysis store before processing is complete.

To suspend the processing on profiles

n Do one of the following:

l Select the profile folder, click the Profilemenu and click Suspend Processing.
l Right-click the profile folder and click Suspend Processing.

To suspend processing on all profiles

n Do one of the following:

l Select the content analysis store root, click the Profilemenu and click Suspend
Processing.

l Right-click the content analysis store root and click Suspend Processing.

Note: Suspendedprofiles are red in color. The status also indicates that the profile is suspended.
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To resume processing on profiles

n Do one of the following:

l Select a profile folder, click the Profilemenu and click Resume Processing.
l Right-click the profile folder and click Resume Processing.

To resume processing of all profiles

n Do one of the following:

l Select the content analysis store root, click the Profilemenu and click Resume
Processing.

l Right-click the profile folder and click Resume Processing.

Adding Sources to Content Analysis Stores
Only EDB store objects, EDB mailboxes, or EDB folders can be dragged or copied and pasted from
the source into the new content analysis store root to prepare for analysis.

If you open a source with a set of mailbox criteria, create a CAS using that source, then close and
re-open the source with different mailbox criteria, no additional folders or mailboxes can be
added from that source. Re-open the source with the matching mailbox criteria or remove all
references to the original source before re-adding.

Note: Messages or folders cannot be copied directly to a profile folder (results folder).

To add a folder, a mailbox, or an EDB file with copy-paste

1. In the Source pane, select a folder, a mailbox, or an EDB file.
2. Do one of the following:

l On the Editmenu, clickCopy.
l Right-click the selected item(s), and on the shortcut menu, clickCopy.

l Click theCopy Mail Item icon on the toolbar.
l PressCtrl+C (Copy).

3. In the Target pane, click the content analysis store root and do one of the following:

l On the Editmenu, click Paste.
l Right-click the selected item, and on the shortcut menu, click Paste.

l Click the Paste icon on the toolbar.
l PressCtrl+V (Paste).
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4. In theCopy Progresswindow, verify that your messages were successfully copied, and click
Close.

To add data even faster, use dragging

n To move entire EDB store objects, EDB mailboxes, or EDB folders, drag to the target content
analysis store root. Dragging achieves the same results as copying and pasting.

To drag when right-clicking a source item

1. In the Source pane, select one or more messages.
2. Right-click the selected message containers and drag them to a content analysis store in

the Target pane.
3. Release the mouse and on the shortcut menu, click Paste.

If a new source (Inbox, Deleted items, Outbox, etc.) is dragged to the content analysis
store or the user removes a source store from the content analysis store, all profiles
automatically process the new source.

Editing and Deleting Profiles
Deleting a profile stops any processing on that profile and removes that profile and all data
associated with it from the content analysis store. Deleting a profile does not modify the EDB
sources.

To edit a profile

1. To edit a profile, right-click the profile folder and click Edit Profile or on the Profilemenu,
select Edit Profile.

2. On the Edit Profile Folder window, edit any or all of the criteria. When new criteria is entered,
all messages in the profile are deleted, the icon changes to its processing color (green), the
profile status will update, and the process begins.

To delete a profile

n Do one of the following:
l Right-click the profile folder and clickDelete.
l Click profile folder, and on the Editmenu, clickDelete.
l Select the profile folder and press theDelete key on the keyboard.

Closing a Content Analysis Store
Closing a content analysis store root closes the root as well as all of the profile folders created
under that root.
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To close a content analysis store (CAS)

n Do one of the following:
l Right-click the CAS and clickClose Store.
l Click the CAS and on the Filemenu, clickClose Store.

Opening a Content Analysis Store as Source
When all profile processing has completed, you can open the content analysis store as a source,
for which the following source operations can be performed: Copy/Paste, Paste Special, Export,
Find, Integrity Check, Properties, and Create Reports. Use copy/paste to copy source profile
search criteria to a target content analysis store.

Note:Opening aContent Analysis StorewithMicrosoft Exchange Server 2016 or later data is not
supported.When aCAS open as a source containingMicrosoft Exchange Server 2016 or later
data, you have the option to open theCAS as a target and remove all Microsoft Exchange Server
2016 or later data.

If a content analysis store is opened as a source and it has not completed processing all profiles, a
window indicates that the content analysis store has not completed its processing. There is then an
option to open the CAS as a target. If that option is selected, Ontrack PowerControls opens it as a
target and resumes processing on all remaining profiles.

To open a content analysis store as source

1. One the Filemenu, clickOpen Source.
2. On the Select Source Filesdialog box, click Browse to the right of Source File (*.edb, *.pst,

*.cas).
3. In the Open dialog box, select a .cas file and clickOpen.
4. In the Select Source Filesdialog box, clickOK. A source content analysis store appears in

the left pane of source.

Figure 8-8: A source content analysis store root and profile folders
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Viewing Properties of a Content Analysis Store
To view the properties of a content analysis store

n To display theCAS File Propertieswindow, right-click the CAS in either the Source or Target
pane and click Properties.

Figure 8-9: The Properties of the selectedCAS file

To view the properties of a content analysis store profile folder

n Right-click the profile folder and click Properties.

Figure 8-10: The Properties of theCAS profile folder

Creating Reports in Content Analysis Store
You can create reports of the source content analysis store by right-clicking the source content
analysis store root. The reports are:
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n Attachment statistics
n Domain statistics
n Messages by Database
n Messages by Profile Folder
n Messages by Date

For instructions on creating reports, see "Reporting ".

Viewing Profiles in Content Analysis Store
The Viewing Profiles option allows you to view what profile criteria has been used for a specific
content analysis. All fields are read only.

To view a profile

1. Do one of the following to display the Profile Folder Propertiespage:
l Right-click the profile folder in either the Source pane or Target pane and point toView
Profile Folder.

l Click the profile in either the Source pane or Target pane, click the Profilemenu and
clickView Profile Folder.
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Figure 8-11: Profile Folder Properties

2. ClickOK to exit.

Missing Database Files
If an EDB or log file that belongs to a content analysis store is moved and then the content analysis
store is opened, there is a prompt to find or remove the missing database files. If the EDB is located
but the STM is missing, Ontrack PowerControls displays an error indicating that the STM needs to be
located in the same directory as the EDB.

Missing EDB
When there is a wrong EDB, you are prompted to locate the file.
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To locate the missing EDB

1. On theMissing Database File error message, click Browse. TheOpenwindow appears.
2. Navigate to the EDB files and double-click the appropriate file.
3. ClickOK. The Source pane now populate with files.
4. If you are unable to locate the EDB file, click Remove on theMissing Database File error

message.
5. When asked to confirm, clickOK.

When an EDB is removed, the complete source EDB is removed from the CAS as well as
any source folders or mailboxes that also reference that EDB.

Missing Log Files
When there are missing log files, you are prompted to locate the log directory. The Browse button
opens a Browse for Folder dialog and defaults to the last known location of the logs.

To locate missing log files

1. On theMissing Database File error message, click Browse. TheOpenwindow appears.
2. Navigate to the directory containing the logs and clickOK. The Source pane now populates

with files.

When logs are removed, the complete source EDB is removed from the CAS as well as any
source folders or mailboxes that also reference that EDB and logs.

Missing STM Files
When there are missing .stm files, you are prompted to remove the files.

To remove missing .stm files

1. On theMissing Database File error message, click Remove.
2. When asked to confirm, clickOK.

When the .stm file is removed, the complete source EDB is removed from the CAS as well as
any source folders or mailboxes that also reference that EDB and .stm.

Missing Temp Files Directory Location
When there are missing temp file directory locations, you are prompted to locate the temp file
directory location. The Browse button opens a Browse for Folder window and defaults to the
current temporary path set by Ontrack PowerControls.

To locate missing temp file directory location

1. On theMissing Database File error message, click Browse. TheOpenwindow appears.
2. Navigate to the directory containing the temp files.
3. ClickOK. The Source pane now populates with files.
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Note: If just the temp files aremissing but the directory exists, it recreates the temp files.

Wrong Database Files
When Ontrack PowerControls finishes opening the EDB, it checks the database for the correct file
in the content analysis store. If it does not locate the correct file, it determines that there is a
different EDB at the original location than when the CAS was originally created. An error appears
and prompts you to remove the file from the CAS.

To remove wrong files

1. On theWrong Database File error message, click Remove.
2. A message appears asking if you are sure you want to remove the source and all related

messages from the content analysis store. ClickOK.
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Chapter 9: Message Views
Overview
You can view all instances of a given message or attachment in the EDB source(s) within the same
database as well as messages related by conversation in the Message Views option. This option is
particularly useful in assisting with administrative tasks such as database cleanup activities,
determining the history or dissemination of a message, or grouping messages by conversation
thereby allowing you to view them together in context without missing a reply or forward.

Message views are available for messages in the Source pane, find results pane, and also from
another message view. Message views are available only on single messages. If multiple messages
are selected in the message pane, the message view menu items and toolbar buttons are
unavailable.

You can view a message in various ways, depending on the message view option selected. Upon
option selection, you are presented the following:

n Message Table View - All the messages that are referenced by the same message table row
as the selected message.

n Attachment Table View - All the messages that have an attachment that are referenced by
the same attachment table row as the selected attachment.

n Conversation View - Messages that are related by conversation, with the sorting order of the
email thread based on who replied to whom within the thread. Messages are indented to
show the thread timeline of when replies occurred.

Note: If you use the "Mailbox Criteria (optional)" box on the Select Source Files dialog box or the
Source Selection page of the DataWizard, only EDBmailboxes containing your entry (or entries)
are displayed on the Source pane. Anymailboxes that do notmatch the entered string(s) do not
appear in the Source pane andare not be included in any subsequent tasks (such as searching,
copying, and exporting of the entire database). Formore information, see "Mailbox Criteria".

Note: If you use the "Multi-TenancyCriteria" box on the Select Source Files dialog box, the Source
Selection page of the DataWizard, theConnect to Exchange Server dialog box, or the Target
Selection page of the DataWizard, onlymailboxes contained in the selectedAddress Book Policy
or Organization appear in the Source or Target panes. Only thesemailboxes are included in any
subsequent tasks (such as searching, copying, and exporting of the entire database). Formore
information, see "Multi-Tenancy Support".
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Message Views Menus and Toolbars
The message views are accessible via the Tools menu, toolbar buttons, and a sub-menu on the
shortcut menu in the message panes.

Message Views Menus
The Tools menu contains a sub-menu with menu items for each message view.

Figure 9-1: The Tools menu leads to theMessage Views options

Message Views Toolbar Icons
A toolbar button exists for each message view: Message Table View, Attachment Table View, and
Conversation View.

Figure 9-2: The toolbar provides another option for accessing theMessage Views

Message View Shortcut Menu
The Source pane shortcut menu has a Message Views sub-menu with menu items for each
message view. As with the main menu, the new Message Views menu items provides status bar
text when they are highlighted.
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Figure 9-3: TheMessage View options can be reached by right-clicking an EDBmessage in the
uppermessage pane.

Figure 9-4: The Status Bar

Message View Pane
The Message View Pane is the area that hosts the various message views. The pane provides you
the ability to view the related messages and perform various actions (for example, viewing
messages in alternate views, exporting messages to your directory, checking the integrity).

Other Options Available in the Message View
Other actions can be performed within a Message View, such as Exporting messages, Integrity
Check, copying messages, and viewing a message in another Message View.

Figure 9-5: Other options available in the Tools menu areCopy, Export, and Integrity Check

These options are available in any Message View:
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n Copying Messages-Messages within a Message View can be copied and pasted into
folders in the Target pane via the Edit menu or shortcut menu. For more information about
copying messages, see "Restoring Microsoft Exchange Server Data".

n Exporting Messages-Messages within a Message View can be exported as any message
can via the Tools menu or shortcut menu. For more information, see "Exporting Messages".

n Integrity Check -Messages within a Message View can have an integrity check performed
on them via the Tools menu or shortcut menu. For more information, see "Looking at the
Interface".

n Message Views -Messages within a Message View can be viewed in any of the three
Message View options, Message Table View, Attachment Table View, or Conversation
View. The message view options are only available if a single message is selected.

Message View Options
You have the option of viewing all instances of a given message or attachment in the EDB source
(s) in three different ways-Message Table, Attachment Table View, and Conversation View.

Message Table View
Choosing the Message Table View option displays all the messages from the same EDB that
reference the same message table row (Single Instance Storage).

Example:

Amessage is sent to User1, User2, and User3. Themessage is stored in themessage table once. If a
user opens up the database and right-clicks themessage in User1's Inbox and choosesMessage
Table View, a table opens with threemessages in it: One in User1's Inbox (or deleted items), one in
User2's Inbox, and one in User3's Inbox as long as they are all in the sameMicrosoft Exchange
Server database (EDB). If User 1, 2, or 3 are in a different EDB, thosemessageswill not appear in this
view.

Sample

Figure 9-6: TheMessage Table Viewdisplaysmessages that have been deleted.
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The message pane displays the related messages in a report format showing the Message Type,
Attachment, From, To, Subject, Folder, Date, and Status (indicating if message has been deleted).

Note:Onlymessageswithin the same EDB can be viewed in theMessage Table View.

To open and view messages in the Message Table View

1. In the message pane, select an EDB message.
2. Do one of the following to display theMessage Table View:

l Click theMessage Table View icon on the toolbar.
l Right-click a message and point toMessage Views, then clickMessage Table View.
l Click the Toolsmenu, point toMessage Views, then clickMessage Table View.

Note: The first time opening a view on this EDB, amessage appears stating that aMessage
View file needs to generate.

Attachment Table View
Choosing the Attachment Table View option displays all of the messages in the same EDB that
have an attachment referencing the same attachment table row as the selected attachment
(Single Instance Storage). If the message contains multiple attachments, a sub-menu listing each
individual attachment allows the selection of an individual attachment.

Note: The Attachment Table Viewdoes not support Microsoft Exchange Server 2007 or later
sources, asMicrosoft stopped supporting single instance storagewithMicrosoft Exchange Server
2007.

Example:

Amessagewith an attachment is sent fromUser1 to User2 and User3. User3 forwards the email to
User4. The attachment is stored in the attachment table only once (single instance storage). A
user opens up theMicrosoft Exchange Server database (EDB) containing thesemessages and
creates an Attachment Table View on themessage in User's "Sent Items" folder. The Attachment
Table View contains fivemessages: one in User1's Sent Items, one in User2's Inbox, one is User's
Inbox, one in User3's Sent Items and one in User4's Inbox as long as they are all in the same EDB.

As in the Message Table View, the Attachment Table View shows the related messages in a report
format with Message Type, Attachment, From, To, Subject, Folder, Date, and Status (including
indicating if message has been deleted).

Note:

n Only messages with attachments can be viewed in the Attachment Table View.
n Only attachments within the same EDB can be viewed in the Attachment Table View.
n Attachments within inaccessible mailboxes cannot be viewed in the Attachment Table

View.
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To open the Attachment Table View

1. In the message pane, select a message.
2. Do one of the following to display theAttachment Table View:

l Click theAttachment Table View icon on the toolbar.
l Right-click a message and point toMessage Views, then clickAttachment Table View.
l Click the Toolsmenu, point toMessage Views, then clickAttachment Table View.

Note: The first time opening a view in this EDB, amessage appears stating that aMessage
View file needs to generate.

Figure 9-7: The Attachment Table Viewdisplaysmessageswith attachments

3. To view a message within theAttachment Table View, right-click a message, point to
Message Viewsand select one of the following options:
l Message Table View
l Attachment Table View
l Conversation View

4. Any message in the Attachment Table View can be opened by double-clicking the
message in the table.
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Conversation View
Choosing the Conversation View option displays the messages that are related by conversation
showing the Message Type, Attachment, From, To, Subject, Folder, Date, and Status (including
indicating if message has been deleted). Messages are indented to show the chain of replies and
forwards.

Example:

If a user composes and sends Email 1 to another user, and that user sends Email 2, a reply to Email
1, then Email 1 has no indention and Email 2 is indented one level. If the first user then replies to
Email 2 with Email 3, then Email 3 is indented two levels.

Note:

n Only conversation threadswithin the same EDB can be viewed in theConversation View.
n Messages within inaccessiblemailboxes cannot be viewed in theConversation View.

To open a Conversation View

1. In the message pane, select a message.
2. Do one of the following to display theConversation View:

l Click theConversation View icon on the toolbar.
l Right-click a message and point toMessage Views, then clickConversation View.
l Click the Toolsmenu, point toMessage Views, then clickConversation View.
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Figure 9-8: TheConversation Viewdisplays the conversation threadswhich are indicated by
indentations.

Note:

l The first time opening a view on this EDB, amessage appears stating that aMessage
View file needs to generated.

l If the first message is missing, the nextmessage in the thread is still indented indicating
that it is not the original message.

3. To view a message within theConversation View, right-click a message, point toMessage
Viewsand select one of the following options:
l Message Table View
l Attachment Table View
l Conversation View

4. Any message in the Conversation View can be opened by double-clicking the message in
the table.

Opening a View for the First Time
The first time you create any Message Table View, Attachment Table View, or Conversation View,
Ontrack PowerControls creates a Message View file. If no file exists, you are prompted to create
the file.
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To create a Message View for the first time

1. When the No Message View File dialog box appears, click Yes to create the file.

Figure 9-9: This message informs the user that an initial message view file does not exist

A progress window appears displaying the stage, progress text, estimated time, elapsed
time, and a grow bar.

For Microsoft Exchange Server 2007 and earlier, there are 5 stages: Initializing file,
Processing attachments, Processing messages, Processing rows, and Saving file.

For Microsoft Exchange Server 2010 and later, there are 3 stages:Creating the file,
processing the conversation messages, and saving the file.

After the message view file has been created, if creating a Message Table View, the
Creating Message ViewFileprogress window is replaced by another progress dialog that
tracks the progress of view preparation. A Preparing Message Table Viewprogress window
appears.

If you clickCancelduring this process, the Message Table View is not shown.

3. To view a message within theMessage Table View, Attachment Table View, or
Conversation View, right-click a message, point toMessage Viewsand select one of the
following options:
l Message Table View
l Attachment Table View
l Conversation View

4. To open a message in the Message Table View, Attachment Table View, or Conversation
View, double-click the message in the table.

Find in Source Window in Message Views
You can open a message view from the Find in Source window by using the Message Views sub-
menu on the Find Window's top-level Tools menu. The messages in the Find in Source window's
results pane also have the Message Views shortcut menu by right-clicking on a message and
pointing to Message Views.
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To open messages in Find in Source window result pane in different views

1. Click the Find icon on the toolbar.

2. In the Find in Source window, enter search criteria in the appropriate fields.
3. Click Find Now. The Resultspane appears with the search results.

Figure 9-10: The Find results can be displayed in each of theMessage Views

4. Do one of the following:
l Click the Toolsmenu, point toMessage Views, then click the desired view in the sub-

menu.
l Right-click the message, point toMessage Views, then click the desired view in the sub-

menu.
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Glossary
Term Description

ABP Address Book Policies. With this feature, you can restrict the users and
mailboxes they can view when sending emails in an environment using
Microsoft Exchange Server 2010 SP2 and later. Users can be assigned ABPs.
ABPs include a Global Address List (GAL) that defines the mailboxes a user
assigned an ABP can view.

Attachment
Table View

A table that displays all the messages that have an attachment referenced
by the same attachment table row as the selected message.

CAS See Content Analysis Store

CHK Checkpoint files (.chk files) are used for recovering (playing) data from
transaction logs into EDB files. The checkpoint is the place marker in the
EDB.CHK file that indicates which transactions have been committed.
Whenever data is written to an EDB file from the transaction log, the
EDB.CHK file is updated with information specifying that the transaction was
successfully committed to the respective EDB file. Separate Exx.chk files are
maintained for each storage group using ESE (Extensible Store Engine).

Content Analysis
Store(CAS)

A data store type where each message in the root level container identifies
a source container. A source container can either be an EDB, an EDB
mailbox, or an EDB folder. The CAS is used to analyze messages based on
profile criteria entered before processing.

Conversation
View

A table that displays all messages in the database that are related by
conversation. The conversation thread is indented to indicate replies.

Data Store A unified collection of folders and messages contained in a single storage
medium. A PST file is a data store. A Microsoft Exchange Server Information
Store is also a data store. In a basic case, Microsoft Exchange Server has
two live data stores, one for the private mailboxes and one for the public
folders.

Data Wizard The first time you start Ontrack PowerControls, the Data Wizard starts. The
Data Wizard guides you through the loading of Microsoft Exchange Server
Database (EDB), PST files, or content analysis store (CAS) files into Ontrack
PowerControls, and shows you how to specify the target PST file or Microsoft
Exchange Server.
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Term Description

Deduplication Deduplication is performed on a per profile basis and if selected does not
return duplicates of a message during a search. For example, if the same
message exists in two or more data stores, only the first message found is
listed in the search results.

EDB See Microsoft Exchange Server Database.

EIS See Microsoft Exchange Server Information Store.

Exchange
Hosted
Organization(or
Hosted
Organization)

An organizational unit created in an environment that has deployed
Microsoft Exchange Server 2010 SP1 or SP2 using the /hosting switch (Hosting
Mode). Users and associated mailboxes created in a hosted organization
can only see other users and mailboxes created in the same hosted
organization.

Log Files Transaction log files (.log files) are history files recording server activity. These
files are useful in restoring and backing up Microsoft Exchange Server data.
Transaction logs for Microsoft Exchange Server 5.5, 2000, and 2003 are 5 MB
in size. Transaction logs for Microsoft Exchange Server 2007 and later are 1
MB in size.

Messages Messages are found in the folders of a Microsoft Exchange Server
Information Store. Messages can mean "email," but Microsoft Office
OutlookContactsare also messages, as areAppointments, Journal Entries,
Sticky Notes,and Tasks.

Message Table
View

A table that displays all messages that are referenced by the same
message table row as the selected message. For example: A message that
is sent to three different users appears three times, one in each user's Inbox.

Microsoft
Exchange
Server Database

This file, which usually has an EDB extension, contains the mailbox, folders,
and messages you see when connecting to a Microsoft Exchange Server.
The Microsoft Exchange Server reads and writes to this file in response to
incoming email and events from the clients. On Microsoft Exchange Server
2000, this is one of the two files that make up the Microsoft Exchange Server
Information Store, the other being the STM file.
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Term Description

Microsoft
Exchange
Server
Information
Store

This is the set of files that compose the data store for private mailboxes and
public folders on a Microsoft Exchange Server. On Microsoft Exchange
Server 5.5, this is the single Microsoft Exchange Server Database file usually
named priv1.edb and pub1.edb. On Microsoft Exchange Server 2000 and
2003, the private mailbox data store consists of the files priv1.edb and
priv1.stm and the public folder data store consists of pub1.edb and
pub1.stm. On Microsoft Exchange Server 2007 and 2010, a private mailbox
data and public folder store consist of the EDB file without a STM file. On
Microsoft Exchange Server 2013 or later, a mailbox data store consists of the
EDB file without a STM file.

Multi-Tenancy
Support

Support included in Ontrack PowerControls and Ontrack Administrative
Server for multi-tenant deployments of Microsoft Exchange Server 2010 and
later. Specifically support is provided for environments that are utilizing the
Microsoft Exchange Server 2010 SP1, SP2 Hosting Mode or Microsoft
Exchange Server 2010 SP2 and later Address Book Policy feature. Support
includes the ability to limit the source and target mailboxes a user can
access based on Exchange Hosted Organizations or Address Book Policies.

For information regarding Hosting Mode using the "/hosting" switch, see

http://technet.microsoft.com/en-us/library/ff923272.aspx

and

http://social.technet.microsoft.com/wiki/contents/articles/1110.
exchange-2010-sp1-information-for-hosted-service-providers.aspx.

For information regarding Address Book Policies, see

http://technet.microsoft.com/en-us/library/hh529948.aspx

and

http://technet.microsoft.com/en-us/library/hh529916.aspx.

PAT Patch files (.pat files) are used to record information on page splits in
Microsoft Exchange Server 5.5 through Microsoft Exchange Server 2000
(SP1). In Microsoft Exchange Server 2000 (SP2) and later, the functionality
provided by .pat files is incorporated into Microsoft Exchange Server log
files.

Profile Folder A subfolder of the content analysis store containing the results of profile
criteria entered for processing.
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Term Description

PST Personal Storage file. This file, used by Microsoft Office Outlook, contains
folders and messages that have been retrieved from a user's Microsoft
Exchange Server mailbox and copied locally.

Received
Messages

Messages that have been sent through a Microsoft Exchange Server to
another mailbox. Messages in the "Sent Items" folder are copies of messages
sent through a Microsoft Exchange Server and are not considered to be
"received messages." Because messages in the "Drafts" folder, "Notes"
folder, and other similar items are not sent through a Microsoft Exchange
Server, they too are not considered to be "received."
Note: Because recovery software such asOntrack PowerControls restores
messages froma source to aMicrosoft Exchange Servermailboxwithout
sending them, themessages that Ontrack PowerControls restores are not
considered to be "receivedmessages."

Shortcut Menu This menu is accessed by right-clicking on an item.

Source Data
Store

This is the data store from which folders and messages are copied. The
source is read-only, so items cannot be copied into, deleted from, or
changed in the source.

STM For Microsoft Exchange Server 2000 and 2003, this is one of the two files that
make up the Microsoft Exchange Server Information Store, the other being
the EDB file. The STM file stores certain data for emails that come into the
Microsoft Exchange Server through the POP or SMTP port. This email data
may eventually get moved into the EDB file over time.

Target Data
Store

This is the data store to which folders and messages are copied. The target is
read-write allowing items to be added, deleted, and changed. The target
data store can be a Microsoft Exchange Server or PST file.
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Appendix A: EWS Configuration
Ontrack PowerControls is using Exchange Web Service for connection to O365 mailboxes.

Before you start using Ontrack PowerControls for Office 365 mailbox connection, please ensure
you have the correct setup in your Azure environment and Office 365 tenant.

Example of correct setup for Ontrack PowerControls and Exchange Web Service
connection

1. In Portal azure, confirm that the OPC app is present in the App registrations.

If there is no registeredOPCapp in the App registrations, create a new one by clickingNew
registration...

... then register the application with the following settings:
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2. On the OPC_AppRegistration page (Overview tab), in the Essentials section, copy the
Application (client) IDand theDirectory (tenant) ID.

3. Confirm that this AppRegistration has on the:
n Authentication page: In theMobile and desktop applications section, the platform

added by default
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(https://login.microsoftonline.com/common/oauth2/nativeclient) is
selected.

n API permissions page: In the Configured Permissions section, Office 365 Exchange
Online – full acccess as app is present.

4. On the Certificates & secrets page createNew client secret that will be needed to connect
to Single Mailbox (Office 365) as a target. Provide a description, expiration date and click
Add. Copy the Value of the newly created secret.
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Index

A
access rights

Microsoft Exchange Server mailboxes 121
access rights to a Microsoft Exchange

Server 113
Address Book Policies 29, 177-178
attachment table view 171, 177
attachments

opening and saving 16
opening and saving in the Find dialog

box 89
searching for 87

Autodiscover 30

C
CAS 177
CHK 177
closing a content analysis store 161
closing sources and targets 58
Command Line

examples 130
syntax 125

Connect to Public Folders 44
content analysis store

creating 151
creating reports 162
Microsoft Exchange Server 2010 data 153
opening as source 161
viewing profiles 163
viewing properties 162

content analysis store (CAS) 177
closing 161

content analysis store profile
viewing properties 162

continue loading EDB file without logs 52
conventions in this manual

shortcut menu 13
conversation view 173, 177
Copy Progress dialog box 113
Copy To Folder 85
copying and pasting 115

create a mailbox
Microsoft Exchange Server 2007 60
Microsoft Exchange Server 2010 or 2013 63
wizard 60

create a new single mailbox
Copy 66

create mailboxes 60
create multiple mailboxes

Copy 69
Create New Mail Folder dialog box 114
creating

content analysis store profile folders 154
creating a content analysis store 151
creating a new folder in the target pane 114
creating reports

content analysis store 162

D
Data Wizard 177

Connection Selection 50
Now Processing Data File 52
Opening 36
opening a target content analysis store 152
Source Selection 36, 49
Target Selection 41

deleted items in Microsoft Exchange Server
viewing 21

deleting a folder in the target pane 114
deleting profile 160
disabled user accounts 60
displaying a message in the preview pane 13
dragging 115

E
EDB 178
EDB file

guidelines for selecting 41
in source pane 7
restoring a folder 119
restoring a mailbox 120
restoring an entire EDB file 121
restoring in three easy steps 112
restoring messages with Copy-Paste 116
restoring messages with Paste Special 117
restoring to a Microsoft Exchange Server 113

editing a profile 160
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EIS 178
embedded messages

searching 81-82
Enter Password dialog box 44, 47, 49
exclude words 80
export messages

Find window 89
export report

printing 110
saving 110

Export to PST 99
exported PST

output 106
using 106

exporting 108
individual messages 108
individual messages from the Find window to

a PST file 102
messages from the Find dialog box 89

exporting messages
about MSG and TXT files 93
general information 92

F
Find dialog box

exporting messages from the Find dialog
box 89

guidelines for using 78
performing an integrity check on

messages 89
restoring messages 89
saving search profiles 87
searching within attachments 88
searching within results 83
viewing previous search results 83

Find in Exchange Target 84, 87
Find in Source 87
Find in Sources 78
Find window

opening messages 176
Folders in the Target Pane

creating 114
deleting 114
renaming 114

G
guidelines

for restoring messages 116
for restoring messages with Copy-Paste 116

for restoring messages with Paste
Special 117

for selecting a Microsoft Exchange Server
database 41

restoring a folder 119
restoring an EDB file 121
restoring to public folders 122
using the Find dialog box 78

H
Help

online Help 4
hiding the preview pane 13
hiding the toolbar and status bar 14
hosted organization 29

I
importing

profile criteria 158
inputting

saved profile criteria 158
Integrity Check 20

L
Live Microsoft Exchange Server 33
log files 178

organizing the Microsoft Exchange Server
database files for Ontrack
PowerControls 3

M
mailbox access 33
mailbox creation 59
mailbox criteria 29
Mailbox List, Creating a 21
mailbox-enabled user

create 59
Main window

menu bar 11
Source message list 8
source pane 7
Target pane 9
toolbar 11

menu bar 11
message (.msg) export 93
Message Report 90
message table view 170, 178
message view options

attachment table view 171
conversation view 173
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message table view 169
message view pane 169
message views

exporting messages 170
menus and toolbars 168

messages
cutting 86
deleting 86
exporting 93
moving 85
searching 79

Microsoft Exchange Server 2010
creating a content analysis store 153

Microsoft Exchange Server database 178
guidelines for selecting 41

Microsoft Exchange Server Database, See
also EDB file

about 2
Microsoft Exchange Server information

store 179
Microsoft Exchange Server targets

searching 78, 84
missing database files

missing temp files location 165
Move To Folder 85
moving messages 85

dragging 85
using Move To Folder 85

moving or copying a folder, a mailbox, or an
EDB file with Copy-Paste 159

multiple levels
searching 82

multiple mailboxes
opening 57

multiple search windows 87
Multi-Tenant Support 29, 179

enabling 27

N
new mailboxes 59
Now Processing Data File 52

O
Office 365 32
online Help 4
Ontrack PowerControls

getting help 3
Open Existing Target PST command 55
open messages in Find window 176
Open Source command 55

Open Target Content Analysis Store
command 56-57

opening
a target content analysis store 56
an existing target PST 55
attachments 16
attachments in Find dialog box 88
conversation view 173
Data Wizard 37
message table view messages 171
messages 14
multiple sources 57
target content analysis store using the Data

Wizard 152
the preview pane 13

Options Tab 22-23
Organizational Forms 108
organizing the Microsoft Exchange Server

database files for 3
Outlook Anywhere 30

P
Paste Special

restoring messages 117
PAT 179
permission rights 33
permissions of public folders 122
Preferences

setting 22
preferences 22
preview pane

displaying a message in 13
hiding 13
opening 13
opening attachments in 16
saving attachments in 17

previewing and opening messages 13
previous search results

viewing 84
processing

content analysis store profile folder 154
processing on profiles

resuming 159
suspending 158

profile folder 179
properties of an EDB file, PST file, CAS file, CAS

profile folder, mailbox, or folder 18
PST 180
PST and folder limits 112
PST export 93
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PST file
creating a new target 55
opening an existing target 55
restoring in three easy steps 112

PST files
as displayed in target pane 9

PST messages per folder limit
turning off 113

public folders
permissions 122

R
Readme File 2
recoverable items

content analysis store 153
EDB properties 17
viewing 22

refreshing the screen 16
renaming a folder in the target pane 114
report

saving 90
using 91

reporting
attachment statistics report 143
creating reports 139
domain statistics report 144
mailbox report 146
messages by database report 145
messages by date report 147
messages by profile folder report 148
saving reports 150
sorting reports 149

reports. See reporting 139
restore messages

Microsoft Exchange Server root node 119
restoring a folder

guidelines 119
results 120

restoring a mailbox
guidelines 120
results 121

restoring an EDB file
guidelines 121
results 122

restoring messages
guidelines 116
Paste Special 117

restoring messages from the Find dialog
box 89

restoring messages with Copy-Paste
results 117

restoring messages with Paste Special
guidelines 117

restoring Microsoft Exchange Server data
looking at the target pane 9

restoring Microsoft Exchange Server data to a
Microsoft Exchange Server

restoring individual messages with Copy-
Paste 112

restoring Microsoft Exchange Server data to a
Microsoft Exchange Server

about the Copy Progress dialog box 113
restoring a folder 119
restoring a folder, a mailbox, an EDB file, a

CAS file, or a PST file 112
restoring a mailbox 120
restoring an EDB file 121
restoring individual messages with Paste

Special 112
restoring messages to a Microsoft Exchange

Server root node with Paste
Special 119

restoring messages to Microsoft Exchange
Server 113

restoring to public folders 122
restoring Microsoft Exchange Server data to a

Microsoft Exchange Server mailbox or
folder with Copy-Paste 116

restoring Microsoft Exchange Server data to a
PST file

about the Copy Progress dialog box 113
looking at the target message list 10
restoring a folder 119
restoring a folder, a mailbox, an EDB file, a

CAS file, or a PST file 112
restoring an EDB file 121
restoring individual messages with Copy-

Paste 112
restoring individual messages with Paste

Special 112
restoring PST and folder targets

limits 112
restoring to public folders 122

guidelines 122
results 123

restoring your Microsoft Exchange Server data
in three easy steps 112

resuming processing on profiles 159
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rights
access rights to a Microsoft Exchange

Server 113

S
saving

attachments 17
attachments in the Find dialog box 89
profile criteria 158
reports 150

saving search profiles 86
search

performing 87
search criteria

report 90
Search in

Attachment File Name(s) 81
Attachment Text 81
Message Body 81
Message Subject 81

search profile
creating 86
editing 87

search profiles 86
search results report 90
searching

for attachments 81
using multiple search windows 87
within attachments 87
within results 82

searching within attachments
exceptions 88

Security Tab 25
Shortcut Menu 13
single instance storage (SIS) vs. cumulative

counts 143
single mailbox

opening 56
sorting messages in the message list 15
Source

EDB or PST file 7
message list 8

Source data store 180
Source Selection 36
split bar, using to resize panes 14
STM 180
Summary Report 90
suspending the processing on profiles 158

T
target content analysis store

opening 152
target message list 10
Target message list

in main window 10
target pane

creating a new folder 114
deleting a folder 114
pasting an item 115
renaming a folder 114

Target Selection 41
technical support 4
text (.txt) export 93
toolbar

in main window 11

U
User Information 63
user permission 59
using Find window in message views 175
using multiple search windows 87
using search profiles 86

V
view the properties of a content analysis store

profile 162
viewing

message table view messages 171
previous search results 83
the properties of a PST file, EDB file, folder, or

mailbox 17
the toolbar or status bar 14

viewing profiles in content analysis store 163
viewing the properties of a content analysis

store 162

W
Warnings Tab 27
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